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1 PRODUCT DESCRIPTION 1.1 GETTING STARTED

1
1 PRODUCT DESCRIPTION 1.1 GETTING STARTED 1.1.1 UNPACKING THE RELAY

The following procedure describes how to unpack and setup the DGP.

1. Unpack and examine the DGP Digital Generator Protection relay. Ensure each module is properly seated
in the relay prior to applying power. 

2. Apply rated DC power to the relay at the power supply input terminals. Refer to the appropriate elementary
diagram in Section 1.5: ELEMENTARY DIAGRAMS on page 1–24 for the location of these terminals. The
rated DC value (Vps) for the relay is found on the nameplate located inside the front cover on the right
side.

3. The DGP settings and control functions are protected by passwords on both MMI and remote access. The
relay is shipped with the factory default passwords that must be changed before any setting change or
control command can be executed (GE Modem Version only). The default passwords are listed below:

Note that the characters "." and "!" are part of the default passwords.

4. Instructions on how to use the keypad to change settings and put the relay into test mode can be found in
Section 4.3.2: SETTING CHANGES on page 4–3. Complete instructions on how to operate the keypad are
found in Section 8.3: KEYPAD on page 8–3.

5. To communicate with the relay from a PC, connect the relay to a serial port of an IBM compatible computer
with a DGP null-modem cable. Connection can be made either to the 25 pin D-connector on the back of
the relay (PL-1) or the 9 pin D-connector on the front (COM).

6. Refer to Figure 9–1: DGP COMMUNICATIONS WIRING on page 9–3 for the internal wiring of the cable.

7. DGP-PC, the communications software required to access the relay from a PC, is included on the GE Mul-
tilin Products CD or available from the GE Multilin web site at www.ge.com/indsys/pm. Follow instructions
in 10.1.3: INSTALLATION on page 10–1 to load DGP-PC onto the PC.

8. To log into the relay, follow the instructions in Section 4.4: USING DGP-PC on page 4–5.

9. This instruction book describes functions available in DGP models with standard function groups A, B, and
C. Refer to the Nomenclature Selection Guide shown below to determine functions included in a specific
model.

MODE PASSWORD

MMI - SETTING 1234.

MMI - MASTER 5678.

REMOTE LINK - VIEW VIEW!

REMOTE LINK - SETTING SETT!

REMOTE LINK - CONTROL CTRL!
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1
1.1.2 ORDER CODES & SELECTION GUIDE

Table 1–1: ORDER CODES
DGP * * * * * *

Base Unit DGP | | | | | | Base Unit
Current Rating 1 | | | | | 1 Ampere Rated Current

5 | | | | | 5 Ampere Rated Current
Power Supply 0 | | | | One Power Supply, 48 V DC

1 | | | | One Power Supply, 110 to 125 V DC
2 | | | | One Power Supply, 220 to 250 V DC
3 | | | | Two Power Supplies, 48 V DC
4 | | | | Two Power Supplies, 110 to 125 V DC

Test Blocks A | | | With Test Blocks
B | | | Without Test Blocks

Protocol A | | GE Modem Protocol
B | | Modbus RTU Protcol (DGP***BCA only)

Functions and 
Features

A | Functions and Features – see DGP selection guide below.
B |
C |

Revision A DGP Revision A Firmware
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1
Table 1–2: DGP SELECTION GUIDE

FUNCTIONS & FEATURES A B C
Stator Differential 87G ✔ ✔ ✔

Current Unbalance 46 ✔ ✔ ✔

Loss of Excitation 40-1, 40-2 ✔ ✔ ✔

Anti-motoring 32 2 1 2
Overcurrent Voltage Restraint 51V ✔ ✔ ✔

Stator Ground 64G1 ! ✔ ✔ ✔

Stator Ground 64G2 " ✔ - ✔

Stator Ground 27TN # - ✔ ✔

Neutral Overcurrent 51GN - ✔ ✔

Overexcitation 24 (Volts/Hz) ✔ ✔ ✔

Overvoltage 59 ✔ ✔ ✔

Undervoltage 27 - ✔ ✔

Underfrequency 81-U 4 2 4
Overfrequency 81-O 4 2 2
Accidental Engergization Logic ✔ ✔ ✔

Sequential Trip Logic ✔ ✔ ✔

Voltage Transformer Fuse Failure VTFF ✔ ✔ ✔

Oscillography Data Capture ✔ ✔ ✔

RS232 Communications Ports 2 2 2
Printer Output ✔ - ✔

IRIG-B Input ✔ ✔ ✔

DEC1000 compatible - - ✔

! 64G1 is Fundamental Frequency Overvoltage, also known as 59GN
" 64G2 uses 3rd harmonic comparator algorithm for enhanced security
# 27TN is 3rd Harmonic Undervoltage supervised by an adjustable window of forward power.
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1.1.3 SPECIAL MODELS

In addition to the standard DGP model described by the order codes above, several special models are avail-
able. Some of these are shown below with a brief description.

DGP***AAA-0101 and DGP***AAA-0102

This model is similar to the standard DGP***AAA except for the following major changes:

• All digital inputs are rated for nominal voltage of 110 to 125 V DC instead of the standard 48 to 250 V DC

• The logic for function 51V is modified to remove fault detector supervision

• Seperate terminals are provided for the optional second power supply input

Refer to instruction book GEK-105552 for additional detail.

DGP***ABA-0005

This model is similar to the standard DGP***ABA except for the following major changes:

• Includes the Stator Ground 27TN function

• Includes oscillography data capture and IRIG-B input capabilities

• Suitable for application with 208 V AC nominal input

Refer to instruction book GEK-105587 for additional detail.

1.1.4 DEC 1000 CONTACT EXPANSION UNIT

The DEC 1000 is a relay expansion unit for the DGP consisting of five form C relays and six form A relays.
These contacts can be used for signalling or alarm purposes. Any protection function available in the compan-
ion DGP relay can be selected for DEC output relay assignment. The DEC 1000 is connected via the DGP
printer port PL2.

The DEC 1000 expansion unit is only compatible with the DGP!!!!!C units.

The DGP expansion unit is only compatible with the DGP!!!!CA units.
NOTE

NOTE
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1.2 INTRODUCTION 1.2.1 GENERAL

The DGP Digital Generator Protection™ System is a microprocessor-based digital relay system that uses
waveform sampling of current and voltage inputs to provide protection, control and monitoring of generators.
These samples are used to compute current and voltage phasors that are used for the protection-function algo-
rithms. The DGP™ system uses a man-machine interface (MMI) and DGP-PC software for local and remote
communication respectively.

This instruction book describes all the functions available in the various standard DGP models. Refer
to the SELECTION GUIDE in the previous section to determine functions included in a specific model.

1.2.2 APPLICATION

The DGP system is designed to be used on hydroelectric, gas, and steam generating units. Any size of gener-
ator can be protected with this digital system.

More detailed application considerations are contained below in the remaining headings of this section and in
Chapter 2: CALCULATION OF SETTINGS.

A typical wiring diagram for the DGP relay is shown on the following page.
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Figure 1–1: TYPICAL WIRING DIAGRAM
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1.3 PROTECTION FEATURES 1.3.1 DESCRIPTION

The following protection functions are included with the DGP system.

A single-line diagram for the DGP is shown below.

Figure 1–2: SINGLE LINE DIAGRAM

Table 1–3: DGP PROTECTION FUNCTIONS

PROTECTION FUNCTION ANSI CODE(S)

Stator Differential 87G

Current Unbalance 46

Loss of Excitation 40

Anti-Motoring 32

Time Overcurrent with Voltage Restraint 51V

Stator Ground 64G1, 64G2, 27TN

Ground Overcurrent 51GN

Over-excitation 24

Overvoltage 59

Undervoltage 27

Over and Underfrequency 81

Voltage Transformer Fuse Failure VTFF

Accidental Energization AE

To
MODEM

To
LAPTOP
PC

TRIPALARM

52G

GSU
Transf.

TO
POWER
SYSTEM

GEN.

51GN 64G164G227NT

RS232

4687G 403251VVTFF

RS232

64G224 32

40

27

59

81

VTFF DGP51V
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1.3.2 STATOR DIFFERENTIAL (87G)

This function provides high-speed protection of the generator stator during internal phase-to-phase and three-
phase faults. It uses a product-restraint algorithm with dual-slope characteristic described in Section 2.3.2:
STATOR DIFFERENTIAL 87G on page 2–13. Refer to Figure 1–3: SIMPLE LOGIC DIAGRAM – 87G, 32, 27,
59, AND AE on page 1–13 for the logic diagram of this function.

Function 87G will not operate for turn-to-turn faults in the machine windings.

It will also not operate for single-phase-to-ground faults if the system is ungrounded or high-impedance
grounded. Phase-to-ground protection by this function requires that the neutral of the machine (or another
machine operating in parallel) be grounded. A small portion of the winding next to the neutral will not be pro-
tected, the amount being determined by the voltage necessary to cause minimum pickup current to flow
through the neutral-to-ground impedance. Current-limiting devices in the neutral-ground circuit increase this
impedance and will decrease the ground-fault-protection coverage of this function.

1.3.3 CURRENT UNBALANCE (46T)

There are several causes of generator unbalance. Some of these include unbalanced loads, unbalanced sys-
tem faults, and/or open circuits. The negative-sequence component (I2) of stator current is directly related to
this unbalance and sets up a counter-rotating flux field in the machine. This in turn causes local heating in the
rotor iron. The capability of machines to withstand heating caused by unbalance currents is typically exper-
essed in terms of an  constant, and is supplied by the manufacturer of the machine.

The current unbalance trip function (46T) of the DGP provides operating-time characteristics expressed as
I22T = K, as shown in Figure 2–6: TIME CURRENT CHARACTERISTIC OF 46T FUNCTION on page 2–19. A
linear reset characteristic is incorporated to approximate the machine cooling following an intermittent current-
unbalance condition. In addition to 46T, the DGP system also includes a current-unbalance alarm function,
46A, which is operated by the negative-sequence component (I2) with an adjustable pickup and time delay.
See Figure 1–4: SIMPLE LOGIC DIAGRAM – 46, 40, AND 51V on page 1–14 for the logic diagram.

1.3.4 LOSS OF EXCITATION (40)

This function is used to detect loss of excitation on synchronous machines. It includes two mho characteristics
looking into the machine, each with adjustable reach, offset, and time delay. Logic is provided to block this
function by presence of a negative-sequence voltage (indicating a voltage transformer fuse failure VTFF condi-
tion) and/or an external VTFF Digital Input DI6 (see Figure 1–4: SIMPLE LOGIC DIAGRAM – 46, 40, AND 51V
on page 1–14).

Excitation can be lost due to inadvertent tripping of the field breaker, open or short circuit on the field winding,
regulator failure, or loss of the source to the field winding. Loss of excitation can be damaging to the machine
and/or detrimental to the operation of the system. When a synchronous generator loses excitation, it will tend
to act as an induction generator: it will run above normal speed, operate at reduced power and receive its exci-
tation (VARS) from the system. The impedance seen by a relay looking into a generator will depend on the
machine characteristics, the load flow prior to the loss of excitation, and the type of excitation failure.

Studies indicates that first zone mho function (40-1) can be set to detect severe cases of excitation failure with
a shorter time delay, whereas the second zone (40-2) can be set to detect all the excitation failure cases. A
longer time delay setting is required for the 40-2 function for security during stable power system swing condi-
tions. Figure 2–7: MHO CHARACTERISTICS FOR 40-1 & 40-2 FUNCTIONS on page 2–21 shows the charac-
teristics of this function.

I2
2T
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1.3.5 ANTI-MOTORING (32)

On a total or partial loss of prime mover, if the power generated is less than no-load losses of the machine, real
power will start flowing into the generator. Typical motoring power of different kinds of prime movers are shown
in the table below. For a specific application, the minimum motoring power of the generator should be obtained
from the supplier of the unit.

The DGP system includes a reverse power function with adjustable time-delay. Either one or two (32-1 & 32-2)
independent setpoints are incorporated depending on the model number.

The 32-1 can be configured as a part of sequential tripping logic as shown in Figure 1–3: SIMPLE LOGIC DIA-
GRAM – 87G, 32, 27, 59, AND AE on page 1–13. If the sequential trip logic is used, 32-1 is enabled when clos-
ing of turbine inlet valves is indicated by digital input DI2 following a turbine trip. The trip sequence is then
continued when timer TL1 times out. The 32-2, if included, is not dependent on the DI2 and is primarily
intended to provide backup to the sequential trip. If the sequential trip is not enabled, the 32-1 can be used as
anti-motoring similar to 32-2.

1.3.6 TIME OVERCURRENT WITH VOLTAGE RESTRAINT 51V

A system must be protected against prolonged generator contribution to a fault. The DGP incorporates a time-
overcurrent function with voltage restraint (51V) to provide part of the system backup protection. As shown in
Figure 1–4: SIMPLE LOGIC DIAGRAM – 46, 40, AND 51V on page 1–14, this function is supervised by a fault
detector and VTFF. The VTFF supervision can be by an internal and/or external (DI6) VTFF function. See Sec-
tion 2.3.7: OVERCURRENT WITH VOLTAGE RESTRAINT (51V) on page 2–22 for the characteristic curves of
the 51V. Note that a separate algorithm is processed for each phase, with the restraint provided by correspond-
ing phase voltage. The restraint is proportional to the magnitude of the voltage and is independent of the phase
angle. A linear reset characteristic is incorporated for this function.

1.3.7 STATOR GROUND (64G/27TN)

This function consists of two overlapping zones (64G1 and 64G2/27TN) to detect stator ground faults in a high-
impedance-grounded generator system. The 64G1 is standard in all DGP models; however, the 64G2/27TN
function is provided in some models only. Together, the two zones cover 100% of the stator windings. See Fig-
ure 1–5: SIMPLE LOGIC DIAGRAM – 64G1, 64G2, 51GN, AND 24 on page 1–15.

Normally the generator-stator neutral has a potential close to ground. With the occurrence of a stator ground
fault, a potential increase will occur on the neutral for all faults except those near the neutral. 64G1 uses a fun-
damental-frequency neutral overvoltage to cover about 95% of the stator winding, depending on the pickup
voltage setting. Alternately, 64G1 can be used as a generator-bus ground detector in a high-impedance
grounded or an ungrounded system. For this application, the VN input must be a zero-sequence voltage
derived from the generator bus, and functions 64G2/27TN must be disabled.

Table 1–4: TYPICAL MOTORING POWER

TYPE OF PRIME 
MOVERS

MOTORING POWER IN % 
OF UNIT RATING

Gas Turbine 10 to 100

Diesel 15 to 25

Hydraulic Turbine 2 to 100

Steam Turbine 0.5 to 4
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64G2 is based on the percentage of third-harmonic voltage at the generator neutral (VN3) compared to the
total third-harmonic voltage generated. This function is designed to cover 15% of the neutral end of the stator
windings, and is supervised by fundamental and third-harmonic voltage thresholds. These thresholds are fixed
at 30 and 0.5 volts respectively. The third-harmonic comparator method eliminates the need to know the gener-
ator harmonic characteristic to use or set this function. Note that wye-connected VTs are required for
proper operation of 64G2.

27TN is the third-harmonic neutral undervoltage function with a forward power supervision and can be used
with either wye or delta connected VTs. The percentage of stator windings covered by this function depends on
its threshold setting as well as the VN3 generated by the machine at the time of the fault. The magnitude of
VN3 under normal conditions is a function of several factors, such as type of generator, load current, load
power factor, system status, etc. It can be very small (nearly zero) under some conditions. To enhance security
during low VN3 voltage conditions, this function can be inhibited by a settable window of forward power. How-
ever, it should be noted that other conditions influencing the VN3 voltage may make 27TN insecure. In these
cases, function 64G2 (available in some models; see the DGP nomenclature guide) or some other means
should be considered.

Digital input DI1 can be configured to block 64G2/27TN when the generator is off-line. This provision is made
to enhance security of the functions under conditions such as static start of a gas turbine generator. Temporary
ungrounding of generator neutral during the static start can look like a ground fault near the neutral.

1.3.8 GROUND OVERCURRENT (51GN)

51GN is an inverse overcurrent function available in some models. It can be used to detect stator ground faults
in a high or low resistance grounded generator system. See Figure 1–5: SIMPLE LOGIC DIAGRAM – 64G1,
64G2, 51GN, AND 24 on page 1–15 for simplified logic diagram and Figure 2–16: 51GN TIME-CURRENT
CHARACTERISTICS on page 2–39 for the inverse time-current characteristics.

This function uses current INR which can be derived by residual connection or by using a generator neutral CT
as noted in Figures 1–9: ELEMENTARY DIAGRAM WITH TEST BLOCKS, WYE VTs and 1–12: ELEMEN-
TARY DIAGRAM WITHOUT TEST BLOCKS, DELTA VTs.

Since this function is independent of the phase current inputs, it can alternately be connected to a CT in the
neutral of the generator step-up transformer.

1.3.9 OVEREXCITATION (24)

Overexcitation can be caused by regulator failure, load rejection, or an excessive excitation when the genera-
tor is off-line. It can also result from decreasing speed while the regulator or an operator attempts to maintain
rated stator voltage. The Volts/Hertz quantity is proportional to magnetic flux in the generator and step-up
transformer cores, and is used to detect the overexcitation condition. See Figure 1–5: SIMPLE LOGIC DIA-
GRAM – 64G1, 64G2, 51GN, AND 24 for details.

The overexcitation protection includes trip (24T) and alarm (24A) functions. 24T consists of an inverse function
and an instantaneous function with time-delay characteristics. The combination of these two characteristics
allows the 24T setting to closely follow the generator and/or step-up transformer V/Hz limit curve. Both 24A
and 24T are computed for each of the three phase voltages (see Table 2–3: 24A VOLTAGES on page 2–30).

Function 24T can be configured to operate different output relays for generator on-line and off-line conditions.
This function incorporates a user-settable linear reset characteristic to mimic machine cooling. The figures in
Section 2.3.12: OVEREXCITATION TRIP (VOLTS/HERTZ: 24T) show the characteristics of this function.
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1.3.10 OVERVOLTAGE (59)

This function consists of a positive-sequence overvoltage with an user selectable inverse or definite time char-
acteristic. See Figure 1–3: SIMPLE LOGIC DIAGRAM – 87G, 32, 27, 59, AND AE on page 1–13 for the logic
diagram and Figure 2–15: 59 TIME-VOLTAGE CHARACTERISTICS on page 2–35 for the inverse time-voltage
characteristics. A linear reset characteristic is incorporated for this function. The overvoltage function can be
considered as a backup to the Volts/Hz function. Some possible causes of this condition are a system distur-
bance or regulator failure.

1.3.11 UNDERVOLTAGE (27)

This function consists of a positive-sequence undervoltage with an user selectable inverse or definite time
characteristic. See Figure 1–3: SIMPLE LOGIC DIAGRAM – 87G, 32, 27, 59, AND AE on page 1–13 for the
logic diagram and Figure 2–17: 27 TIME-VOLTAGE CHARACTERISTICS on page 2–40 for the inverse time-
voltage characteristics. A linear reset characteristic is incorporated for this function.

1.3.12 OVER AND UNDERFREQUENCY (81)

This function provides over and underfrequency protection, each with an adjustable time delay. Two or four
over and underfrequency steps are provided depending on the model. All frequency functions are supervised
by an adjustable positive-sequence voltage level. This undervoltage cut-off level and/or digital input DI1 can be
used to block the frequency functions during start-up. Frequency disturbance can occur due to a system fault
or islanding of the unit or an unconnected unit can operate at abnormal frequency due to malfunction of speed
control. Figure 1–6: SIMPLE LOGIC DIAGRAM – 81-O AND 81-U on page 1–16 shows the logic diagram for
this function.

1.3.13 VOLTAGE TRANSFORMER FUSE FAILURE (VTFF)

Functions 40 and 51V may operate for a full or partial loss of AC potential caused by one or more blown fuses.
The DGP makes provisions to block tripping by these functions when a fuse failure is detected; all other protec-
tion functions are allowed to trip. Figure 1–7: SIMPLE LOGIC DIAGRAM – VT FUSE FAILURE on page 1–17
shows the logic diagram for the VTFF function.

If AC potential is lost on one or more phases, the negative-sequence voltage (V2) rises and/or the positive-
sequence voltage (V1) drops. Either V2 > 15V or V1 < 50V provides a basic indication of the VTFF condition.
This signal is supervised by a Disturbance Detector (DD) and generator positive-sequence current (I1) detec-
tor (see three-input AND gate on the logic diagram). Supervision by the DD and I1 signals provide security
against false operation during fault and generator out of service conditions respectively. Security is enhanced
by use of the A/0 and B/0 timers shown in the logic diagram.

Signal DD is derived from a combination of sequence current levels, change in levels, and pickup flags of vari-
ous protection functions as shown in the logic diagram.

The VTFF logic allows integration of an external VTFF contact. Either of the two fuse-failure signals or both sig-
nals can be configured to block tripping of functions 40 and 51V.

Detection of VTFF energizes the 74FF (Fuse Failure alarm) relay, de-energizes the 74CR (critical alarm) relay,
and turns the status LED red, even though all protection functions except 40 and 51V are unaffected.
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1.3.14 ACCIDENTAL ENERGIZATION (AE)

The DGP includes logic to detect accidental energization of the generator (see Figure 1–3: SIMPLE LOGIC
DIAGRAM – 87G, 32, 27, 59, AND AE on page 1–13). When a generator is energized while at standstill or
reduced speed, it behaves and accelerates as an induction motor. The machine terminal voltage and current
during such an event will be a function of generator, transformer, and system impedances.

An instantaneous overcurrent signal (50) is used to detect the accidental energization. This signal is armed by
a logic signal derived from positive-sequence voltage and GEN OFF LINE input DI1. These two "arming" sig-
nals can be configured in AND or OR mode by Setting 2703: AE ARM. The 50 function is armed 5 seconds
after the generator is taken out of service. The logic automatically disarms itself during a normal start-up
sequence when the voltage detector picks up and/or the generator is on-line.

For the AE logic to perform, special precautions must be taken to ensure that the DGP system and associated
trip circuits remain in service when the generator is out of service. Additionally, the generator off-line input, DI1,
must be reliable. It should also be noted that the pickup flag of function 51V is used as signal 50; therefore this
logic will automatically be disabled if function 51V is disabled.



GE Multilin DGP Digital Generator Protection System 1-13

1 PRODUCT DESCRIPTION 1.3 PROTECTION FEATURES

1

Figure 1–3: SIMPLE LOGIC DIAGRAM – 87G, 32, 27, 59, AND AE
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Figure 1–4: SIMPLE LOGIC DIAGRAM – 46, 40, AND 51V
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Loss of Excitation
Zone 1 40-1

VTFF + DI6
FD

Overcurrent
(voltage restraint) 51V

(+) DI3TL21
(1)

External Trip - 1

DI3

DI4TL22
(1)

External Trip - 2

DI4
(+)

Current Unbalance
(Alarm)

TL14 46A

Current Unbalance
(Trip) 46T

TL12AND

Loss of Excitation
Zone 2 40-2TL13AND

AND

(+) DI6
Ext. VTFF OR

V2 > 15V SELV2SUP
PU

DO

ENA

DIS
PU=3 Samples
DO=5 Samples

OR
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      operate any combination of the 8 output relays (4-Trip and 4-Alarm). DSPLGC2.VSD
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Figure 1–5: SIMPLE LOGIC DIAGRAM – 64G1, 64G2, 51GN, AND 24

CONFIGURABLE
LOGIC (2)

TRIP A
94G

OR

TRIP B
94G1

OR

TRIP C
94G2

OR

TRIP D
94G3

OR

ALARM
74A

OR

ALARM
74B

OR

ALARM
74C

OR

ALARM
74D

OR

NOTES:
(1) Indicates an optinal function (includes associated logic). Refer to
    DGP nomenclature selection guide for available functions in a
    specific model.

Overexcitation
(Alarm)

TL6 24A

Stator Ground
Zone 1 64G1TL4

AND 24T
(On-Line)

AND

Overexcitation
(Trip) TL7

Time

Inst
OR

DI1
(+)

Gen.
Off-Line 24T

(Off-Line)

Neutral Overcurrent
(1) 51GN

Stator Ground
Zone 2 (1) AND TL5

VP3 > 0.5V

V1 >  30V

(+)
DI1

SELBKDI1Gen.
Off-Line

64G2

TL20AND
(+)

DI1

GEN. OFF-LINE

SELBKDI1

POWER < FORPWR-L

POWER > FORPWR-H
OR

27TN
(1)

(2) Each of the available protection functions can be configured to
    operate any combination of the 8 output relays (4-Trip and 4-Alarm).

V1  ≥  25V

V N3 ≤  27TN PICKUP



1-16 DGP Digital Generator Protection System GE Multilin

1.3 PROTECTION FEATURES 1 PRODUCT DESCRIPTION

1

Figure 1–6: SIMPLE LOGIC DIAGRAM – 81-O AND 81-U
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    operate any combination of the 8 output relays (4-Trip and 4-Alarm).
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Figure 1–7: SIMPLE LOGIC DIAGRAM – VT FUSE FAILURE
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1.4 OTHER FEATURES 1.4.1 INPUTS

The DGP system takes eight current and four voltage inputs (refer to Section 1.5: ELEMENTARY DIAGRAMS).
The input currents in terminals BH1, BH3, and BH5 (IAS, IBS, and ICS) are used to process functions 46, 40, 32,
and 51V. As noted in the elementary diagrams, these currents can be derived from system side or neutral side
CTs as desired. Either the system or neutral side CTs can be used for these functions if the Stator Differential
(87G) function is enabled.

The current inputs INS and INR are derived from the residual connections of the respective phase CTs and do
not require dedicated neutral CTs. Zero-sequence current at system and/or neutral side of the generator stator
windings is calculated and then compared with the measured INS and/or INR values by the DGP as a part of the
background self-test.

The INR current is used to process the 51GN function (not available on DGP***AAA models). If desired, a ded-
icated neutral CT can be used for the input INR.

The DGP phase voltage inputs can be wye or delta and are derived from the generator terminal voltage. VN is
derived from the generator neutral grounding transformer.

A time synchronizing signal can be connected to the DGP for synchronization to within 1 ms of a reference
clock. Either IRIG-B or GE's G-NET system signal can be used. This signal is required only if it is necessary to
synchronize the DGP to an external reference clock.

Six digital inputs can be connected to the DGP. Two of these inputs (DI3 and DI4) are assigned for possible
routing of external trip/alarm signals to take advantage of the output configuration or sequence-of-events capa-
bility. Generator off-line (DI1), turbine inlet-valve-close indication (DI2), and external VTFF (DI6) inputs are
used for various relay logic functions. A contact input, (DI5), can also be used to trigger the optional oscillogra-
phy feature. In some models, the DI6 input can be configured as external VTFF or DISABLE ALL PROTEC-
TION (refer to Section 1.5: ELEMENTARY DIAGRAMS for details).

The digital input circuits are universally rated for nominal control voltages of 48 to 250 V DC.

1.4.2 OUTPUT RELAYS

The DGP system includes eight user-configurable output relays. Four of these relays (94G, 94G1, 94G2 and
94G3) are high speed (4 ms) trip-duty rated with two form A contacts each. The remaining four (74A, 74B, 74C
and 74D) are standard speed (8 ms) with one form C contact each, intended for alarms. Each of the protection
functions can be configured to operate any number of these output relays. The trip outputs are intended for, but
not limited to, the following purposes:

• 94G: trip a lockout relay to shut down the machine

• 94G1: trip field breaker

• 94G2: trip main generator breaker or breakers

• 94G3: operate a lockout relay to trip turbine.

In addition to the configurable output relays, five pre-defined alarm duty relays with one form C contact each
are included. These alarm relays include critical and non-critical self-test alarms (74CR and 74NC), the VTFF
alarm (74FF), and loss of power-supply alarms (PS1 and PS2). The form C contact of each of the alarm relays,
except PS1 and PS2, are wired out to the terminal block. A hard wire jumper is used to select either the form A
or the form B contact of each of the PS1 and PS2 relays, as shown in Figure 3–3: DGP POWER SUPPLY
MODULE on page 3–4.

All alarm relays, with the exception of 74CR, PS1 and PS2, are energized when the appropriate alarm condi-
tions exist. Relays 74CR, PS1 and PS2, however, are energized under normal conditions and will drop out
when the alarm conditions exist.
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Also included are two additional relays (TEST PICKUP and TEST TRIP) that can be configured to operate by a
selected protection function pickup flag and trip output. These two outputs are intended to facilitate testing of
the selected protection function.

A Contact Expansion Unit is also available which can be used with DGP***ACA models. The General Electric
DEC1000 Contact Expansion Unit provides eleven additional output relays that can be factory configured to
user specifications. Refer to the GE Multilin Product Catalog, the GE Multilin Products CD, or instruction book
GEK-105561 for additional details on the DEC1000.

1.4.3 START-UP SELF-TESTS

The most comprehensive testing of the DGP is performed during power-up. Since the DGP is not performing
any protection activities at that time, tests (such as RAM tests) that would normally be disruptive to run-time
processing are performed during the start-up. All processors participate in the start-up self-test process. The
processors communicate their results to each other so that any failures found can be reported to the user and
to ensure each processor successfully completes its assigned self-tests before the DGP system begins protec-
tion activity.

During power-up, the microprocessors perform start-up self-tests on their associated hardware (PROM, local
RAM, shared RAM, interrupt controller, timer chip, serial and parallel I/O ports, non-volatile memory, analog
and digital I/O circuitry, MMI hardware, etc.). In addition, the DGP system verifies that the PROM version num-
bers in all processor boards are compatible. The components tested at start-up are listed in Table 6–1: START-
UP SELF-TESTS on page 6–2.

In most cases, if any critical self-test failure is detected, the DGP will not continue its start-up but will not cause
a reset. An attempt will be made to store the system status, to initialize the MMI and remote communications
hardware/software for communication status, and to print a diagnostic message. The critical alarm relay will be
de-energized.

If no failures are detected, the DGP completes initialization of its hardware and software. Next, each processor
board (DAP and SSP) will enable the outputs. As a final step, the DGP checks the results of all the tests to
determine whether to turn the front panel status LED to green.

The start-up procedure takes approximately one minute. As soon as the SSP successfully completes its PROM
test and initializes the display hardware, the message INITIALIZING will be displayed. When the DGP system
initialization is completed, the display is blanked and the relay begins acquiring and processing data.

1.4.4 RUN-TIME SELF-TESTS

Each of the processors has "idle time" when the system is in a quiescent state; that is, when the DGP is not
performing fault or post-fault processing. During this idle time, each processor performs background self-tests
that are non-disruptive to the foreground processing. If any background self-test fails, the test is repeated. To
declare a component FAILED, the test must fail three consecutive times. In the case of critical failures, the
DGP forces a self reset to resume operation again after an intermittent failure. The reset activities are identical
to the start-up activities except that not all start-up self-tests are performed.

A reset is not reported to the user by the DGP system. If the reset is successful, no message is printed, no fail-
ure status is recorded, and the critical alarm is not generated. However, during the reset procedure, the red
LED on the MMI panel will light and a failure code may appear on the MMI display. If the reset is not success-
ful, the processor board will be shut down, leaving the MMI panel displaying the error information. Refer to
Section 6.4: ERROR CODES on page 6–7 for error codes. To prevent continual resets in the case of a solid
failure, both hardware and software will permit only four resets in a one hour period. On the fifth reset, the DGP
will not perform initialization, but will attempt to initialize MMI, communications, and the critical alarm output, as
in the case of a start-up with a critical self-test failure.
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The components tested in the background are listed in Table 6–2: RUN-TIME BACKGROUND SELF-TESTS
on page 6–3. The testing of I/O hardware is done in the foreground so the processors know when a given com-
ponent or port is in use and therefore not available for testing. The components tested in the foreground are
listed in Table 6–3: RUN-TIME FOREGROUND SELF-TESTS on page 6–3. Some foreground tests are per-
formed every sample period while others are performed less frequently. As with background self-tests, any
failed test is repeated and must fail three consecutive times to be considered a failure. Although not specifically
a self-test, trip circuit continuity monitoring is also performed as a foreground test. Refer to the TRIP CIRCUIT
MONITOR section below.

In addition to background self-tests, the operator may initiate a visual-response test of the MMI components.
Refer to Section 4.6.2 T1: MMI STATUS AND DISPLAY TESTING on page 4–9 for details.

1.4.5 ADAPTIVE SAMPLING FREQUENCY

The DGP system samples analog input waveforms at a rate of 12 samples per cycle. An adaptive sampling fre-
quency is used to maintain this rate over the power system frequencies of 30.5 to 79.5 Hz. As a result of this
feature, the measurement accuracy of the analog inputs and the sensitivities of the protection functions are
maintained over the range of power system frequencies. This feature provides improved protection for faults
during off-normal frequencies (such as start-up conditions). Figure 1–8: FREQUENCY-SENSITIVITY CHAR-
ACTERISTICS shows variations in sensitivity of protection functions at different power system frequencies.

The sampling frequency is based on 30.5 Hz for power system frequencies below 30.5 Hz and 79.5 Hz for the
frequencies above 79.5 Hz. In either case, if the AC voltage to the DGP drops below approximately 20 V, the
sampling frequency is automatically recalculated on the basis of the nominal system frequency (Setting 102:
SYSFREQ).

The sampling frequency, which is 12 times the measured system frequency, can be accessed as one of the
Present Values.

1.4.6 TRIP CIRCUIT MONITOR

The trip circuit monitor consists of DC voltage and current monitors (TVM and TCM respectively). Each of the
trip contacts shown with polarity marks in the elementary diagrams (see Section 1.5: ELEMENTARY DIA-
GRAMS) is monitored. TVM and TCM can be selectively disabled for each of the trip circuits.

Under normal conditions, DC voltage across each of the contacts is continuously monitored. If the DC voltage
becomes virtually zero, then the trip circuit has "failed open". The TVM is active only when the generator is on-
line, as indicated by the input DI1. This function is intended to replace the indicating light typically used for trip
circuit monitoring. It is universally rated for 48 through 250 V DC. A non-critical alarm is generated when the
TVM detects an abnormality.

When the DGP system issues a trip, DC current through each of the appropriate trip contacts is monitored. The
trip relay is sealed-in, as long as the current is flowing, to protect the contact. A minimum current of 150 mA is
required for the TCM to recognize the trip current. Status of the trip current flow following issuance of any trip is
logged in the sequence of events.

1.4.7 SEQUENCE OF EVENTS

This function time-tags and stores the last 100 events in memory. The resolution of the time-tagging is 1 milli-
second. The event list contains power system events, operator actions, and self-test alarms. The sequence of
events can be accessed, either locally or remotely, by a PC via one of the RS232 ports. A full description of this
function is contained in the Chapter 8: INTERFACE.
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Figure 1–8: FREQUENCY-SENSITIVITY CHARACTERISTICS

1.4.8 TIME SYNCHRONIZATION

The DGP system includes a real time clock that can run freely or be synchronized from an external signal. Two
different external time-sync signals are possible. If the DGP is connected to the host computer of a G-NET sub-
station information and control system, then the DGP receives a time-sync pulse via pin 25 of port PL-1. If the
DGP is not connected to a G-NET host computer, then a demodulated IRIG-B signal connected to optional port
PL-3 may be used to synchronize the clock. In both cases, the clock in a given DGP is synchronized to within
±1 millisecond of any other digital relay clock, provided the two relays are wired to the same synchronizing sig-
nal.
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1.4.9 FAULT REPORT & OSCILLOGRAPHY DATA

A fault report is initiated by any one of the protection-function pickup flags or an optional external oscillography
trigger input, DI5. For the fault report to be completed and stored, the DGP either has to issue a trip or the DI5
input contact must close any time during the fault report period. The fault report period begins when the first
protection function flag is up or the DI5 input contact is closed. It ends when the DGP issues a trip or when it
has captured the selected number of post-fault waveform cycles, whichever is later. If all the pickup flags reset
without issuing a trip and the DI5 does not close, the fault report initiated by the protection flag will not be com-
pleted or stored.

The fault report includes the Unit ID, date and time, system operating time, pre-fault metering values, fault cur-
rents and voltages, trip/fault types, and up to 14 sequence-of-event points logged after initiation. The system
operating time (OP TIME) is the time difference between the first protection function pickup flag and the first
protection function trip. The DGP stores the last three fault reports in its memory. A full description of the fault
report is contained in Chapter 8: INTERFACE.

DGP models with oscillography data capture capability will store waveform data in their memory each time the
system stores a fault report. A total of 120 cycles of data can be stored. The 120 cycles in memory are divided
in one, two, or three partitions, based on Setting 111: NUM FLTS. The number of prefault cycles captured per
fault can be set up to 20 cycles. It should be noted that the pre-fault cycles are based on the first flag or DI5 to
initiate the data capture.

Oscillography data includes station and generator identification, a complete list of settings, the fault report,
internal flags, and a selected number of pre-fault and post-fault waveform cycles. This data can be displayed
using the DGP-PC software program. See Chapter 10: DGP-PC SOFTWARE for details.

1.4.10 LOCAL MAN-MACHINE INTERFACE

A local man-machine interface (MMI), incorporating a keypad, LED display, and 19 target LEDs, is provided to
allow the user to enter settings, display present values, view fault target information, and access stored data.
The use and functioning of the MMI is fully described in the Chapter 8: INTERFACE.

1.4.11 LOCAL PRINTER

An optional printer port (PL-2) on the rear of the DGP permits the use of a serial printer. The port can also be
used to connect the DEC1000 Contact Expansion Unit (DGP***ACA models only) which provides eleven addi-
tional output relays. The sequence-of-events (SOE) data are available at this port for immediate printing as
they occur. Additionally, for DGP***AAA models, a variety of information stored in the DGP system memory
can be printed when requested via the local MMI; see Chapter 8: INTERFACE for details.

1.4.12 REMOTE COMMUNICATIONS

Two RS232 serial ports permit the user to communicate with the DGP from an IBM PC-compatible computer.
One of the ports, a DB-25 (PL-1), is located on the rear of the case and the other, a DB-9 (COMM), is located
on the front plate of the MMI module.

A PC may be connected to the DGP with a proper null-modem cable, provided the cable length does not
exceed 50 feet. The PC can also be connected via interposing modems if it is physically remote from the DGP.
DGP-PC software is required to communicate with the DGP. The capabilities and use of the software are
described in Chapter 10: DGP-PC SOFTWARE. Refer to Chapter 9: COMMUNICATIONS for details regarding
the required cables and proper connection.

When a connection to the host computer of a station integration system is desired, the following two physical
connections are possible:
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• Standard hard-wire cables may be used for distances up to 50 feet.
• For longer distances it is possible to add an optional external adapter that plugs into PL-1 to provide a fiber

optic link between the DGP and the host computer. An isolated 5 V DC supply is internally connected to pin
11 of PL-1 to power this external adapter.

Cables and associated equipment can be connected to each port simultaneously. However, when one port is
active the other is effectively disabled. For instance, when PL-1 is connected to host computer of an integration
system, it is not possible to log into the DGP from the front port when the integration system is active. If PL-1 is
connected to a modem and the front port is connected to a PC using a null-modem cable, then the first port
that becomes active is given preference, and the other port is disabled until the first is released.

1.4.13 REMOTE CONTROL

By using the local MMI or a remote PC connected to the RS232 port, it is possible to selectively operate any of
the four trip output relays for remote control. The control action may include shutdown of the machine, field
breaker trip, main generator breaker trip, turbine trip, etc., depending on the equipment connected to the out-
puts. The controls described above are enabled or disabled by a hard-wired jumper located on the MMI mod-
ule (see Figure 3–4: DGP MMI MODULE on page 3–5). As shipped from the factory, this jumper is physically
present and the Remote Control is disabled. To enable Remote Control, the jumper must be removed.

1.4.14 PASSWORD PROTECTION

Passwords provide security when using the local interface (MMI) or during remote communications while run-
ning the DGP-PC program. Two different passwords provide local MMI security for: 
1. control operations (close trip-output contacts)
2. settings changes.

Three different passwords in the DGP-PC program provide remote communications security for:
1. view and upload information
2. control operations
3. settings changes

Refer to the Chapter 8: INTERFACE for a description of MMI password usage, and refer to Chapter 10: DGP-
PC SOFTWARE for a description of DGP-PC password usage.

1.4.15 REMOTE COMMUNICATIONS – MODBUS PROTOCOL

The RS232 serial ports can be used with an optional RS485 to RS232 converter. Refer to Chapter 9: COMMU-
NICATIONS for further information on Modbus communication.
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1.5 ELEMENTARY DIAGRAMS

Figure 1–9: ELEMENTARY DIAGRAM WITH TEST BLOCKS, WYE VTs
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Figure 1–10: ELEMENTARY DIAGRAM WITH TEST BLOCKS, DELTA VTs
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Figure 1–11: ELEMENTARY DIAGRAM WITHOUT TEST BLOCKS, WYE VTs
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Figure 1–12: ELEMENTARY DIAGRAM WITHOUT TEST BLOCKS, DELTA VTs
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Figure 1–13: DIGITAL RELAY SYMBOL LEGEND
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2 CALCULATION OF SETTINGS 2.1 GENERAL 2.1.1 DESCRIPTION

This section provides information to assist the user in determining settings for the DGP™ generator protection
system. Some settings are determined by the size and type of generator and the system to which it is con-
nected, while other settings are the same regardless of the machine and/or system. Other settings may be set
according to user preference.

Settings that are independent of system and machine size/type will be presented first, followed by machine
and system-dependent settings. A blank setting form is provided (see Table 2–5: DGP***AAA SETTINGS
TABLE on page 2–41) and may be used to record model number, PROM version number, and settings for spe-
cific applications.

Table 2–1: DGP SYSTEM SETTINGS & RATINGS on page 2–3 lists all the settings and the corresponding
ranges and units. The column labeled DEFAULT indicates the DGP system settings stored in memory when
shipped from the factory. The settings described in the subsequent sections are arranged by category, corre-
sponding to the category headings on the light-emitting diode (LED) display of the local man-machine interface
(MMI). Individual settings and category headings are listed by the descriptive name followed by its mnemonic.
The DGP displays the mnemonic to identify a particular setting or category-of-setting heading.

In the following section, a set of example settings based on a typical generator system is presented. By no
means does this presentation encompass all possible setting scenarios or calculations. It is provided as a dem-
onstration for the setting methods and procedures to follow.

A sample generator system diagram is shown on the following page; it will be used to demonstrate the exam-
ple settings for a typical DGP protection system.
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Figure 2–1: SAMPLE GENERATOR SYSTEM
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Table 2–1: DGP SYSTEM SETTINGS & RATINGS (Sheet 1 of 7)

SETTING 
NUMBER

MNEMONIC RANGE DEFAULT

5 AMP 1 AMP UNITS 5 AMP 1 AMP

CONFIGURATION: CONFIG

101 UNITID 0 to 9999 (GEmodem protocol)
1 to 127 (Modbus protocol)

N/A 0 (GEmodem)
1 (Modbus)

102 SYSFREQ 50 / 60 Hz 60

103 SEL TVM 0000 to 1111 N/A 0000

104 SEL TCM 0000 to 1111 N/A 0000

105 SELPRIM PRIMARY (0); SECNDRY (1) N/A SECNDRY

106 CT RATIO 1 to 50000 N/A 1

107 VT RATIO 1.0 to 240.0 N/A 1.0

108 COMMPORT Format: xxyz, where
Baud Rate (xx): 03, 12, 24, 48, 96 (× 100)

Parity (y): 0 (None), 1 (Odd), 2 (Even)
Stop Bits (z): 1, 2

N/A 2401

109 ! PHASE A-B-C (0); A-C-B (1) NA A-B-C

110 TIMESYNC INTRNL (0); IRIG-B (1)"; G-NET (2) N/A INTRNL

111 NUM FLTS 1 to 3 N/A 3

112 " PREFLT 1 to 20 cycles 20

113 " OSC TRIG DI ENA (0); DI DIS (1) N/A DI ENA

114 NOM VOLT 100.0 to 225.0 "# / 100.0 to 140.0 % V 120.0

115 RATEDCUR 0.10 to 9.99 0.02 to 1.99 A 5.00 1.00

116 VT CONN WYE   (0); DELTA (1) N/A WYE

117 # NCTRATIO 1 to 50000 N/A 1

STATOR DIFFERENTIAL: 87G

201 TRIP 0000 to 1111 N/A 0000

202 ALARM 0000 to 1111 N/A 0000

203 K1 1.0 to 10.0 % 5.0

204 PICKUP 0.20 to 1.00 0.04 to 2.00 A 0.30 0.06

CURRENT UNBALANCE – ALARM: 46A

301 ALARM 0000 to 1111 N/A 0000

302 PICKUP 0.05 to 2.99 0.01 to 0.60 A 0.05 0.01

! Set to match the system phase sequence. Setting informs the relay of actual system phase sequence, either ABC or ACB. CT 
and VT inputs labeled A, B, and C on the DGP must be connected to system phases A, B, and C for correct operation.

" Setting/value not available in DGP***ABA models.
# Setting/value not available in DGP***AAA models.
% Setting/value not available in DGP****CA models.
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2.1 GENERAL 2 CALCULATION OF SETTINGS

2
303 TL14 1 to 9 sec. 1

CURRENT UNBALANCE – TRIP: 46T

401 TRIP 0000 to 1111 N/A 0000

402 ALARM 0000 to 1111 N/A 0000

403 PICKUP 0.05 to 2.99 0.01 to 0.60 A 2.00 0.40

404 K2 1.0 to 45.0 sec. 1.0

LOSS OF EXCITATION – SUPERVISION: 40

501 SELV2SUP DISABLE (0); ENABLE (1) N/A DISABLE

LOSS OF EXCITATION – ZONE 1: 40-1

601 TRIP 0000 to 1111 N/A 0000

602 ALARM 0000 to 1111 N/A 0000

603 CENTER 2.50 to 60.00 12.5 to 300.00 Ω 11.00 55.00

604 RADIUS 2.50 to 60.00 12.5 to 300.00 Ω 8.50 42.50

605 TL12 0.01 to 9.99 sec. 0.01

LOSS OF EXCITATION – ZONE 2: 40-2

701 TRIP 0000 to 1111 N/A 0000

702 ALARM 0000 to 1111 N/A 0000

703 CENTER 2.50 to 60.00 12.50 to 300.0 Ω 11.00 55.00

704 RADIUS 2.50 to 60.00 12.50 to 300.0 Ω 8.50 42.50

705 TL13 0.01 to 9.99 sec. 0.01

ANTI-MOTORING #1: 32-1

801 TRIP 0000 to 1111 N/A 0000

802 ALARM 0000 to 1111 N/A 0000

803 SQ TR EN YES [1/Y]; NO [3/N] N/A YES

804 REV PWR 0.5 to 99.9 0.1 to 19.9 W 1.5 0.3

805 TL1 1 to 120 sec. 5

ANTI-MOTORING #2: 32-2

901 " TRIP 0000 to 1111 N/A 0000

Table 2–1: DGP SYSTEM SETTINGS & RATINGS (Sheet 2 of 7)

SETTING 
NUMBER

MNEMONIC RANGE DEFAULT

5 AMP 1 AMP UNITS 5 AMP 1 AMP

! Set to match the system phase sequence. Setting informs the relay of actual system phase sequence, either ABC or ACB. CT 
and VT inputs labeled A, B, and C on the DGP must be connected to system phases A, B, and C for correct operation.

" Setting/value not available in DGP***ABA models.
# Setting/value not available in DGP***AAA models.
% Setting/value not available in DGP****CA models.
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902 " ALARM 0000 to 1111 N/A 0000

903 " REV PWR 0.5 to 99.9 0.1 to 19.9 W 1.5 0.3

904 " TL2 1 to 60 sec. 1

OVERCURRENT WITH VOLTAGE RESTRAINT: 51V

1001 TRIP 0000 to 1111 N/A 0000

1002 ALARM 0000 to 1111 N/A 0000

1003 PICKUP 0.5 to 16.0 0.1 to 3.2 A 0.5 0.1

1004 TIME FAC 0.10 to 99.99 sec. 0.10

STATOR GROUND – ZONE 1: 64G1

1101 TRIP 0000 to 1111 N/A 0000

1102 ALARM 0000 to 1111 N/A 0000

1103 PICKUP 4.0 to 40.0 V 4.0

1104 TL4 0.1 to 9.9 sec. 0.1

STATOR GROUND – ZONE 2: 64G2

1201 " TRIP 0000 to 1111 N/A 0000

1202 " ALARM 0000 to 1111 N/A 0000

1203 " TL5 0.1 to 9.9 sec. 0.1

OVEREXCITATION – ALARM: 24A

1301 ALARM 0000 to 1111 N/A 0000

1302 PICKUP 1.0 to 1.99 per unit 1.50

1303 TL6 0 to 9.9 sec. 1.0

OVEREXCITATION – TRIP: 24T

1401 TRIP ON (-line) 0000 to 1111 N/A 0000

1402 TRIP OFF (-line) 0000 to 1111 N/A 0000

1403 ALARM 0000 to 1111 N/A 0000

1404 CURVE # 1 to 4 N/A 1

1405 INV PU 1.00 to 1.99 per unit 1.50

1406 TIME FAC 0.10 to 99.99 sec. 99.99

Table 2–1: DGP SYSTEM SETTINGS & RATINGS (Sheet 3 of 7)

SETTING 
NUMBER

MNEMONIC RANGE DEFAULT

5 AMP 1 AMP UNITS 5 AMP 1 AMP

! Set to match the system phase sequence. Setting informs the relay of actual system phase sequence, either ABC or ACB. CT 
and VT inputs labeled A, B, and C on the DGP must be connected to system phases A, B, and C for correct operation.

" Setting/value not available in DGP***ABA models.
# Setting/value not available in DGP***AAA models.
% Setting/value not available in DGP****CA models.
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2.1 GENERAL 2 CALCULATION OF SETTINGS

2
1407 INST PU 1.00 to 1.99 per unit 1.50

1408 TL7 0 to 9.9 sec. 1.0

1409 RESET 0 to 999 sec. 1

OVERVOLTAGE: 59

1501 TRIP 0000 to 1111 N/A 0000

1502 ALARM 0000 to 1111 N/A 0000

1503 INV PICKUP 100 to 350 "# / 100 to 200 % V 120

1504 TIME FAC 0.10 to 99.99 sec. 1.00

1505 # CURVE # 1 (Inverse); 2 (Definite Time) N/A 1

1506 "# INST PU 100 to 400 V 240

OVER/UNDER FREQUENCY VOLTAGE CUTOFF 81

1601 UVCUTOFF 35 to 99 % 90

UNDERFREQUENCY SETPOINT 1: 81-1U

1701 TRIP 0000 to 1111 N/A 0000

1702 ALARM 0000 to 1111 N/A 0000

1703 SET PNT 40.00 to 65.00 Hz 60.00

1704 TL8 0.1 to 999.9 sec. 2.0

UNDERFREQUENCY SETPOINT 2: 81-2U

1801 TRIP 0000 to 1111 N/A 0000

1802 ALARM 0000 to 1111 N/A 0000

1803 SET PNT 40.00 to 65.00 Hz 60.00

1804 TL9 0.05 to 99.99 sec. 2.00

UNDERFREQUENCY SETPOINT 3: 81-3U

1901 " TRIP 0000 to 1111 N/A 0000

1902 " ALARM 0000 to 1111 N/A 0000

1903 " SET PNT 40.00 to 65.00 Hz 60.00

1904 " TL10 0.05 to 99.99 sec. 2.00

Table 2–1: DGP SYSTEM SETTINGS & RATINGS (Sheet 4 of 7)

SETTING 
NUMBER

MNEMONIC RANGE DEFAULT

5 AMP 1 AMP UNITS 5 AMP 1 AMP

! Set to match the system phase sequence. Setting informs the relay of actual system phase sequence, either ABC or ACB. CT 
and VT inputs labeled A, B, and C on the DGP must be connected to system phases A, B, and C for correct operation.

" Setting/value not available in DGP***ABA models.
# Setting/value not available in DGP***AAA models.
% Setting/value not available in DGP****CA models.
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UNDERFREQUENCY SETPOINT 1: 81-4U

2001 " TRIP 0000 to 1111 N/A 0000

2002 " ALARM 0000 to 1111 N/A 0000

2003 " SET PNT 40.00 to 65.00 Hz 60.00

2004 " TL11 0.05 to 99.99 sec. 2.00

OVERFREQUENCY SETPOINT 1: 81-1O

2101 TRIP 0000 to 1111 N/A 0000

2102 ALARM 0000 to 1111 N/A 0000

2103 SET PNT 45.00 to 79.99 Hz 60.00

2104 TL15 0.05 to 99.99 sec. 2.00

OVERFREQUENCY SETPOINT 2: 81-2O

2201 TRIP 0000 to 1111 N/A 0000

2202 ALARM 0000 to 1111 N/A 0000

2203 SET PNT 45.00 to 79.99 Hz 60.00

2204 TL16 0.05 to 99.99 sec. 2.00

OVERFREQUENCY SETPOINT 3: 81-3O

2301 "% TRIP 0000 to 1111 N/A 0000

2302 "% ALARM 0000 to 1111 N/A 0000

2303 "% SET PNT 45.00 to 79.99 Hz 60.00

2304 "% TL17 0.05 to 99.99 sec. 2.00

OVERFREQUENCY SETPOINT 4: 81-4O

2401 "% TRIP 0000 to 1111 N/A 0000

2402 "% ALARM 0000 to 1111 N/A 0000

2403 "% SET PNT 45.00 to 79.99 Hz 60.00

2404 "% TL18 0.05 to 99.99 sec. 2.00

DIGITAL INPUT: DIG INP

2501 SELBKDI1 NO BLK (0); BLK #1-9 (1-9) N/A NO BLK

2502 DI3 TRIP 0000 to 1111 N/A 0000

Table 2–1: DGP SYSTEM SETTINGS & RATINGS (Sheet 5 of 7)

SETTING 
NUMBER

MNEMONIC RANGE DEFAULT

5 AMP 1 AMP UNITS 5 AMP 1 AMP

! Set to match the system phase sequence. Setting informs the relay of actual system phase sequence, either ABC or ACB. CT 
and VT inputs labeled A, B, and C on the DGP must be connected to system phases A, B, and C for correct operation.

" Setting/value not available in DGP***ABA models.
# Setting/value not available in DGP***AAA models.
% Setting/value not available in DGP****CA models.
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2503 DI3 ALRM 0000 to 1111 N/A 0000

2504 "& DI3 TIMR# 0.00 to 9.99 sec. 0.01

2505 
(2504&)

DI4 TRIP 0000 to 1111 N/A 0000

2506 
(2505&)

DI4 ALRM 0000 to 1111 N/A 0000

2507 "# DI4 TIMR 0.00 to 9.99 sec. 0.01

2508 # DI6 FUNC EXTVTFF (0); DISPROT (1) N/A EXTVTFF

VOLTAGE TRANSFORMER FUSE FAILURE: VTFF

2601 VTFF DISABLE (0); ENABLE (1) N/A DISABLE

ACCIDENTAL ENERGIZATION: AE

2701 TRIP 0000 to 1111 N/A 0000

2702 ALARM 0000 to 1111 N/A 0000

2703 AE ARM AND (0); OR (1) N/A AND

GROUND OVERCURRENT: 51GN

2801 # TRIP 0000 to 1111 N/A 0000

2802 # ALARM 0000 to 1111 N/A 0000

2803 # PICKUP 0.10 to 5.00 0.02 to 1.00 A 0.50 0.10

2804 # TIME FAC 0.10 to 99.99 sec. 1.00

UNDERVOLTAGE: 27

2901 # TRIP 0000 to 1111 N/A 0000

2902 # ALARM 0000 to 1111 N/A 0000

2903 # PICKUP 40 to 210 " V 100

2903 # PICKUP 40 to 120 % V 100

2904 # TIME FAC 0.1 to 99.99 sec. 1.00

2905 # CURVE # 1 (Inverse); 2 (Definite Time) N/A 1

UNDERVOLTAGE – THIRD HARMONIC: 27TN

3001 # TRIP 0000 to 1111 N/A 0000

3002 # ALARM 0000 to 1111 N/A 0000

Table 2–1: DGP SYSTEM SETTINGS & RATINGS (Sheet 6 of 7)

SETTING 
NUMBER

MNEMONIC RANGE DEFAULT

5 AMP 1 AMP UNITS 5 AMP 1 AMP

! Set to match the system phase sequence. Setting informs the relay of actual system phase sequence, either ABC or ACB. CT 
and VT inputs labeled A, B, and C on the DGP must be connected to system phases A, B, and C for correct operation.

" Setting/value not available in DGP***ABA models.
# Setting/value not available in DGP***AAA models.
% Setting/value not available in DGP****CA models.
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3003 # PICKUP 0.1 to 9.9 V 0.9

3004 # TL20 0.5 to 99.9 sec. 2.0

3005 # FORPWR-L 0 to 999 0 to 200 W 10 1

3006 # FORPWR-H 0 to 999 0 to 200 Watt 20 1

Table 2–1: DGP SYSTEM SETTINGS & RATINGS (Sheet 7 of 7)

SETTING 
NUMBER

MNEMONIC RANGE DEFAULT

5 AMP 1 AMP UNITS 5 AMP 1 AMP

! Set to match the system phase sequence. Setting informs the relay of actual system phase sequence, either ABC or ACB. CT 
and VT inputs labeled A, B, and C on the DGP must be connected to system phases A, B, and C for correct operation.

" Setting/value not available in DGP***ABA models.
# Setting/value not available in DGP***AAA models.
% Setting/value not available in DGP****CA models.
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2

2.2 CONFIGURATION SETTINGS 2.2.1 DESCRIPTION

101: UNITID – UNIT ID NUMBER

UNITID is a decimal number between 0 and 9999 (for units with GE Modem protocol only) or 1 to 127 (for units
with Modbus protocol) stored in non-volatile memory that uniquely identifies a DGP relay system. When the
DGP is accessed via one of its serial ports, the UNITID is required to establish communication, thus providing
a measure of security. UNITID can only be changed via the local MMI. It is not possible to change UNITID with
the DGP-PC communication software.

102: SYSFREQ – SYSTEM FREQUENCY

SYSFREQ can be set to either 50 Hz or 60 Hz.

103: SEL TVM – SELECT TRIP VOLTAGE MONITORING

One contact of each of the four trip output relays can be monitored for DC voltage. The monitoring is enabled
or disabled by setting SEL TVM to 1 or 0, respectively. The four-digit code of the SEL TVM setting applies to
94G, 94G1, 94G2, and 94G3, in that order. For example, a setting of 1100 enables trip voltage monitoring for
94G and 94G1 and disables for 94G2 and 94G3.

The monitoring of all unused contacts should be disabled to avoid nuisance alarms.

104: SEL TCM – SELECT TRIP CURRENT MONITORING

The four trip contacts described above for the SEL TVM can also be monitored for DC current when a trip sig-
nal is issued. This monitoring is enabled or disabled by setting SEL TCM to 1 or 0, respectively. The four-digit
code of the SEL TCM setting applies to 94G, 94G1, 94G2, and 94G3, in that order. If the trip current through
any of the monitored contacts is not expected to be above 150 mA, or if any of the trip circuit is not interrupted
externally, it should be disabled to avoid nuisance sequence-of-event points or seal-in of the output relay.

For example, a setting of 1000 enables TCM for 94G and disables for 94G1, 94G2, and 94G3.

105: SELPRIM – SELECT PRIMARY/SECONDARY UNITS

SELPRIM can be set to either 0 (PRIMARY) or 1 (SECNDRY). This setting determines whether the present
values (currents, voltages, watts, and vars) are displayed and stored as primary or secondary values. All user-
entered settings are expressed in terms of secondary values, regardless of the SELPRIM setting.

106: CT RATIO – CURRENT TRANSFORMER RATIO

CT RATIO can be set from 1 to 50000. This setting applies to all current inputs with a possible exception of cur-
rent INR. If Setting 117: NCTRATIO is provided, then it applies to the current INR. Refer to the Neutral Current
Transformer Ratio (Setting 117: NCTRATIO) described later.

For the sample generator system, 

107: VT RATIO – VOLTAGE TRANSFORMER RATIO

VT RATIO can be set from 1.0 to 240.0.

For the sample generator system, 

CT RATIO 8000
5

------------- 1600= =

VT RATIO 18900
120

---------------- 157.5= =
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108: COMMPORT – COMMUNICATIONS PORT

COMMPORT sets the baud rate, parity, and stop bits of the RS232 serial port. The setting format is a four-digit
number xxyz, where:

Baud Rate = xx = 03, 12, 24, 48, 96 (× 100)
Parity = y = 0 (None), 1 (Odd), 2 (Even)
Stop Bits = z = 1, 2

The baud rate setting of 300, 1200, 2400, 4800, or 9600 must match the baud rate of the modem or serial
device connected to the RS232 serial ports. The parity and stop bits must match those selected for the serial
port of the remote PC. Normally, 1 stop bit is selected. However, certain modems or other communications
hardware might dictate using 2 stop bits. DGP-PC communications software can be configured to match the
DGP setting for baud rate, parity, and stop bits.

COMMPORT can only be changed via the DGP keypad. It cannot be changed with DGP-PC communications
software.

109: PHASE – PHASE DESIGNATION

PHASE can be set to either A-B-C or A-C-B to match the positive-sequence phase rotation for the generator
system where the DGP is installed. This setting informs the relay of the actual system phase sequence, either
A-B-C or A-C-B. The CT and VT inputs on the relay, labeled as A, B, and C, must be connected to system
phases A, B, and C for correct operation. This setting permits the DGP to properly compute and report the
sequence-dependent quantities.

110: TIMESYNC – TIME SYNCHRONIZATION SOURCE

TIMESYNC determines the method of synchronizing the DGP system's internal clock. It can be set to 0
(INTERNAL), 1 (optional, IRIG-B), or 2 (G-NET). TIMESYNC = 0 lets the clock run freely from the internal
oscillator. TIMESYNC = 1 synchronizes the clock using an IRIG-B signal connected directly to the DGP via
port PL-3. TIMESYNC = 2 synchronizes the clock using a signal on pin 25 of RS232 port PL-1 when connected
to a G-NET host computer.

111: NUM FLTS – NUMBER OF FAULT EVENTS

NUM FLTS selects the maximum number of fault reports and optional oscillography data that may be stored in
memory without overwriting, and can be set to 1, 2, or 3. When the maximum number are stored in memory,
the fault report and the oscillography data associated with a subsequent storage event will overwrite the data
from the oldest event.

This setting also apportions a fixed amount of memory into different sized blocks for oscillography storage. The
following tabulation shows the total number of oscillography cycles allowed per storage event as a function of
NUM FLTS.

To avoid loss of fault data stored in the DGP, upload and save the data before changing this
setting.

NUM FLTS STORAGE CYCLES
1 120
2  60
3  40

CAUTION
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112: PREFLT – PREFAULT CYCLES

PREFLT selects the number of pre-trigger (or pre-fault) cycles in each oscillography data set. It can be set from
1 to 20. Setting 111: NUM FLTS determines the total number of cycles per storage event, as explained above,
and PREFLT determines how many of these are pre-trigger cycles.

113: OSC TRIG – EXTERNAL OSCILLOGRAPHY TRIGGER

A DGP system trip always causes oscillography to be stored. OSC TRIG enables or disables an additional
oscillography trigger by an external digital input (DI5). Refer to Section 1.4.9: FAULT REPORT & OSCILLOG-
RAPHY DATA on page 1–22 for further explanation. OSC TRIG may be set to 0 (DI ENA) or 1 (DI DIS).

114: NOM VOLT – NOMINAL VOLTAGE

NOM VOLT can be set from 100.0 to 140.0 V (phase-to-phase).

For the sample generator system,

115: RATEDCUR – RATED CURRENT

RATEDCUR can be set from 0.10 to 9.99 A (0.02 to 1.99 A for models with 1 A rating).

For the sample generator system,

116: VT CONN – VOLTAGE TRANSFORMER CONNECTION

VT CONN may be set to 0 (WYE) or 1 (DELTA). VT CONN must be set to identify the VT connections that sup-
ply AC voltage to the DGP.

117: NCTRATIO – NEUTRAL CURRENT TRANSFORMER RATIO

NCTRATIO setting is available in all DGP models except DGP***AAA. It can be set from 1 to 50000. This set-
ting applies to INR current only; refer to Current Transformer Ratio (Setting 106: CT RATIO) for the CT ratio set-
ting of other current inputs.

For the sample generator system,

2.2.2 EXAMPLE CONFIGURATION SETTINGS

Example Settings (based on Figure 2–1: SAMPLE GENERATOR SYSTEM):

UNITID =1 PHASE = A-B-C (0)
SYSFREQ = 60 TIMESYNC = INTRNL (0)
SEL TVM = as required NUM FLTS = 3
SEL TCM = as required NOM VOLT = 114.3 volts
SELPRIM = PRIMARY (0) RATEDCUR = 4.25 amps
CT RATIO = 1600 VT CONN = WYE (0)
VT RATIO = 157.5 NCTRATIO = 1600
COMMPORT = 2401

NOM VOLT 18000
18900 120⁄( )

----------------------------------- 114.3 V= =

RATEDCUR 211765
1.732 18×( ) 8000 5⁄( )

---------------------------------------------------------- 4.25 A= =

NCTRATIO 8000
5

------------- 1600= =
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2.3 PROTECTION FUNCTION SETTINGS 2.3.1 TRIP AND ALARM OUTPUT RELAYS

There are eight user-configurable output relays included in the DGP system. Four of these are high-speed
relays intended for tripping and four are standard-speed relays intended for alarm. Each of the protection func-
tions described below includes two four-digit settings, TRIP and ALARM, which configure the function to oper-
ate any number of these relays. An output relay is selected or de-selected by setting a code to 1 or 0,
respectively. The four-digit code of the TRIP setting applies to the 94G, 94G1, 94G2, and 94G3 relays, in that
order. The four digit code of the ALARM setting applies to the 74A, 74B, 74C, and 74D relays, in that order.

Any number of the protection functions can be disabled by setting both the TRIP and ALARM codes for the
function or functions to 0000.

The configurable trip and alarm outputs can be used to customize the DGP in accordance with a number of
user-defined trip and alarm strategies.

2.3.2 STATOR DIFFERENTIAL 87G

Algorithm: Function 87G operates when the following inequality is met:

where:  = Generator return-side phase current

 = Generator system-side phase current

K = an adaptive variable 

where K1 = 87G K1 setting in percent (Setting 203: K1)

1. The algorithm is processed only if

2. The algorithm is processed separately for each phase.

3. The initial characteristic slope can be calculated using the formula:

Characteristics: The following four graphs show the curves for selected values of Setting 203: K1 and 204:
PICKUP. The curve for any combination of the 203: K1 and 204: PICKUP settings can be derived using the
algorithm above.

This function should be set as sensitive as practical, keeping adequate margin for CT errors under all through-
load and through-fault current conditions. K1 and PICKUP settings of 2% and 0.3 A, respectively, are recom-
mended for most applications where the system and neutral side CTs are of identical design. Higher settings
must be considered if the CTs are not of identical design or if a higher CT error margin is desired.

For the sample generator system, set K1 = 2% and PICKUP = 0.3 A.

I1 I2–
2 K I1 I2⋅( )>

I1
I2

K1 100⁄              if  I1 I2⋅ 81≤=

15 K1× 100⁄      if  I1 I2⋅ 81>=

I1 I2– 87G PICKUP>

% slope 100 K1
100
----------⋅=
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Figure 2–2: 87G CHARACTERISTICS – K1 = 1%, PICKUP = 0.3 A
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Figure 2–3: 87G CHARACTERISTICS – K1 = 2%, PICKUP = 0.3 A
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Figure 2–4: 87G CHARACTERISTICS – K1 = 5%, PICKUP = 0.3 A
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Figure 2–5: 87G CHARACTERISTICS – K1 = 10%, PICKUP = 0.3 A
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2.3.3 CURRENT UNBALANCE ALARM 46A

This function is intended to alarm prior to a 46T trip to enable an operator to take corrective action. Setting 302:
PICKUP should be a safe margin below the generator's allowable continuous negative-sequence current.

For the sample generator system,

set 303: TL14 = 2 seconds

2.3.4 CURRENT UNBALANCE TRIP 46T

Algorithm:

where

I2 = Negative sequence current

K2 = 46T K2 setting (Setting 404: K2)

IFL = Full load current of the machine (Setting 115: RATEDCUR)

1. Time T is computed only if I2 > 46T PICKUP

2. Reset time: Linear reset (227 seconds maximum)

Characteristics: Figure 2–6: TIME CURRENT CHARACTERISTIC OF 46T FUNCTION shows the curves for
selected values of Setting 404: K2. The curve for any other K2 setting can be derived with the above algorithm.

This function should be set at or below the negative-sequence current capability of the machine.

For the sample generator system,

set K2 = machine  capability = 10

set 302: PICKUP 70% of I2 capability of the machine=

0.7 0.08× 211765×
1.732 18×

----------------------------------------------------=

380.4 A primary=

0.24 A secondary=

Operating Time T K2
I2 IFL⁄( )2

-----------------------=   seconds

set PICKUP I2 capability of the machine=

0.08 211765
1.732 18× 1600×
-----------------------------------------------×=

0.34 A secondary=

I2
2T
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Figure 2–6: TIME CURRENT CHARACTERISTIC OF 46T FUNCTION
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2.3.5 LOSS OF EXCITATION 40, 40-1, 40-2

Algorithm: Impedance looking in to the machine is computed using delta voltage and delta current as shown in
the following equation. Functions 40-1 and 40-2 are identical, each with an adjustable time delay.

Characteristic and setting criteria: See Figure 2–7: MHO CHARACTERISTICS FOR 40-1 & 40-2 FUNCTIONS.

With settings per the criteria shown in Figure 2–7: MHO CHARACTERISTICS FOR 40-1 & 40-2 FUNCTIONS,
function 40-1 detects the loss of excitation for about 30% or higher load conditions; function 40-2 detects for all
load conditions, However, some stable power system swing conditions may momentarily enter the 40-2 char-
acteristic. For security of the function under stable swing conditions, it is recommended to delay functions 40-1
and 40-2 by a minimum of 0.06 and 0.5 seconds, respectively.

Setting 501: SELV2SUP can be set to either 0 (DISABLE) or 1 (ENABLE). It is recommended to set this to
function to ENABLE unless an external VTFF is used via input DI6.

For the sample generator system,

(secondary) = 15.54 × 0.216 = 3.36 ohms

(secondary) = 15.54 × 1.967 = 30.57 ohms

Set 501: SELV2SUP to 1 (ENABLE).

Set the 40-1 setpoints to the following values:

Set the 40-2 setpoints to the following values:

Zab
Va Vb–

Ia Ib–
-------------------=   if Setting 109: PHASE = A-B-C

Zac
Va Vc–

Ia Ic–
-------------------=   if Setting 109: PHASE = A-C-B

Zb secondary( )
kVbase

2

MVAbase
----------------------- CT Ratio

VT Ratio
-----------------------×=

182

211.765
--------------------- 1600

157.5
---------------×=  = 15.54 ohms

Xd′

Xd

CENTER 15.54 3.36+
2

--------------------------------- 9.45 ohms= =

RADIUS 15.54
2

--------------- 7.77 ohms= =

TL12 0.06 seconds=

CENTER 30.57 3.36+
2

--------------------------------- 16.97 ohms= =

RADIUS 30.57
2

--------------- 15.28 ohms= =

TL12 0.5 seconds=
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Figure 2–7: MHO CHARACTERISTICS FOR 40-1 & 40-2 FUNCTIONS

2.3.6 ANTI-MOTORING (REVERSE POWER)

The 32-1 and 32-2 anti-motoring reverse power level settings 804: REV PWR and 903: REV PWR (optional,
not available in DGP***ABA models) can be set from 0.5 to 99.9 W each.

The reverse power levels (REV PWR) of 32-1 and 32-2 should be set at 30 to 70% (depending on power factor
following the turbine trip) of the turbine-generator motoring power .

Integrating type timers are associated with anti-motoring to achieve high level of dependability when the power
is around the REV PWR setting, particularly at high power factor. If Setting 803: SQ TR EN (sequential trip
enable) is set to YES, a value of three seconds or less is suggested for the timer TL1 associated with 32-1. If
SQ TR EN is set to NO, Setting 805: TL1 should be identical to Setting 904: TL2 described below.

Timer TL2, associated with 32-2, should be set to override the power swings expected during normal system
operations. A setting of 10 to 60 seconds is suggested.

Setting 803: SQ TR EN can be set to YES or NO, depending on the generator tripping strategy used.

C1C2

40-1

40-2

R1

R2

Zb

Xd

X'd/2
R

X

C1 = Center of 40-1

= (Zb + X'd)/2

R1 = Radius of 40-1

= Zb/2

C2 = Center of 40-2

= (Xd + X'd)/2

R2 = Radius of 40-2

= Xd/2

Zb = Base impedance of the machine

X'd = Transient reactance of the machine

Xd = Synchronous reactance of the machine
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For the sample generator system,

Set REV PWR to:

REV PWR = 0.5 × 87.3 (functions 32-1 and 32-2)
= 43.6 watts

Set TL1 to:

TL1 = 2 or 30 seconds, depending on Setting 803: SQ TR EN.

Set TL2 to:

TL2 = 30 seconds

2.3.7 OVERCURRENT WITH VOLTAGE RESTRAINT (51V)

Algorithm:

where: T = Operating time.
K = time factor (Setting 1004: TIME FAC).
I / IPU = current in multiple of IPU (Setting 1003: PICKUP).
VNOM = Nominal Voltage (Setting 114: NOM VOLT)
V =  for Wye connected VTs (see note 2)

phase-to-phase voltage for Delta connected VTs

1. Time T is computed individually for each phase.

2. See the table below for the restraint voltages corresponding to phase currents for different PHASE (Setting
109) and VT CONN (Setting 116) settings.

3. If the quantity V / VNOM < 0.3, then 0.3 is used as its value in the equation.

4. If the quantity , then 65.5 is used as its value in the equation.

5. Reset Time: Linear reset with maximum of 1.4 seconds.

Table 2–2: 51V RESTRAINT VOLTAGES

CURRENT RESTRAINT VOLTAGES

PHASE →
VT →

ABC
WYE

ABC
DELTA

ACB
WYE

ACB
DELTA

IA VA VAB VA VAC

IB VB VBC VB VBA

IC VC VCA VC VCB

motoring power 22000 1000×
CT RATIO VT RATIO×
--------------------------------------------------------------=  watts 22000 1000×

1600 157.5×
------------------------------------  watts 87.3 watts= =

T K
I IPU⁄

V VNOM⁄
----------------------- 1–

-------------------------------------=  seconds

3 phase-to-ground voltage×

I IPU⁄
V VNOM⁄
----------------------- 0.3<
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Characteristics: The following four graphs show the curves for selected values of K and Voltage Restraint. The
curve for any combination of K and Restraint Voltage can be determined with the above algorithm.

This function should be set to coordinate with the power system protective relays used at the generating sta-
tion. Also, the PICKUP setting should be a safe margin above the expected maximum load on the machine.
Refer to Section 2.3.19: ACCIDENTAL ENERGIZATION AE on page 2–37 for additional considerations regard-
ing the 51V PICKUP setting.

For the sample generator system,

set PICKUP= 1.75 × generator rated load current
= 1.75 × 4.25 A
= 7.5 A secondary

Setting 1004: TIME FAC (K) should be selected to back up the relays on transmission lines out of the generat-
ing station. As the information about line relays is not known, set TIME FAC such that the operate time of 51V
for a 3-phase fault on the high side of the GSU is about 0.75 second. For simplicity, power system contribution
to the fault is not considered in the following calculations.

Generator contribution = 4.25 / 0.322 = 13.2 A secondary

Multiple of PICKUP = 13.2 / 7.5 = 1.76

Generator terminal voltage = 

% restraint = 

TIME FAC (K) = 

set TIME FAC = 1.0

Impedance to fault 21.6 10 211.765
200

---------------------× 
 + 21.6 10.6+ 32.2% at machine base= = =

18 10.6
32.2
-----------× 5.93=  kV

5.93
18

----------- 100× 32.9%=

0.75 1.76
0.329
--------------- 1– 

 × 0.985 or higher=
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Figure 2–8: 51V TIME-CURRENT CHARACTERISTICS FOR 0 TO 30% RESTRAINT
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Figure 2–9: 51V TIME-CURRENT CHARACTERISTICS FOR 50% RESTRAINT
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Figure 2–10: 51V TIME-CURRENT CHARACTERISTICS FOR 75% RESTRAINT
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Figure 2–11: 51V TIME-CURRENT CHARACTERISTICS FOR 100% RESTRAINT
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2.3.8 STATOR GROUND FAULT 64G-1

Algorithm: 64G-1 operates if following condition is met:

VN1 ≥ PICKUP for time > TL4 seconds

where: VN1 = Neutral voltage of fundamental frequency
PICKUP = 64G-1 pickup setting
TL4 = timer TL4 setting

Setting 1103: PICKUP of 64G-1 should be set with a safe margin above the highest voltage (fundamental fre-
quency) expected at the generator neutral under normal operating conditions. Timer TL4 should be set with a
safe margin above the longest clearing time for power system faults that are outside of the generator protection
zone.

For the sample generator system,

set 1103: PICKUP = 5.0 volts

set 1104: TL4 = 1 second or higher

2.3.9 STATOR GROUND FAULT 64G-2

Algorithm: 64G-2 operates when the following condition is met:

The only setting required for this optional function is for timer TL5 (Setting 1203: TL5) to provide a short delay
for security of the function.

For the sample generator system,

set 1203: TL5 = 0.10 second.

2.3.10 STATOR GROUND FAULT 27TN

Algorithm: 27TN operates when the following conditions are met (see Figure 1–5: SIMPLE LOGIC DIAGRAM –
64G1, 64G2, 51GN, AND 24 on page 1–15 for the logic diagram):

VN3 < 27TN PICKUP and V1 > 25V for time > TL20

where: VN3 = Third harmonic voltage at generator neutral.
V1 = Positive sequence voltage at generator terminals.
TL20 = Timer TL20 (Setting 3004: TL20).

Setting 3003: PICKUP should be set as sensitive as the VN3 characteristic of the generator allows without loss
of security. A flexible window of power can be established to enhance security of 27TN. For example, assume
that the available VN3 is below 27TN pickup for power outputs in the range of 50 to 80 watts. The flexible win-
dow is provided by Settings 3005: FORPWR-L and 3006: FORPWR-H, which can be set at 47 and 85 watts
(based on margin of about 5%) respectively to inhibit the function between the limits. This function can also be
blocked when the generator is off-line; refer to Setting 2501: SELBKDI1.

Settings 3003: PICKUP, 3005: FORPWR-L, and 3006: FORPWR-H require measurements to determine
proper settings. The DGP measures and displays 3rd harmonic voltage (THIRD HARMONIC N) at the genera-
tor terminals. The 3rd harmonic voltage varies at very low forward power levels and in many cases is non-zero
when the generator is starting and becomes lower (or zero) in a certain band of forward power. Is is recom-
mended that the 3rd harmonic voltage related to forward power is recorded as the unit is started and ran to full
load to determine the exact values for PICKUP, FORPWR-L, and FORPWR-H.

VN3
VP3 3⁄( ) VN3+

--------------------------------------- 0.15  for time >TL5 seconds≤
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2.3.11 OVEREXCITATION ALARM (VOLTS/HERTZ: 24A)

This function is intended to alarm prior to a 24T trip, allowing an operator to take corrective action. Setting
1302: PICKUP should be below the continuous Volts/Hz rating of the generator or step-up transformer, which-
ever is lower. Timer TL6 (Setting 1303: TL6) should be set to minimize the nuisance alarms.

For the sample generator system, assume an allowable over V/Hz of 10%.

set PICKUP = 1 + (90% of 10%) per unit = 1.09 per unit

set TL6 = 2 seconds.

2.3.12 OVEREXCITATION TRIP (VOLTS/HERTZ: 24T)

Algorithm:

where

T1 = Operating time for CURVE #1 (see Figure 2–12: TIME CHARACTERISTICS OF FUNCTION 24T
(CURVE 1) on page 2–31)

T2 = Operating time for CURVE #2 (see Figure 2–13: TIME CHARACTERISTICS OF FUNCTION 24T
(CURVE 2) on page 2–32)

T3 = Operating time for CURVE #3 (see Figure 2–14: TIME CHARACTERISTICS OF FUNCTION 24T
(CURVE 3) on page 2–33)

T4 = Operating time for CURVE #4 - characteristic of curve #4 is definite time providing the operating time
equal to K seconds if

K = Time factor (Setting 1406: TIME FAC)

VNOM = nominal voltage (Setting 114: NOM VOLT)

FS = system frequency (Setting 102: SYSFREQ)

PU = V/Hz pickup (Setting 1405: INV PU)

1. The algorithm is processed separately for each phase.

2. V and VNOM values used are phase-ground voltages for wye-connected VTs. However, phase-phase volt-
ages are used for delta-connected VTs. The following table shows the voltages used by each of the three

T1 K
V F⁄

PU VNOM FS⁄( )×
--------------------------------------------- 

  2
1–

---------------------------------------------------------------  seconds=

T2 K
V F⁄

PU VNOM FS⁄×
---------------------------------------- 1–
--------------------------------------------------  seconds=

T3 K
V F⁄

PU VNOM FS⁄( )×
--------------------------------------------- 

  0.5
1–

-------------------------------------------------------------------  seconds=

T4 K  seconds=

V
F
---- PU

VNOM
FS

---------------×>
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phases for different phase designations (Setting 109: PHASE) and VT connections (Setting 116: VT
CONN).

3. Reset time: Linear reset with maximum time = RESET setting (Setting 1409).

This function should be set with a safe margin below the excitation capability of the generator or step-up
transformer, whichever is lower. The following example is based on the traditional criteria of 45 seconds
operating time at V/Hz from 1.1 to 1.18 per unit. However, actual excitation capability curves should be
obtained for the generator and the transformer to take full advantage of the inverse characteristic of this
function. Setting 1409: RESET should be set to match the cooling characteristic of the protected equip-
ment (if known). If the reset characteristic is not available, a setting in the range of 0 to 50 seconds may be
used.

For the sample generator system, using CURVE #4 (definite time) and operating time of 45 seconds:

set INV PU = 1.10 per unit

set TIME FAC = 45 seconds

set INST PU = 1.18 per unit

set TL7 = 2 seconds

set RESET = 30 seconds

Table 2–3: 24A VOLTAGES

PHASE VOLTAGES

PHASE →
VT →

ABC
WYE

ABC
DELTA

ACB
WYE

ACB
DELTA

A VA VAB VA VAB

B VB VBC VB VBC

C VC VCA VC VCA
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Figure 2–12: TIME CHARACTERISTICS OF FUNCTION 24T (CURVE 1)
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Figure 2–13: TIME CHARACTERISTICS OF FUNCTION 24T (CURVE 2)
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Figure 2–14: TIME CHARACTERISTICS OF FUNCTION 24T (CURVE 3)
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2.3.13 OVERVOLTAGE 59

Algorithm:

T2 = K seconds

T3 = no intentional time delay

where:

T1 = Operating time for CURVE #1 (see Figure 2–15: 59 TIME-VOLTAGE CHARACTERISTICS)

T2 = Operating time for CURVE #2 (the characteristic of optional curve #2 is definite time providing the
operating time equal to K seconds if V1 > VPU)

T3 = Operating time of optional instantaneous function if V1 > VPU

K = time factor (Setting 1504: TIME FAC)

V1 = positive-sequence voltage (phase-phase)

VPU = overvoltage pickup (Setting 1503: INV PICKUP)

VIPU = instantaneous overvoltage pickup (Setting 1506: INST PU)

Reset Time: Linear reset (1.4 seconds maximum)

Characteristics: Figure 2–15: 59 TIME-VOLTAGE CHARACTERISTICS shows the CURVE #1 for selected val-
ues of K. The curve for any other K setting can be derived using the above algorithm.

This function should be set with a safe margin below the overvoltage capability of the protected equipment.
Function 59 can provide backup to function 24T.

For the sample generator system, set 59 using criteria similar to 24T settings except with lower sensitivity and
higher operating time.

Set VPU = 1.1 × NOM VOLT = 1.1 × 114.3 = 126 volts

For determining the time factor K (assuming CURVE #1 is used), use an operating time of about 45 seconds at
115% of PICKUP voltage.

Voltage (V) = 1.15 × 126 = 144.9 volts

Time Factor K = 

T1 K
V1

VPU
---------- 1–

--------------------  seconds=

45 144.9
126

--------------- 1– 
 ⋅ 6.75=
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Figure 2–15: 59 TIME-VOLTAGE CHARACTERISTICS
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2.3.14 UNDERVOLTAGE CUTOFF OF 81

Setting 1601: UVCUTOFF can be set from 35 to 99% of the nominal voltage (Setting 114: NOM VOLT). This
setting can be used to block the frequency functions from operating during start-up conditions until near-normal
generator field is applied and set voltage is generated.

2.3.15 UNDERFREQUENCY 81-U

There are either two or four underfrequency functions included with the DGP, depending on the model. Each of
the functions (Settings 1703/1803/1903/2003: SET PNT) can be set from 40.00 to 65.00 Hz, with a time delay
of 0.1 to 999.9 seconds for 81-1U and 0.05 to 99.99 seconds for the other(s). The actual settings will depend
on the protection and operating philosophies of the individual user.

2.3.16 OVERFREQUENCY 81-O

There are either two or four overfrequency functions included in the DGP, depending on the model. Each of the
functions (Settings 2103/2203/2303/2403: SET PNT) can be set from 45.00 to 79.99 Hz, with a time delay of
0.05 to 99.99 seconds. The actual settings will depend on the protection and operating philosophies of the indi-
vidual user.

2.3.17 DIGITAL INPUT DI

Setting 2501: SELBKDI1 determines the blocking action by digital input DI1 (generator off-line) when it is ener-
gized. It is set from 0 to 9 depending on the protection functions to be blocked during the start-up. The table
below describes the different blocking actions:

Note that for DGP***ABA models, some of the SELBKDI1 settings are functionally redundant; any one of such
settings may be used to obtain the specified functionality.

Table 2–4: DI1 BLOCKING CONFIGURATION

SELBKDI1 FUNCTIONS DISABLED (X) BY DI1

81 32 64G2 / 27TN 1 VTFF

NO BLK (0) - - - -

BLK #1 (1) X - - X

BLK #2 (2) X - X -

BLK #3 (3) X - X X

BLK #4 (4) X X - -

BLK #5 (5) - X - X

BLK #6 (6) X X - X

BLK #7 (7) - X X X

BLK #8 (8) X - - -

BLK #9 (9) X X X X

1 Refer to the Nomenclature Guide for available functions
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An appropriate combination of functions 81, 32, 64G2, 27TN, and VTFF should be blocked during start-up
(generator off-line) as required. For example, to prevent nuisance operation, Setting 2501: SELBKDI1 may be
set as follows:

• BLK #6 to block 81, 32, and VTFF for cross compound machine.

• BLK #8 to block 81 if generator field is applied at a speed lower than the speed corresponding to lowest
81U setpoint.

• BLK #9 to block all four functions for a gas turbine generator with static start.

Settings 2502: DI3 TRIP, 2503: DI3 ALARM, 2504/5: DI4 TRIP, and 2505/6: DI4 ALARM can be used to oper-
ate any or all of the Trip (94G to 94G3) or Alarm (74A to 74D) relays. If the settings are selected, energizing the
corresponding digital input will cause the appropriate Trip and Alarm relay to operate after time delay, if appli-
cable.

Setting 2508: DI6 FUNC can be set to 0 (EXTVTFF) or 1 (DISPROT) to configure the DI6 input. If set to 0
(EXTVTFF), the DI6 is configured to receive an external VTFF signal. If set to 1 (DISPROT), the DI6 is config-
ured to disable all protection functions as long as the input signal is present. It should be set to 0 (EXTVTFF) if
the input DI6 is not used.

2.3.18 VOLTAGE TRANSFORMER FUSE FAILURE VTFF

Setting 2601: VTFF can be set to either 0 (DISABLE) or 1 (ENABLE) as desired. It is recommended to set
VTFF = 1 (ENABLE) if the external VTFF input (DI6) is not used. If the external VTFF input is used, the VTFF
setting will depend on user preference.

2.3.19 ACCIDENTAL ENERGIZATION AE

Setting 2703: AE ARM can be set to 0 (AND) or 1 (OR) as desired. If set to 0 (AND), the logic will be armed
when the positive sequence voltage V1 < 30 volts and the generator is off-line. If it is set to 1 (OR), the logic will
be armed when the voltage V1 < 30 volts or the generator is off-line. The setting of 0 (AND) is recommended.
However, if both of the following conditions apply, it must be set to 1 (OR) for effective arming of the logic.

• The generator system includes a generator disconnect device (breaker or switch), and

• The VTs are connected on the power system side of the disconnect device.

Since the pickup flag of function 51V is used for instantaneous overcurrent signal in the Accidental Energiza-
tion logic (Figure 1–3: SIMPLE LOGIC DIAGRAM – 87G, 32, 27, 59, AND AE on page 1–13), the following
additional criteria should be used in setting the 51V PICKUP.

The 51V PICKUP (Setting 1003: PICKUP) should be set with a safe margin above ILMAX, where ILMAX is an
expected maximum load current of the machine. If Setting 2703: AE ARM is set to 1 (OR) and simultaneous
loss of all three phase voltages is likely, then PICKUP should be set with a safe margin above 3.33 × ILMAX.

Note that function AE will be effectively disabled if function 51V is disabled by setting both its TRIP and
ALARM codes (Settings 1001 and 1002) to 0000. This is in addition to the normal way of disabling function AE
by setting its TRIP and ALARM codes (Settings 2701 and 2702) to 0000.

For the sample generator system,

set AE ARM = 0 (AND)
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2.3.20 GROUND OVERCURRENT 51GN

Algorithm:

where:

K = time factor (Setting 2804: TIME FAC)

INR = Neutral current (fundamental frequency)

IPU = Setting 2803: PICKUP current

Reset Time: Linear reset (1.4 seconds maximum)

Characteristics: Figure 2–16: 51GN TIME-CURRENT CHARACTERISTICS shows the curves for selected val-
ues of K. The curve for any other value of K can be derived using the above algorithm.

Setting 2803: PICKUP of 51GN should be set with a safe margin above the highest neutral current (fundamen-
tal frequency) expected under normal operating conditions. Setting 2804: TIME FAC should be set to coordi-
nate with other protective devices for power system faults that are outside of the generator protection zone.

For the sample generator system, function 51GN is not usable, due to the high resistance grounding and high
CT ratio for the function. Set Settings 2801: TRIP and 2802: ALARM to 0000 to disable the function.

2.3.21 UNDERVOLTAGE 27

Algorithm:

where:

T1= operating time for CURVE #1 (Figure 2–17: 27 TIME-VOLTAGE CHARACTERISTICS on page 2–40)

T2= operating time for CURVE #2 (the characteristic of CURVE #2 is definite time providing the operating
time is equal to K seconds if V1 < VPU)

V1 = positive-sequence voltage (phase-phase).

VPU = undervoltage function threshold (Setting 2903: PICKUP).

Reset Time: Linear reset (1.4 seconds maximum)

The algorithm is NOT processed if input DI1 (generator off-line) is present.

Characteristics: Figure 2–17: 27 TIME-VOLTAGE CHARACTERISTICS shows the CURVE #1 for selected val-
ues of K. The curve for any other K setting can be derived using the above algorithm. This optional function
can be used to isolate the generator from the utility system for an undervoltage condition. Settings 2905:
CURVE #, 2903: PICKUP, and 2904: TIME FAC should be set to override voltage dips caused by normal
power system faults.

For the sample generator system, 27 can be set as follows:

CURVE # = 2 (Definite Time)
PICKUP = 102 V (< 90% of NOM VOLT of 114.3 V)
TIME FAC = 1.0 second

Operating Time T K
INR IPU⁄ 1–

----------------------------------  seconds=

T1 K
VPU V1⁄( ) 1–

-----------------------------------  seconds=
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Figure 2–16: 51GN TIME-CURRENT CHARACTERISTICS
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2

Figure 2–17: 27 TIME-VOLTAGE CHARACTERISTICS
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2

2.4 COMMISSIONING 2.4.1 DGP***AAA SETTINGS TABLE

Table 2–5: DGP***AAA SETTINGS TABLE (Sheet 1 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ AAA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ F

SETTING # MNEMONIC DESCRIPTION USER SETTING

CONFIGURATION: CONFIG

101 UNITID Unit ID number 

102 SYSFREQ System Frequency Hz

103 SEL TVM Select Trip Voltage Monitoring 

104 SEL TCM Select Trip Current Monitoring 

105 SELPRIM Select Primary/Secondary units 

106 CT RATIO Current Transformer Ratio

107 VT RATIO Voltage Transformer Ratio 

108 COMMPORT Communications Port   

109 PHASE Phase Rotation

110 TIMESYNC Time Synchronizing source 

111 NUM FLTS Number of Fault events stored 

112 PREFLT Number of prefault cycles stored Cycles

113 OSC TRIG External oscillography trigger

114 NOM VOLT Nominal Voltage of generator Volts

115 RATEDCUR Rated Current of generator Amps

116 VT CONN Type of VT connection   

STATOR DIFFERENTIAL: 87G

201 TRIP Configure trip outputs 

202 ALARM Configure alarm outputs

203 K1 K factor %

204 PICKUP Pickup level Amps

CURRENT UNBALANCE – ALARM: 46A

301 ALARM Configure alarm outputs 

302 PICKUP Pickup current (Negative sequence) Amps

303 TL14 Timer TL14 setting Sec.

CURRENT UNBALANCE – TRIP: 46T

401 TRIP Configure trip outputs 
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2
402 ALARM Configure alarm outputs 

403 PICKUP Pickup current (Negative sequence) Amps

404 K2 K factor   Sec.

LOSS OF EXCITATION – SUPERVISION: 40

501 SELV2SUP Select V2 supervision of 40

LOSS OF EXCITATION – ZONE 1: 40-1

601 TRIP Configure trip outputs 

602 ALARM Configure alarm outputs 

603 CENTER Center of characteristic Ohms

604 RADIUS Radius of characteristic Ohms

605 TL12 Timer TL12 setting Sec.

LOSS OF EXCITATION – ZONE 2: 40-2

701 TRIP Configure trip outputs 

702 ALARM Configure alarm outputs 

703 CENTER Center of characteristic Ohms

704 RADIUS Radius of characteristic Ohms

705 TL13 Timer TL13 setting Sec.

ANTI-MOTORING #1: 32-1

801 TRIP Configure trip outputs 

802 ALARM Configure alarm outputs 

803 SQ TR EN Enable sequential trip

804 REV PWR Reverse power pickup Watts

805 TL1 Timer TL1 setting Sec.

ANTI-MOTORING #2: 32-2

901 TRIP Configure trip outputs 

902 ALARM Configure alarm outputs 

903 REV PWR Reverse power pickup Watts

904 TL2 Timer TL2 setting Sec.

OVERCURRENT WITH VOLTAGE RESTRAINT: 51V

1001 TRIP Configure trip outputs 

Table 2–5: DGP***AAA SETTINGS TABLE (Sheet 2 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ AAA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ F

SETTING # MNEMONIC DESCRIPTION USER SETTING
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2
1002 ALARM Configure alarm outputs 

1003 PICKUP Pickup current Amps

1004 TIME FAC Time factor Sec.

STATOR GROUND – ZONE 1: 64G1

1101 TRIP Configure trip outputs 

1102 ALARM Configure alarm outputs 

1103 PICKUP Pickup voltage Volts

1104 TL4 Timer TL4 setting Sec.

STATOR GROUND – ZONE 1: 64G2

1201 TRIP Configure trip outputs 

1202 ALARM Configure alarm outputs 

1203 TL5 Timer TL5 setting Sec.

OVEREXCITATION – ALARM: 24A

1301 ALARM Configure alarm outputs 

1302 PICKUP Pickup (V/Hz) Per Unit

1303 TL6 Timer TL6 setting Sec.

OVEREXCITATION – TRIP: 24T

1401 TRIP ON Configure trip outputs (on-line) 

1402 TRIP OFF Configure trip outputs (off-line)

1403 ALARM Configure alarm outputs

1404 CURVE # Curve number (Inverse characteristic)

1405 INV PU Pickup - V/Hz (Inverse characteristic) Per Unit

1406 TIME FAC Time factor Sec.

1407 INST PU Pickup - V/Hz (Instantaneous) Per Unit

1408 TL7 Timer TL7 setting Sec.

1409 RESET Reset time Sec.

OVERVOLTAGE: 59

1501 TRIP Configure trip outputs 

1502 ALARM Configure alarm outputs 

1503 PICKUP Inverse function pickup voltage (positive- sequence) Volts

Table 2–5: DGP***AAA SETTINGS TABLE (Sheet 3 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ AAA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ F

SETTING # MNEMONIC DESCRIPTION USER SETTING
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2
1504 TIME FAC Time factor Sec.

OVER/UNDER FREQUENCY VOLTAGE CUTOFF: 81

1601 UVCUTOFF Undervoltage cutoff level for functions 81 Volts

UNDERFREQUENCY SETPOINT 1: 81-1U

1701 TRIP Configure trip outputs 

1702 ALARM Configure alarm outputs 

1703 SET PNT Set point Hz

1704 TL8 Timer TL8 setting Sec.

UNDERFREQUENCY SETPOINT 2: 81-2U

1801 TRIP Configure trip outputs 

1802 ALARM Configure alarm outputs 

1803 SET PNT Set point Hz

1804 TL9 Timer TL9 setting Sec.

UNDERFREQUENCY SETPOINT 3: 81-3U

1901 TRIP Configure trip outputs 

1902 ALARM Configure alarm outputs 

1903 SET PNT Set point Hz

1904 TL10 Timer TL10 setting Sec.

UNDERFREQUENCY SETPOINT 4: 81-4U

2001 TRIP Configure trip outputs 

2002 ALARM Configure alarm outputs 

2003 SET PNT Set point Hz

2004 TL11 Timer TL11 setting Sec.

OVERFREQUENCY SETPOINT 1: 81-1O

2101 TRIP Configure trip outputs 

2102 ALARM Configure alarm outputs 

2103 SET PNT Set point Hz

2104 TL15 Timer TL15 setting Sec.

OVERFREQUENCY SETPOINT 2: 81-2O

2201 TRIP Configure trip outputs 

Table 2–5: DGP***AAA SETTINGS TABLE (Sheet 4 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ AAA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ F

SETTING # MNEMONIC DESCRIPTION USER SETTING
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2202 ALARM Configure alarm outputs 

2203 SET PNT Set point Hz

2204 TL16 Timer TL16 setting Sec.

OVERFREQUENCY SETPOINT 3: 81-3O

2301 TRIP Configure trip outputs 

2302 ALARM Configure alarm outputs 

2303 SET PNT Set point Hz

2304 TL17 Timer TL17 setting Sec.

OVERFREQUENCY SETPOINT 4: 81-4O

2401 TRIP Configure trip outputs 

2402 ALARM Configure alarm outputs 

2403 SET PNT Set point Hz

2404 TL18 Timer TL18 setting Sec.

DIGITAL INPUT: DIG INP

2501 SELBKDI1 Select blocking action by input DI1

2502 DI3 TRIP Configure trip outputs

2503 DI3 ALRM Configure alarm outputs

2504 DI4 TRIP Configure trip outputs

2505 DI4 ALRM Configure alarm outputs

VOLTAGE TRANSFORMER FUSE FAILURE: VTFF

2601 VTFF Enable/Disable VTFF

ACCIDENTAL ENERGIZATION: AE

2701 TRIP Configure trip outputs 

2702 ALARM Configure alarm outputs 

2703 AE ARM Arming logic, Accidental Energization

Table 2–5: DGP***AAA SETTINGS TABLE (Sheet 5 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ AAA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ F

SETTING # MNEMONIC DESCRIPTION USER SETTING
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2

2.4.2 DGP***ABA SETTINGS TABLE

Table 2–6: DGP***ABA SETTINGS TABLE (Sheet 1 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ ABA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ J

SETTING # MNEMONIC DESCRIPTION USER SETTING

CONFIGURATION: CONFIG

101 UNITID Unit ID number 

102 SYSFREQ System Frequency Hz

103 SEL TVM Select Trip Voltage Monitoring 

104 SEL TCM Select Trip Current Monitoring 

105 SELPRIM Select Primary/Secondary units 

106 CT RATIO Current Transformer Ratio

107 VT RATIO Voltage Transformer Ratio 

108 COMMPORT Communications Port   

109 PHASE Phase Rotation

110 TIMESYNC Time Synchronizing source 

111 NUM FLTS Number of Fault events stored 

114 NOM VOLT Nominal Voltage of generator Volts

115 RATEDCUR Rated Current of generator Amps

116 VT CONN Type of VT connection   

117 NCTRATIO Current Transformer Ratio (Neutral)

STATOR DIFFERENTIAL: 87G

201 TRIP Configure trip outputs 

202 ALARM Configure alarm outputs

203 K1 K factor %

204 PICKUP Pickup level Amps

CURRENT UNBALANCE – ALARM: 46A

301 ALARM Configure alarm outputs 

302 PICKUP Pickup current (Negative sequence) Amps

303 TL14 Timer TL14 setting Sec.

CURRENT UNBALANCE – TRIP: 46T

401 TRIP Configure trip outputs 

402 ALARM Configure alarm outputs 
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403 PICKUP Pickup current (Negative sequence) Amps

404 K2 K factor   Sec.

LOSS OF EXCITATION – SUPERVISION: 40

501 SELV2SUP Select V2 supervision of 40

LOSS OF EXCITATION – ZONE 1: 40-1

601 TRIP Configure trip outputs 

602 ALARM Configure alarm outputs 

603 CENTER Center of characteristic Ohms

604 RADIUS Radius of characteristic Ohms

605 TL12 Timer TL12 setting Sec.

LOSS OF EXCITATION – ZONE 2: 40-2

701 TRIP Configure trip outputs 

702 ALARM Configure alarm outputs 

703 CENTER Center of characteristic Ohms

704 RADIUS Radius of characteristic Ohms

705 TL13 Timer TL13 setting Sec.

ANTI-MOTORING: 32-1

801 TRIP Configure trip outputs 

802 ALARM Configure alarm outputs 

803 SQ TR EN Enable sequential trip

804 REV PWR Reverse power pickup Watts

805 TL1 Timer TL1 setting Sec.

OVERCURRENT WITH VOLTAGE RESTRAINT: 51V

1001 TRIP Configure trip outputs 

1002 ALARM Configure alarm outputs 

1003 PICKUP Pickup current Amps

1004 TIME FAC Time factor Sec.

STATOR GROUND – ZONE 1: 64G1

1101 TRIP Configure trip outputs 

1102 ALARM Configure alarm outputs 

Table 2–6: DGP***ABA SETTINGS TABLE (Sheet 2 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ ABA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ J

SETTING # MNEMONIC DESCRIPTION USER SETTING
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1103 PICKUP Pickup voltage Volts

1104 TL4 Timer TL4 setting Sec.

OVEREXCITATION – ALARM: 24A

1301 ALARM Configure alarm outputs 

1302 PICKUP Pickup (V/Hz) Per Unit

1303 TL6 Timer TL6 setting Sec.

OVEREXCITATION – TRIP: 24T

1401 TRIP ON Configure trip outputs (on-line) 

1402 TRIP OFF Configure trip outputs (off-line)

1403 ALARM Configure alarm outputs

1404 CURVE # Curve number (Inverse characteristic)

1405 INV PU Pickup - V/Hz (Inverse characteristic) Per Unit

1406 TIME FAC Time factor Sec.

1407 INST PU Pickup - V/Hz (Instantaneous) Per Unit

1408 TL7 Timer TL7 setting Sec.

1409 RESET Reset time Sec.

OVERVOLTAGE: 59

1501 TRIP Configure trip outputs 

1502 ALARM Configure alarm outputs 

1503 PICKUP Inverse function pickup voltage (positive- sequence) Volts

1504 TIME FAC Time factor Sec.

1505 CURVE# Curve Number (1 = Inverse; 2 = Definite Time)

OVER/UNDER FREQUENCY VOLTAGE CUTOFF: 81

1601 UVCUTOFF Undervoltage cutoff level for functions 81 Volts

UNDERFREQUENCY SETPOINT 1: 81-1U

1701 TRIP Configure trip outputs 

1702 ALARM Configure alarm outputs 

1703 SET PNT Set point Hz

1704 TL8 Timer TL8 setting Sec.

Table 2–6: DGP***ABA SETTINGS TABLE (Sheet 3 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ ABA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ J

SETTING # MNEMONIC DESCRIPTION USER SETTING
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2
UNDERFREQUENCY SETPOINT 2: 81-2U

1801 TRIP Configure trip outputs 

1802 ALARM Configure alarm outputs 

1803 SET PNT Set point Hz

1804 TL9 Timer TL9 setting Sec.

OVERFREQUENCY SETPOINT 1: 81-1O

2101 TRIP Configure trip outputs 

2102 ALARM Configure alarm outputs 

2103 SET PNT Set point Hz

2104 TL15 Timer TL15 setting Sec.

OVERFREQUENCY SETPOINT 2: 81-2O

2201 TRIP Configure trip outputs 

2202 ALARM Configure alarm outputs 

2203 SET PNT Set point Hz

2204 TL16 Timer TL16 setting Sec.

DIGITAL INPUT: DIG INP

2501 SELBKDI1 Select blocking action by input DI1

2502 DI3 TRIP Configure trip outputs

2503 DI3 ALRM Configure alarm outputs

2504 DI3 TIMR Pickup Delay, DI3 timer sec.

2505 DI4 TRIP Configure trip outputs

2506 DI4 ALRM Configure alarm outputs

2507 DI4 TIMR Pickup delay, DI4 timer sec.

2508 DI6 FUNC Define DI6 Function

VOLTAGE TRANSFORMER FUSE FAILURE: VTFF

2601 VTFF Enable/Disable VTFF

ACCIDENTAL ENERGIZATION: AE

2701 TRIP Configure trip outputs 

2702 ALARM Configure alarm outputs 

2703 AE ARM Arming logic, Accidental Energization

Table 2–6: DGP***ABA SETTINGS TABLE (Sheet 4 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ ABA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ J

SETTING # MNEMONIC DESCRIPTION USER SETTING
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GROUND OVERCURRENT: 51GN

2801 TRIP Configure trip outputs 

2802 ALARM Configure alarm outputs 

2803 PICKUP Pickup current Amps

2804 TIME FAC Time factor sec.

UNDERVOLTAGE: 27

2901 TRIP Configure trip outputs 

2902 ALARM Configure alarm outputs 

2903 PICKUP Pickup voltage (Positive sequence) Volts

2904 TIME FAC Time factor sec.

2905 CURVE # Curve number (1-Inverse, 2-Def. Time)

UNDERVOLTAGE – THIRD HARMONIC: 27TN

3001 TRIP Configure trip outputs 

3002 ALARM Configure alarm outputs 

3003 PICKUP Pickup voltage (3rd Harmonic at generator neutral) Volts

3004 TL20 Timer TL20 setting Sec.

3005 FORPWR-L Lower limit of Forward Power window Watts

3006 FORPWR-H Upper limit of Forward Power window Watts

Table 2–6: DGP***ABA SETTINGS TABLE (Sheet 5 of 5)

LOCATION: GENERATOR NUMBER:
RELAY MODEL NUMBER: DGP _ _ _ ABA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ J

SETTING # MNEMONIC DESCRIPTION USER SETTING
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2.4.3 DGP****CA SETTINGS TABLE

Table 2–7: DGP***ACA SETTINGS TABLE (Sheet 1 of 6)

LOCATION: GENERATOR NUMBER:

RELAY MODEL NUMBER: DGP _ _ _ _CA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ D

SETTING # MNEMONIC DESCRIPTION USER SETTING

CONFIGURATION: CONFIG

101 UNITID Unit ID number 

102 SYSFREQ System Frequency Hz

103 SEL TVM Select Trip Voltage Monitoring 

104 SEL TCM Select Trip Current Monitoring 

105 SELPRIM Select Primary/Secondary units 

106 CT RATIO Current Transformer Ratio

107 VT RATIO Voltage Transformer Ratio 

108 COMMPORT Communications Port   

109 PHASE Phase Rotation

110 TIMESYNC Time Synchronizing source 

111 NUM FLTS Number of Fault events stored 

112 PREFLT Number of prefault cycles stored Cycles

113 OSC TRIG External oscillography trigger

114 NOM VOLT Nominal Voltage of generator Volts

115 RATEDCUR Rated Current of generator Amps

116 VT CONN Type of VT connection   

117 NCTRATIO Current Transformer Ratio (Neutral)

STATOR DIFFERENTIAL: 87G

201 TRIP Configure trip outputs 

202 ALARM Configure alarm outputs

203 K1 K factor %

204 PICKUP Pickup level Amps

CURRENT UNBALANCE – ALARM: 46A

301 ALARM Configure alarm outputs 

302 PICKUP Pickup current (Negative sequence) Amps

303 TL14 Timer TL14 setting Sec.
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2 CURRENT UNBALANCE – TRIP: 46T

401 TRIP Configure trip outputs 

402 ALARM Configure alarm outputs 

403 PICKUP Pickup current (Negative sequence) Amps

404 K2 K factor   Sec.

LOSS OF EXCITATION – SUPERVISION: 40

501 SELV2SUP Select V2 supervision of 40

LOSS OF EXCITATION – ZONE 1: 40-1

601 TRIP Configure trip outputs 

602 ALARM Configure alarm outputs 

603 CENTER Center of characteristic Ohms

604 RADIUS Radius of characteristic Ohms

605 TL12 Timer TL12 setting Sec.

LOSS OF EXCITATION – ZONE 2: 40-2

701 TRIP Configure trip outputs 

702 ALARM Configure alarm outputs 

703 CENTER Center of characteristic Ohms

704 RADIUS Radius of characteristic Ohms

705 TL13 Timer TL13 setting Sec.

ANTI-MOTORING #1: 32-1

801 TRIP Configure trip outputs 

802 ALARM Configure alarm outputs 

803 SQ TR EN Enable sequential trip

804 REV PWR Reverse power pickup Watts

805 TL1 Timer TL1 setting Sec.

ANTI-MOTORING #2: 32-2

901 TRIP Configure trip outputs 

902 ALARM Configure alarm outputs 

903 REV PWR Reverse power pickup Watts

904 TL2 Timer TL2 setting Sec.

Table 2–7: DGP***ACA SETTINGS TABLE (Sheet 2 of 6)

LOCATION: GENERATOR NUMBER:

RELAY MODEL NUMBER: DGP _ _ _ _CA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ D

SETTING # MNEMONIC DESCRIPTION USER SETTING
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2OVERCURRENT WITH VOLTAGE RESTRAINT: 51V

1001 TRIP Configure trip outputs 

1002 ALARM Configure alarm outputs 

1003 PICKUP Pickup current Amps

1004 TIME FAC Time factor Sec.

STATOR GROUND – ZONE 1: 64G1

1101 TRIP Configure trip outputs 

1102 ALARM Configure alarm outputs 

1103 PICKUP Pickup voltage Volts

1104 TL4 Timer TL4 setting Sec.

STATOR GROUND – ZONE 1: 64G2

1201 TRIP Configure trip outputs 

1202 ALARM Configure alarm outputs 

1203 TL5 Timer TL5 setting Sec.

OVEREXCITATION – ALARM: 24A

1301 ALARM Configure alarm outputs 

1302 PICKUP Pickup (V/Hz) Per Unit

1303 TL6 Timer TL6 setting Sec.

OVEREXCITATION – TRIP: 24T

1401 TRIP ON Configure trip outputs (on-line) 

1402 TRIP OFF Configure trip outputs (off-line)

1403 ALARM Configure alarm outputs

1404 CURVE # Curve number (Inverse characteristic)

1405 INV PU Pickup - V/Hz (Inverse characteristic) Per Unit

1406 TIME FAC Time factor Sec.

1407 INST PU Pickup - V/Hz (Instantaneous) Per Unit

1408 TL7 Timer TL7 setting Sec.

1409 RESET Reset time Sec.

OVERVOLTAGE: 59

1501 TRIP Configure trip outputs 

Table 2–7: DGP***ACA SETTINGS TABLE (Sheet 3 of 6)

LOCATION: GENERATOR NUMBER:

RELAY MODEL NUMBER: DGP _ _ _ _CA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ D

SETTING # MNEMONIC DESCRIPTION USER SETTING
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2 1502 ALARM Configure alarm outputs 

1503 PICKUP Inverse function pickup voltage (positive- sequence) Volts

1504 TIME FAC Time factor Sec.

1505 CURVE# Curve Number (1 = Inverse; 2 = Definite Time)

1506 INST PU Instantaneous Pickup Voltage (positive-sequence) Volts

OVER/UNDER FREQUENCY VOLTAGE CUTOFF: 81

1601 UVCUTOFF Undervoltage cutoff level for functions 81 Volts

UNDERFREQUENCY SETPOINT 1: 81-1U

1701 TRIP Configure trip outputs 

1702 ALARM Configure alarm outputs 

1703 SET PNT Set point Hz

1704 TL8 Timer TL8 setting Sec.

UNDERFREQUENCY SETPOINT 2: 81-2U

1801 TRIP Configure trip outputs 

1802 ALARM Configure alarm outputs 

1803 SET PNT Set point Hz

1804 TL9 Timer TL9 setting Sec.

UNDERFREQUENCY SETPOINT 3: 81-3U

1901 TRIP Configure trip outputs 

1902 ALARM Configure alarm outputs 

1903 SET PNT Set point Hz

1904 TL10 Timer TL10 setting Sec.

UNDERFREQUENCY SETPOINT 4: 81-4U

2001 TRIP Configure trip outputs 

2002 ALARM Configure alarm outputs 

2003 SET PNT Set point Hz

2004 TL11 Timer TL11 setting Sec.

OVERFREQUENCY SETPOINT 1: 81-1O

2101 TRIP Configure trip outputs 

2102 ALARM Configure alarm outputs 

Table 2–7: DGP***ACA SETTINGS TABLE (Sheet 4 of 6)

LOCATION: GENERATOR NUMBER:

RELAY MODEL NUMBER: DGP _ _ _ _CA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ D

SETTING # MNEMONIC DESCRIPTION USER SETTING
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22103 SET PNT Set point Hz

2104 TL15 Timer TL15 setting Sec.

OVERFREQUENCY SETPOINT 2: 81-2O

2201 TRIP Configure trip outputs 

2202 ALARM Configure alarm outputs 

2203 SET PNT Set point Hz

2204 TL16 Timer TL16 setting Sec.

OVERFREQUENCY SETPOINT 3: 81-3O

2301 TRIP Configure trip outputs 

2302 ALARM Configure alarm outputs 

2303 SET PNT Set point Hz

2304 TL17 Timer TL17 setting Sec.

OVERFREQUENCY SETPOINT 4: 81-4O

2401 TRIP Configure trip outputs 

2402 ALARM Configure alarm outputs 

2403 SET PNT Set point Hz

2404 TL18 Timer TL18 setting Sec.

DIGITAL INPUT: DIG INP

2501 SELBKDI1 Select blocking action by input DI1

2502 DI3 TRIP Configure trip outputs

2503 DI3 ALRM Configure alarm outputs

2504 DI3 TIMR Pickup Delay, DI3 timer sec.

2505 DI4 TRIP Configure trip outputs

2506 DI4 ALRM Configure alarm outputs

2507 DI4 TIMR Pickup delay, DI4 timer sec.

2508 DI6 FUNC Define DI6 Function

VOLTAGE TRANSFORMER FUSE FAILURE: VTFF

2601 VTFF Enable/Disable VTFF

ACCIDENTAL ENERGIZATION: AE

2701 TRIP Configure trip outputs 

Table 2–7: DGP***ACA SETTINGS TABLE (Sheet 5 of 6)

LOCATION: GENERATOR NUMBER:

RELAY MODEL NUMBER: DGP _ _ _ _CA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ D

SETTING # MNEMONIC DESCRIPTION USER SETTING



2-56 DGP Digital Generator Protection System GE Multilin

2.4 COMMISSIONING 2 CALCULATION OF SETTINGS

2 2702 ALARM Configure alarm outputs 

2703 AE ARM Arming logic, Accidental Energization

GROUND OVERCURRENT: 51GN

2801 TRIP Configure trip outputs 

2802 ALARM Configure alarm outputs 

2803 PICKUP Pickup current Amps

2804 TIME FAC Time factor sec.

UNDERVOLTAGE: 27

2901 TRIP Configure trip outputs 

2902 ALARM Configure alarm outputs 

2903 PICKUP Pickup voltage (Positive sequence) Volts

2904 TIME FAC Time factor sec.

2905 CURVE # Curve number (1-Inverse, 2-Def. Time)

UNDERVOLTAGE – THIRD HARMONIC: 27TN

3001 TRIP Configure trip outputs 

3002 ALARM Configure alarm outputs 

3003 PICKUP Pickup voltage (3rd Harmonic at generator neutral) Volts

3004 TL20 Timer TL20 setting Sec.

3005 FORPWR-L Lower limit of Forward Power window Watts

3006 FORPWR-H Upper limit of Forward Power window Watts

Table 2–7: DGP***ACA SETTINGS TABLE (Sheet 6 of 6)

LOCATION: GENERATOR NUMBER:

RELAY MODEL NUMBER: DGP _ _ _ _CA PROM VERSION NUMBER: V _ _ _ . _ _ _ _ _ D

SETTING # MNEMONIC DESCRIPTION USER SETTING
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3 HARDWARE DESCRIPTION 3.1 CASE ASSEMBLY 3.1.1 WARNING

Power down the relay by removing one of the connection plugs or turn both power switches
to OFF before removng or inserting modules. Failure to do so can permanently damage the
relay.

3.1.2 CONSTRUCTION

The case that houses the electronic modules is constructed from an aluminum alloy. It consists of a main frame
with side mounting brackets, a front cover and a rear cover.

The front cover, comprised of a metal frame with plate glass, is pivoted on the top and is opened from the bot-
tom by way of two spring-loaded latches. The door is constrained from coming off by tabs that require the door
to be unlatched and lifted slightly to be removed. A push-button extender installed into the plate glass makes it
possible to clear the display without removing the front cover.

The rear cover supports terminal blocks that are used in making external connections to the case. The mod-
ules are mounted vertically inside the case and are supported by sockets on the motherboard within the case.
In addition to providing this mechanical support, the sockets also offer the means of making the electrical con-
nection to the modules. The modules are further restrained inside the case by the front cover.

Proper alignment of the module with respect to the socket is maintained by slotted guides, one guide above
and one guide beneath each module, with the exception of the magnetics module, MGM and MMI modules,
which require two guides above and two beneath.

3.1.3 ELECTRICAL CONNECTIONS & INTERNAL WIRING

As mentioned earlier, electrical connections are made to the case through eight terminal blocks mounted on
the rear cover plate. Each block contains 14 terminal points, which consist of a #6 screw threaded into a flat
contact plate. Each terminal is rated for a maximum of two connections. Exceeding this will violate UL
specifications for two wires per terminal.

Connection to the MGM module is made by means of two connector sockets: an 8-contact current block and a
104-pin signal block. The current block contacts are rated to handle current transformer (CT) secondary cur-
rents. They are shorted upon removal of the MGM module.

3.1.4 IDENTIFICATION

The DGP model number label is located on the outside of the front cover and on the right-hand sidesheet
inside the case. A marking strip indicating the name and position of every module in a case is included on the
front center of the case. It is placed to be read when the front cover is removed.

The terminal blocks located on the rear cover plate are uniquely identified by a two-letter code found directly
beneath the outermost edge of each terminal block. Also, the terminal points (1 through 14) are identified by
stamped numbers.

Connector PL1 is used for serial communication between the DGP and the PC/Modem. Connector PL2 is used
to output sequence of events (SOE) to a serial printer or a DEC100 unit for additional auxiliary contacts output.
PL3 is used for IRIG-B signal input to the DGP. Note that the PL2 and PL3 connectors are not included on all
DGP models; see Section 1.1.2: ORDER CODES & SELECTION GUIDE on page 1–2 for details.

CAUTION
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Figure 3–1: DGP OUTLINE DRAWING
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Figure 3–2: FRONT AND REAR VIEW
704752A9.CDR

MAN MACHINE INTERFACE MODULE (MMI)
�

�

�

�

16 digit alpha-numeric LED display for fault report,
metering values, alarm messages, setting parameters, etc.
keypad includes 20 keys for user friendly
local interface with the DGP
dual color LED indicates relay status

RS232 port facilitates connection of lap-top PC

MODULES
System Processor (SSP),
Analog Interface (ANI),
Data Acquisition (DAP), &
Digital Signal Processor
(DSP) modules are plug-in
type for ease of maintenance
and trouble-shooting.

DIGITAL INPUT & TARGET
MODULE (DIT) LED targets
indicate ALL the fuctions
that operated during a
trip event

MAGNETIC MODULES
(MGM) Two identical
modules contain CT's, VT's,
output relays, etc. and are
interchangeable.

OPTIONAL TEST BLOCKS
facilitate injection of
analog input signals and
monitoring of DGP outputs
for test purpose without
disturbing field wiring.

POWER SUPPLY MODULES
are located behind the
cover plate. Module PS2
is optional

RS232 PLUG (PL-1)
provides connection to modem
for remote communications
or an interface to station
integration system.

OPTIONAL SERIAL PORT (PL-2)
Can be used to connect a
printer for automatic/manual
printout of data or a Contact
Expansion Unit DEC1000.

OPTIONAL PLUG (PL-3)
Available for IRIG-B signal input
to synchronize the DGP internal
clock to a common reference
clock e.g. GPS receiver.

VT INPUTS:
�

�

3 phase vt inputs,
wye or delta
1 neutral vt input

DIGITAL INPUTS:
�

�

3 configurable contact
inputs
3 predefined contact
inputs

CONTROL POWER
DC control power input

CT INPUTS
�

�

�

6 phase CT inputs
1 residual CT input
1 residual/neutral CT input

OUTPUT RELAY CONTACTS
�

�

8 configurable relays
8 predefined relays
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3.2 CIRCUIT BOARD MODULES 3.2.1 WARNING

This relay contains electronic components that could be damaged by electrostatic discharge
currents. The main source of electrostatic discharge currents is the human body, and the con-
ditions of low humidity, carpeted floors, and isolating shoes are conducive to the generation
of electrostatic discharge currents. Where these conditions exist, care must be exercised
when removing and/or handling the modules. The persons handling the modules must ensure
that their body charge has been discharged by touching some surface at ground potential
before touching any of the components on the modules.

3.2.2 BASIC CONSTRUCTION

Each module consists of a printed-circuit board and front panel. Two knobs are provided on the front panel for
removing and inserting the module. Electrical connection is made by the 96 pins of the Eurocard connector
located at the back of the board.

3.2.3 IDENTIFICATION

Each module has its own identification number, consisting of a three-letter code followed by a three-digit num-
ber. These are found at the bottom of each front panel.

Figure 3–3: DGP POWER SUPPLY MODULE

CAUTION
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Figure 3–4: DGP MMI MODULE
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3.3 XTM TEST PLUGS 3.3.1 DESCRIPTION

The XTM test plugs are designed specifically for post-installation testing of the DGP system. As many as four
plugs can be used at one time: two XTM28L1 (left-hand plugs) and two XTM28R1 (right-hand plugs), each pro-
viding access to fourteen relay-side and fourteen system-side points. The system-side points are designated
"S" and the relay-side points are designated "R". The plugs are keyed by the contact finger arrangement so
that there can be no accidental interchange between the left-hand and right-hand plugs.

The plugs are fitted with a sliding handle that swings out to facilitate wiring to the terminals. The terminals con-
sist of #8 screws threaded into flat contact plates. The handles each have a tab on the outside edge to guide
the wire dress of the test leads.

Not all external connections to the DGP system are wired through the test receptacle.

3.3.2 TERMINAL DESIGNATION

The test receptacle and connection plugs are located to the extreme left and right on the lower unit. The left-
hand plugs are labeled as TP1 with terminals 1 through 28. The right hand plugs are labeled TP2 with termi-
nals 1 through 28. These points are designated on the elementary diagrams as TP1-1 (see Section 1.5: ELE-
MENTARY DIAGRAMS on page 1–24). The left-hand test plug (XTM28L1) terminals are labeled 1R through
14R and 1S through 14S for the relay side and system side, respectively, with the system side labeled in red.
Similarly, the right-hand test plug (XTM28R1) terminals are labeled 15R through 28R and 15S through 28S.

3.3.3 XTM TEST-CIRCUIT CONNECTIONS

Test-circuit connections, designated as TP points in the elementary diagrams, should be made to the relay side
of the test plug. Where it is desired to use available system quantities for testing (e.g. DC control power), jump-
ers may be inserted between the corresponding system-side and relay-side test plug terminals. Appropriate
precautions should be taken when working with station battery DC power. Connections should be made to the
test plugs prior to insertion into the DGP system.

3.3.4 TEST PLUG INSERTION

It is critical that jumpers be inserted on the system-side test plug terminals that are connected
to the CT secondaries, as shown in Figure 1–9: ELEMENTARY DIAGRAM WITH TEST
BLOCKS, WYE VTs. If these jumpers are left out, the resulting high voltages will present a
serious hazard to personnel and may severely damage equipment.

To remove power from the relay, remove at least one of the connection plugs.

To insert the test plugs, the two connection plugs must first be removed. In so doing, electrical continuity is bro-
ken between the power system and the DGP for those signals that are wired through the test receptacle (refer
to TP points on the elementary diagrams in Section 1.5: ELEMENTARY DIAGRAMS on page 1–24). For the
terminals connected to the CT secondaries, shorting bars are included on the system side of the test recepta-
cle. These are clearly visible through the transparent plastic face plate on the receptacle. The shorting bars
make contact before the connection-plug contacts break during removal so that the CT secondaries are never
open-circuited.

Four test plugs may be inserted at the same time giving access to all 56 terminals simultaneously. Otherwise, if
using fewer than four test plugs, the remaining connection plugs may remain in the other receptacles.

When the test plugs are inserted into the receptacle, parts of the power system become isolated from the DGP.
Refer to the elementary diagrams in Section 1.5: ELEMENTARY DIAGRAMS on page 1–24 for the TP points
associated with each of the test plugs.

CAUTION
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3.4 INSTALLATION 3.4.1 RECEIVING, HANDLING, & STORAGE

Immediately upon receipt, the equipment should be unpacked and examined for any damage sustained in tran-
sit. If damage resulting from rough handling is evident, file a damage claim at once with the transportation com-
pany and promptly notify the nearest GE Multilin Sales Office. If the equipment is not to be installed
immediately, it should be stored indoors in a location that is dry and protected from dust, metallic chips, and
severe atmospheric conditions.

3.4.2 ENVIRONMENT

The location should be clean and dry, free from dust and excessive vibration, and well lighted to facilitate
inspection and testing.

3.4.3 MOUNTING

The DGP case has been designed for standard rack mounting. The case measures eight rack units (8 RU) in
height. Refer to Figure 3–1: DGP OUTLINE DRAWING on page 3–2 for the outline and mounting dimensions.

3.4.4 EXTERNAL CONNECTIONS

External connections are made according to the elementary diagrams in Section 1.5: ELEMENTARY DIA-
GRAMS on page 1–24. These are general diagrams incorporating all of the available options. Connection
need not be made to those terminals associated with options that will not be used.

3.4.5 EXTERNAL CONNECTIONS TEST

The DGP system should be disabled to prevent tripping of the of the circuit breakers until it
has been determined that the unit is properly connected. This can be accomplished in two
ways: one is to de-energize the trip circuit connected to the relay; the other is to disable the
DGP outputs by setting the DISABLE OUTPUTS function to YES prior to installation.

An overall check of current transformer polarities, potential transformer polarities, and connections to the DGP
can be made prior to placing the system in service by using the system voltages and load current while moni-
toring the display for Present Values. Obtaining the DGP present values can be done in two ways.

1. Access the INF category through the keypad. Once the INF category is chosen use the [↑] key to select the
PRESENT VALUES menu item. Scrolling through the present values will allow you to determine if the
relay is wired correctly.

2. Press the [CLR] key and allow the DGP to automatically scroll through the present values.

3.4.6 SURGE GROUND CONNECTIONS

Terminal BH14 must be tied to station ground, as shown in the elementary diagrams in Sec-
tion 1.5 ELEMENTARY DIAGRAMS on page 1–24. The connection to the ground bus must be
made as short as possible, preferably 10 inches or less, using #12 wire or larger.

CAUTION

CAUTION
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4 ACCEPTANCE TESTS 4.1 INTRODUCTION 4.1.1 WARNING

POWER DOWN THE RELAY BEFORE REMOVING OR INSERTING MODULES. FAILURE TO DO
SO CAN PERMANENTLY DAMAGE THE RELAY!

4.1.2 GENERAL

This section is a guide for testing the relay. It is not necessary that these tests be performed for incoming
inspection. The relay has been tested at the factory with automated test equipment. The DGP is a digital relay
controlled by self-checking software. If a system failure is detected, it will be reported through the MMI and
remote communications.

The following tests include: Relay status self test and display and MMI self test. Tests of the protection func-
tions and measuring accuracy are also included and can be performed at the user's discretion. Protection func-
tions that end with an asterisk (*) are available on certain models only – see the DGP model list in Section
1.1.2: ORDER CODES & SELECTION GUIDE on page 1–2.

a) GENERAL TESTS

• T1: MMI Status and Display Tests (Self-tests)

• T2: Digital Output Tests

• T3: Digital Input Tests

• T4: AC System Input Test

b) PROTECTION TESTS

• T5: Generator Differential, 87G

• T6: Current Unbalance Alarm, 46A

• T7: Current Unbalance Trip, 46T

• T8: Loss of Excitation, 40-1

• T9: Loss of Excitation, 40-2

• T10: Anti-Motoring, 32-1

• T11: Anti-Motoring, 32-2 *

• T12: Time Overcurrent with Voltage Restraint,
51V

• T13: Accidental Energization, AE

• T14: Stator Ground Zone1, 64G1

• T15: Stator Ground Zone2, 64G2 *

• T16: Overexcitation (Volts/Hz) Alarm, 24A

• T17: Overexcitation (Volts/Hz) Trip, 24T

• T18: Overvoltage, 59

• T19: Underfrequency, 81-1U

• T20: Underfrequency, 81-2U

• T21: Underfrequency, 81-3U *

• T22: Underfrequency, 81-4U *

• T23: Overfrequency, 81-1O

• T24: Overfrequency, 81-2O

• T25: Overfrequency, 81-3O *

• T26: Overfrequency, 81-4O *

• T27: Voltage Transformer Fuse Failure, VTFF

• T28: TOC Ground Overcurrent, 51GN *

• T29: Undervoltage, 27 *

• T30: 3rd Harmonic Neutral Undervoltage, 27TN *

* Functions available in some models only.

CAUTION
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4.2 TEST PREPARATION 4.2.1 TEST EQUIPMENT

1. Three-phase source of voltage and current operating from 30 to 80 Hz, with capability to add 3rd harmonic
voltage to the fundamental

2. DC voltage source (Power supply)

3. Three AC voltmeters

4. Three AC ammeters

5. A continuity tester or Ohm meter

6. A PC compatible computer with a serial and mouse port

7. An RS232 null modem cable to connect the PC to the DGP system

8. A Precision Timer for testing timed events.

The specific requirements of the equipment are given in the text of this section and the associated circuit dia-
grams. The three-phase AC sinusoidal voltage must be balanced and undistorted. Similarly, the DC power
should come from a good source with less than 5% ripple. A "good source" is one that is within the voltage
range shown in Chapter 7: SPECIFICATIONS.

As an alternative, a three-phase electronic test source may be used. In many cases, these devices enable the
test circuits to be simplified.

4.2.2 DRAWINGS & REFERENCES

a) DRAWINGS

• Elementary Diagrams in Section 1.5: ELEMENTARY DIAGRAMS on page 1–24

• Figure 1–3: SIMPLE LOGIC DIAGRAM – 87G, 32, 27, 59, AND AE on page 1–13

• Figure 1–4: SIMPLE LOGIC DIAGRAM – 46, 40, AND 51V on page 1–14

• Figure 1–5: SIMPLE LOGIC DIAGRAM – 64G1, 64G2, 51GN, AND 24 on page 1–15

• Figure 1–6: SIMPLE LOGIC DIAGRAM – 81-O AND 81-U on page 1–16

• Figure 1–7: SIMPLE LOGIC DIAGRAM – VT FUSE FAILURE on page 1–17

b) REFERENCES

• Chapter 10: DGP-PC SOFTWARE

• The DGP default settings shown in Table 2–1: DGP SYSTEM SETTINGS & RATINGS on page 2–3

4.2.3 EQUIPMENT GROUNDING

All equipment used in testing the DGP relay should be connected to a common grounding point to provide
noise immunity. This includes the voltage and current sources, as well as the DGP system itself. The common
for surge protection is terminal BH14.

4.2.4 REQUIRED SETTINGS

Most tests will utilize the default Settings. If Setting changes are required, they will be listed prior to the test
procedure. For periodic testing purposes, see the Chapter 5: PERIODIC TESTS for details on performing the
relay test with user-specific settings.
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4.3 GENERAL INSTRUCTIONS 4.3.1 PROCEDURE

1. To remove power from the relay, remove at least one of the connection plugs. For models without connec-
tion plugs, turn both DC Control switches to the OFF position. 

2. The DGP tests are performed in the "test mode" of operation. The test mode selects and isolates various
test functions and measuring units and routes their status to the output Test Pickup and Test Trip (DOR12
and DOR13) contacts. When the particular function under test has picked up, DOR12 (AF6—AG6) will
operate. When the particular function under test has tripped, DOR13 (AF5—AG5) will operate. 

For the remainder of this test, DOR12 will be referred to as "test pickup" and DOR13 as "test trip".

The Digital Output contacts will chatter when the unit under test is near its threshold. DO
NOT let it continue. Remove the test signal. A single contact closure is enough to deter-
mine that the unit picked up.

SELECTED TRIP AND ALARM CONTACTS WILL ALSO OPERATE IN THE TEST MODE.

3. The trip-time settings listed in these tests do not include the 4 to 5 ms required for the output relay to oper-
ate. For very short trip times, this may become significant.

4. During the test, one or more of the electronic current sources may not be used. If the source is not used, it
must be set to zero (0) in addition to being disabled. Also, the currents should always be set at or near zero
(0) whenever a current source is powered ON or OFF.

5. The phase angles of the test sources are shown relative to phase A voltage. A positive (+) phase angle
refers to the referenced quantity leading phase A voltage. A negative (–) phase angle refers to the refer-
enced quantity lagging phase A voltage.

6. All test voltages are phase-to-ground measurements unless otherwise specified.

7. Typing an entry on the MMI keypad will be shown as [KEY] where KEY represents the alphanumeric label
of the key to be pressed.

For tests that require a setting change, the setting number will be shown in parentheses next to the setting,
to facilitate direct access to the setting. This is performed by pressing the [SET] key, entering the four-digit
the setting number (nnnn), then pressing the [ENT] key. The new setting may then be entered.

At the end of testing, ensure that all settings are returned to initial values. Print them out and verify them
before placing the relay in service. If a printer is not available, scroll through all settings with the MMI dis-
play and verify each one individually.

4.3.2 SETTING CHANGES

Setting changes required for a particular test will be listed before the test. A sample Setting change is shown
below. Refer to Chapter 8: INTERFACE for further details on making Setting changes.

Example for changing the set point of the Underfrequency Unit #1 to 62.00 Hz.

1. Apply rated DC and wait for relay initialization to complete, as indicated by the green LED on the MMI.

2. Press the [ACT] key. Scroll with the arrow key until ACT: ENTER PASSWORD is displayed, then press the
[ENT] key.

If this is the first time the Settings Level functions are used, the password has the factory value “1234.”.
The decimal point is a character that can only be entered at the factory. This password must be changed
before any Setting functions can be accessed. See Section 8.3.9: ACTIONS KEY [ACT] on page 8–7 for
information on how to change the password.

CAUTION

NOTE
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3. Enter the current Settings Level password. If the password is not known, see Chapter 8: INTERFACE for
information on how it can be viewed.

When the correct password is entered, the message SELECTED is displayed.

4. Press the [SET] key.

5. Scroll with the arrow key until SET: 81-1U is displayed, then press the [ENT] key.

6. Scroll through the 81-1U settings until the SET PNT = #.# item appears.

7. Enter 62.00 on the keypad. The digits will display at half-intensity – this denotes that a change is made but
not yet entered.

8. When the correct frequency is entered, press the [ENT] key. The input is now displayed at full intensity.
This denotes that the change is entered into the settings buffer, but not permanently changed in the relay.

9. To finalize the setting change, press the [END] key followed by the [ENT] key. If the [END] and the [ENT]
keys are not pressed after setting changes, the settings will not be stored into memory.

10. Restore Setting 1703: SET PNT back to its original value before beginning the test. It will be necessary to
enter the Settings Level password again.

4.3.3 ENTERING THE TEST MODE

Before each test, it is necessary to place the relay in the test mode and select the function to be tested. The
test mode is set as follows:

1. Apply rated DC and wait for relay initialization to complete (indicated by the green LED on the MMI).

2. Press the [ACT] key. Scroll with the arrow key until ACT: ENTER PASSWORD is displayed, then press the
[ENT] key.

For DGP units with GE Modem protocol: If this is the first time the Control Level functions are used, the
password has the factory value "5678.". The decimal point, ".", is part of the password that can only be
entered at the factory. This password must be changed before any Control functions can be accessed. See
Section 8.3.9: ACTIONS KEY [ACT] on page 8–7 for information on how to change the password. 

For DGP units with Modbus protocol: Password access is not required.

3. Enter the current Control Level password. If the password is not known, see Chapter 8: INTERFACE for
information on how it can be viewed.

When the correct password is entered, the message SELECTED will be displayed.

4. Press the [ACT] key. Scroll with the arrow key until ACT: RELAY TEST is displayed, then press [ENT].

5. Scroll through the different test mode functions or enter the number of the desired test, such as "5" for the
40-1 then press [ENT]. Pressing [ENT] again causes the MMI to display 40-1 ON and the MMI LED to turn
red, indicating that the relay is in the test mode. When the relay picks up or trips for the selected function it
will close the DOR12 or DOR13 contacts, respectively.

4.3.4 EXITING THE TEST MODE

While in the test mode, press the [ACT] key. Scroll with the arrow key until the ACT: RELAY TEST item is dis-
played, then press the [ENT] key. Scroll until the display shows END TEST MODE, or press "1" then [ENT].
Press the [ENT] key again. The MMI LED should turn green, indicating that normal operation has resumed.
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4.4 USING DGP-PC 4.4.1 DESCRIPTION

Testing the relay without using the keypad is accomplished via a PC running the DGP-PC program. DGP-PC is
required to establish communications, change the password, change settings for the tests, and place the unit
into test mode.

The following section is intended to give a step-by-step procedure to test the relay, from setting up communica-
tions to the application of the voltages and current inputs. It will be necessary to be familiar with the DGP-PC
software. Refer to Chapter 10: DGP-PC SOFTWARE for detailed information on using DGP-PC.

4.4.2 HARDWARE SETUP

The cable used to connected the DGP to a PC depends on the DGP and PC port settings. The DGP PL-1 port
accepts a 25-pin male D-connector; the COMM port accepts a 9-pin male D-connector. The PC may require a
9 or 25-pin connector depending on its configuration. Null-modem cable wiring is shown in Figure 9–1: DGP
COMMUNICATIONS WIRING on page 9–3 for connecting the DGP system with a 9-pin to 25-pin and a 25-pin
to 25-pin setup.

4.4.3 SOFTWARE SETUP

The software setup requires loading the software on to the PC, starting the program, and configuring the pro-
gram to match the port settings and baud rate of the system.

a) LOAD & START DGP-LINK

1. Insert the CD containing the compressed DGP-PC file or download it onto your computer. Double click on
DGP-PC icon and follow the instructions to load the required components.

2. Start the program by double-clicking the DGP-PC icon or through the Windows Start Menu.

b) SET UP A NEW TEST UNIT

1. Set DGP-PC to access the NewSite page. The default is always NewSite. To change this default name,
enter the new name is the Site Name box (for example, TestSite) and click the Save button.

2. Select File > Add new IED. Select appropriate IED type from the IED Type scroll list (see Figure 4–1:
ADDING A NEW IED below). The correct IED type can be obtained by viewing the DGP model with the
MMI.

3. The IED Description can be changed to TEST UNIT, for example, once created.

4. Enter the Unit ID and select the appropriate COM Port and Baud Rate. For DGP models with the GE
Modem protocol, type decoded remote passwords into the Passwords box. If the current passwords are
not known, refer to Chapter 8: INTERFACE for information on how to display them. Click Save when done.

5. NOTE: Baud rate, parity and stop bits are set to default. See following section for details.
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Figure 4–1: ADDING A NEW IED

4.4.4 RELAY SETUP

Before shipment, the relay is set with factory default settings. These include the Unit ID, the Baud Rate, and
the Factory Passwords. The default communications parameters are:

4.4.5 LOGGING INTO THE RELAY

1. To log on to the Test unit, click on the test unit IED to highlight it. Select the Communication > Connect
Relay menu item and click on Connect.

2. When prompted by DGP-PC, enter the password for the appropriate access levels (GE Modem protocol
only). 

Table 4–1: DEFAULT COMMUNICATION PARAMETERS

SETTING FACTORY DEFAULT

UNIT ID 0 (GE Modem) / 1 (Modbus)

VIEW PASSWORD VIEW!

CONTROL PASSWORD CTRL!

SETTINGS PASSWORD SETT!

BAUD RATE 2400
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3. The passwords are listed in the table above and must be changed before any of the relay functions except
CHANGE PASSWORD and LOGOUT will operate.

4. If communication is successful, the the status bar at the bottom of the screen will indicate that the DGP is
connected along with other status information

5. If this was an initial login with the factory default passwords, the user must change the password (applies
to GE Modem protocol units only).

4.4.6 SETTING CHANGES

1. Any Setting changes required for a particular test are listed at the beginning of the test. Settings can be
changed individually through the IED Settings folder shown below. 

Figure 4–2: DGP-PC SETTINGS MENU

2. Additional detail on changing Settings with DGP-PC is provided in Chapter 10: DGP-PC SOFTWARE.

3. Once a setting has been modified, select the Control > Send Settings to Relay menu item.

4.4.7 ENTERING THE TEST MODE

Before most tests it is necessary to set the relay in the test mode. Test mode is set as follows:

1. Log into the relay using Control access level password.

2. When the password is accepted, CTRL MODE will appear at the bottom right of the screen.

3. Select Relay test from the IED Operations folder.

4. The Test Mode list box appears.

5. Select the test you wish to enter from the menu and then click BEGIN TEST.

6. The MMI LED will change from green to red when the DGP system is in the test mode.

NOTE: No access password is required for relays with the Modbus protocol.

4.4.8 EXITING THE TEST MODE

The test mode is ended (and the relay protection turned on) by selecting END TEST mode from the Test Mode
list. The MMI LED changes from red to green.
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4.5 INITIAL TEST SETUP 4.5.1 DESCRIPTION

Before beginning the test, the relay settings should be recorded for reference and verification. The factory
defaults are listed in Table 2–1: DGP SYSTEM SETTINGS & RATINGS on page 2–3. Scroll through each set-
ting to ensure they match the default settings listed.

If testing with DGP-PC, the relay settings should be uploaded from the DGP and printed for reference and ver-
ification. Verify that each DGP setting matches the default setting listed. If no printer is available, verify individ-
ual settings through the Settings folder.

Once uploaded, the current settings can be saved to a disk file and be reloaded back into the DGP when test-
ing is completed. Select the current IED and use the File > Save Settings to File menu item to save the DGP
settings to a file. DGP-PC will prompt for a file name. More information on using this command can be found in
Chapter 10: DGP-PC SOFTWARE.
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4.6 GENERAL RELAY TESTS 4.6.1 NOTE

SETTINGS MADE VIA MMI: All Settings or Control changes must have their respective pass-
words entered before any changes can be made. After all of the settings changes have been
entered, the [END] [ENT] key-sequence must be entered so that the relay can accept and oper-
ate with the new settings.

4.6.2 T1: MMI STATUS AND DISPLAY TESTING

The Relay Status is reported through the MMI, the non-critical alarm contact, and the critical alarm contact. If a
system error caused relaying functions to cease, the LED on the MMI would turn red, a FAIL message would
be displayed, and the critical alarm relay would de-energize. A failure that did not interrupt relaying would be
indicated by energizing the non-critical alarm relay and a WARN message.

a) STATUS CHECK

This test will demonstrate the use of the MMI to check relay status. See Chapter 6: SERVICING for more infor-
mation.

1. The AC inputs are not required for this test, only the DC power supply voltage. Apply rated DC power and
wait for initialization to complete as indicated by the green LED.

2. Enter the Setting Level password. Press the [SET] key followed by "103" to change the setting for the trip
circuit monitor. 

3. Set 103: SEL TVM = 0000.

Press [END] and [ENT] keys after each setting change.

4. Press the [INF] key. Scroll with the arrow keys until the INF: STATUS heading is displayed.

5. Press the [ENT] key.

The display should read STATUS OK. "OK" indicates that the relay is operational and there are no errors.

b) WARNING STATUS

1. Enter the Setting Level password. Press the [SET] key followed by "103" to change the setting for the trip
circuit monitor. 

2. Set 103: SEL TVM = 1111. When completed, the relay expects wetting voltage across the trip contacts.
Press the [END] and then [ENT] keys.

3. Press the [INF] key. Scroll with the arrow keys until the INF: STATUS heading is displayed.

4. Press the [ENT] key.

The display should read STATUS: WARN.

5. Scroll with the arrow keys until the 94G TRP CIR OPN heading is displayed. Continue scrolling through the
remaining trip circuit outputs (94G1, 94G2, and 94G3). This verifies that the relay detected the absence of
wetting voltage across the trip contacts.

6. Enter the Setting Level password. Press the [SET] key followed by "103" to change the setting for the trip
circuit monitor. 

7. Enter Setting 103: SEL TVM = 0000. Press the [END] and then [ENT] keys.

NOTE

NOTE
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c) DISPLAY TEST

The MMI test is built into the software. It allows the user to test the keypad, printer, and display. If no printer is
connected to the relay, skip the printer port testing.

1. Apply rated DC power and wait for initialization to complete as indicated by the green LED.

2. Press the [ACT] key. Scroll with the arrow keys until the ACT: MMI TEST heading is displayed.

3. Press the [ENT] key.

The display should read NEXT?.

4. Press [1/Y] followed by the [ENT] key.

The display will change to LED TST?.

5. Press [1/Y] followed by the [ENT] key.

If the green LED is on, it will change to red. If the red LED is on, it will change to green. The target LEDs
will flash on and off four times and then each target LED will be lit individually. When the test is over, the
target LEDs will return to their original state.

6. Next, the display will prompt for the keyboard test with KEYBRD TST?.

7. Press [1/Y] followed by the [ENT] key.

8. At this point the MMI is in the keyboard test. Press every key on the keypad except for [CLR] key. As each
key is pressed, verify that the display indicates the correct key was pressed. 

9. When all the keys have been checked, press the [CLR] key.

10. The display will prompt PRINTER TST?. if you do not have a printer or the printer port is not active, then
press the [3/N] followed by the [ENT] key. Otherwise, press [1/Y] followed by the [ENT] key.
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4.6.3 T2: DIGITAL OUTPUT TESTS

This test checks all relay outputs. It is a convenient way to determine proper system connections and verify the
operation of all relay contacts without having to apply currents and voltages to simulate faults.

If DGP-PC is used to perform this test, none of the outputs will operate unless Jumper J1 on
the MMI module is removed. Refer to Figure 3–4: DGP MMI MODULE on page 3–5.

1. Connect the relay as shown in Figure 4–3: DIGITAL OUTPUT TEST CONNECTIONS.

2. Enter the Control Level password.

3. Press the [ACT] key and then select DIG OUT TEST. Press the [ENT] key.

4. Select the output to test by using the arrow keys to scroll to the desired output, such as 94G, and press the
[ENT] key.

After all tests are done you must end this test mode using step 6.

Before the contact is allowed to close you will be prompted to turn protection off during the test. The
prompt is: DISABLE PROT?. Press the [1/Y] key followed by the [ENT] key to turn protection off. Protec-
tion will remain off until the test mode is ended.

Once the protection choice is chosen, the selected relay output will close.

Using an ohmmeter or other suitable device, verify that the output under test has closed.

5. After the output is tested, scroll to the next output to test and press the [ENT] key. This output will close and
the previously selected output will open. Continue in this fashion until all outputs are tested.

6. End the test mode by scrolling to the END TEST MODE item and press the [ENT] key. Alternatively, the
[END] [ENT] key sequence can be entered to end the test and re-enable protection.

NOTE

NOTE
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Figure 4–3: DIGITAL OUTPUT TEST CONNECTIONS

UNIT UNDER TEST

 CONTINUITY
TESTER

DIGITAL OUTPUTS
(SEE TABLE TO LEFT)

X

Y

RATED DC POWER
SUPPLY

48, 125, 250 V DC
RATED DC
VOLTAGEAG2 or TP1-15

AG1 or TP1-1

SURGE & CASE
GROUND

BH14

DIGITAL OUTPUTS X Y

94G BE10 BF10

94G1 BE9 BF9

94G2 BE8 BF8

94G3 BE7 BF7

74A AF14 AG14

74B AF13 AG13

74C AF12 AG12

74D AF11 AG11

74CR AF7 AG7

74NC AF8 AG10

74FF AF10 AG10

TEST PICKUP AF6 AG6

TEST TRIP AF5 AG5

AG8
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4.6.4 T3: DIGITAL INPUT TESTS

This test checks all digital inputs of the relay. It is a convenient way to determine proper system connections
and verify the operation of all dual optically isolated digital inputs. All digital inputs should be between 35 and
300 V DC.

Protection can be enabled or disabled, as deemed necessary by the user.

1. Connect the relay as shown in Figure 4–4: DIGITAL INPUT TEST CONNECTIONS.

2. Apply DC across DI1 (BG8—BG7). Using the MMI and the INFORMATION–VALUES command, verify that
GEN = OFF-LINE.

3. Remove DC from DI1 (BG8—BG7). Using the MMI and the INFORMATION–VALUES command, verify
that GEN = ON-LINE.

4. Apply DC across DI2 (BG6—BG5). Using the MMI and the INFORMATION–VALUES command, verify that
INLET VLV=CLOSED.

5. Remove DC from DI2 (BG6—BG5). Using the MMI and the INFORMATION–VALUES command, verify
that INLET VLV=OPEN.

6. Apply DC across DI3 (BG4—BG3). Using the MMI and the INFORMATION–VALUES command, verify that
DIG IN 3 = CLOSE.

7. Remove DC from DI3 (BG4—BG3). Using the MMI and the INFORMATION–VALUES command, verify
that DIG IN 3 = OPEN.

8. Apply DC across DI4 (BG2—BG1). Using the MMI and the INFORMATION–VALUES command, verify that
DIG IN 4 = CLOSE.

9. Remove DC from DI4 (BG2—BG1). Using the MMI and the INFORMATION–VALUES command, verify
that DIG IN 4 = OPEN.

10. Apply DC across DI5 (BE4—BE3). Using the MMI and the INFORMATION–VALUES command, verify that
OSC TRIG = CLOSE. 

NOTE: This input is not active on some models of DGP.

11. Remove DC from DI5 (BE4—BE3). Using the MMI and the INFORMATION–VALUES command, verify that
OSC TRIG = OPEN.

NOTE: This input is not active on some models of DGP.

12. Apply DC across DI6 (BE2—BE1). Using the MMI and the INFORMATION–VALUES command, verify that
DIG IN 6 (EXT VTFF) = CLOSE.

13. Remove DC from DI6 (BE2—BE1). Using the MMI and the INFORMATION–VALUES command, verify that
DIG IN 6 (EXT VTFF) = OPEN.
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Figure 4–4: DIGITAL INPUT TEST CONNECTIONS

UNIT UNDER TEST

RATED DC POWER
SUPPLY

48, 125, 250 V DC
RATED DC
VOLTAGEAG2 or TP1-15

AG1 or TP1-1

SURGE & CASE
GROUND

BH14

DI6

DI1

DI2

DI3

DI4

DI5

BE1

BG6

BG5

BG4

BG3

BG2

BG1

BE4

BE3

BE2

BG7

BG8
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4.6.5 T4: AC SYSTEM INPUT TEST

This test uses the INFORMATION–VALUES function of the MMI to determine that the voltages and currents
are applied to the proper connections on the terminal strip. The INFORMATION–VALUES function can be used
at any time during the test to verify that the relay has the correct voltages and currents applied.

1. Connect the relay as shown in Figure 4–5: AC SYSTEM INPUT TEST CONNECTIONS.

2. Using a 60 Hz source, set the current inputs to:

IA = 0.5 (0.1) A rms ∠0°
IB = 2.0 (0.4) A rms ∠–120°
IC = 15.0 (3.0) A rms ∠–240°

and set the voltage inputs to:

VA = 20 V rms ∠0°
VB = 70 V rms ∠–120°
VC = 120 V rms ∠–240°

3. Press the [INF] key. Scroll with arrow keys to the INF: VALUES heading, then press the [ENT] key. The
present values are now selected.

4. With the arrow keys, scroll through the values of:

IAS, ANGLE IAS

IBS, ANGLE IBS

ICS, ANGLE ICS

IAR, ANGLE IAR

IBR, ANGLE IBR

ICR, ANGLE ICR

VAN, ANGLE VAN

VBN, ANGLE VBN

VCN, ANGLE VCN

GEN FREQ

Check that all frequency measurements are within 0.01 Hz and all voltage and current measurements are
within 3% of their set amplitude and 1° of their set phase.

Other quantities are listed between the values of ANGLE VCN and GEN FREQ. These will
be tested in another section.

If a printer is available, press the [PRT] key while in the INF: VALUES category and all present values will
be printed. Alternately, whenever the MMI display is blank, pressing the [CLR] key will automatically scroll
through all of the present values.

5. Repeat steps 2 through 4 using the following source frequencies: 30.5 and 79.5 Hz.

NOTE
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Figure 4–5: AC SYSTEM INPUT TEST CONNECTIONS
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4.7 PROTECTION TESTS 4.7.1 DESCRIPTION

All Settings or Control Level changes must have their respective passwords entered before
any changes can be made. After all of the settings changes have been entered, the [END]
[ENT] key sequence must be entered so the relay can accept and operate with the new set-
tings.

Before starting the Protection Functions test, input the following settings into the Configuration category.

Settings:

CONFIG

(102) SYSFREQ = 60
(103) SEL TVM = 0000
(104) SEL TCM = 0000
(105) SELPRIM = SECNDRY (1)
(106) CT RATIO = 1
(107) VT RATIO = 1.0
(109) PHASE = A-B-C
(114) NOM VOLT = 120.0
(115) RATEDCUR = 5.00 (1.00)

Protection Function testing is accomplished with two methods:

1. In protection mode, all outputs are directed to the selected Trip/Alarm output contacts.

2. In test mode, all outputs are directed to the test-output contacts (DOR12—test pickup, DOR13—test trip),
along with the selected Trip/Alarm contacts. Test pickup has a normally open (AF6—AG6) and a normally
closed (AF6—AE6) contact. Test trip also has a normally open (AF5—AG5) and a normally closed (AF5—
AE5) contact.

To enter test mode, first input the Control Level password. Press the [ACT] key, then scroll until the head-
ing ACT: RELAY TEST is displayed. Press the [ENT] key. Scroll through the different functions until you
reach the function to be tested. Press the [ENT] key. The status light will turn red and the MMI will display
ON next to the function to be tested.

1.Although the status light is red, the protection functions are still ON while the relay is
in test mode.

2.Where appropriate, current levels are defined with two numbers as xx(yy); xx is the
value to be used for relays rated at 5 amperes and (yy) is the value to be used for 1
ampere relays.

4.7.2 T5: GENERATOR DIFFERENTIAL TEST 87G

1. Settings:

87G

(203) K1 = 5
(204) PICKUP = 0.3 (0.06) A

2. Connect the relay as shown in Figure 4–6: GENERATOR DIFFERENTIAL TEST CONNECTIONS.

3. Set up relay in test mode for the 87G function; 87G ON will be displayed on the MMI.

4. Set the current of IAR to 5 A (1 A) rms and IAS to 5 A (1 A) rms in phase. The test pickup and test trip con-
tacts should not operate. Increase IAS to 7 A (1.3 A) rms and test pickup and test trip should operate.

5. Set IAS to 5 A (1 A) rms and test pickup and test trip should not operate. 

NOTE

NOTE
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6. Decrease IAS to 3 A (0.75 A) rms and test pickup and test trip should operate.

7. Repeat the above test for phases B (IBR, IBS) and C (ICR, ICS).

Figure 4–6: GENERATOR DIFFERENTIAL TEST CONNECTIONS

U
N

IT U
N

D
ER

 TEST

RATED DC POWER
SUPPLY

48, 125, 250 V DC
RATED DC
VOLTAGEAG2 or TP1-15

AG1 or TP1-1+

–

TEST PICKUP

INR

I (A, B, C) R

AG6

AF6

AH8 or TP2-14

AH7 or TP2-13

X2

X1

SURGE & CASE
GROUND

BH14

CONTINUITY
TESTER

TEST TRIP
AG5

AF5
CONTINUITY

TESTER

SINGLE-PHASE
CURRENT SOURCE

IR

N

INS

I (A, B, C) S

BH8 or TP1-14

BH7 or TP1-13

Y2

Y1

SINGLE-PHASE
CURRENT SOURCE

IS

N

INPUT X1 INPUT X2 INPUT Y1 INPUT Y2PHASE
UNDER
TEST TERMINAL

BLOCK
NUMBER

XTM
TERMINAL
NUMBER

TERMINAL
BLOCK

NUMBER

XTM
TERMINAL
NUMBER

TERMINAL
BLOCK

NUMBER

XTM
TERMINAL
NUMBER

TERMINAL
BLOCK

NUMBER

XTM
TERMINAL
NUMBER

A AH1 TP2-7 AH2 TP2-8 BH1 TP1-7 BH2 TP1-8

B AH3 TP2-9 AH4 TP2-10 BH3 TP1-9 BH4 TP1-10

C AH5 TP2-11 AH6 TP2-12 BH5 TP1-11 BH6 TP1-12

SY
N

C
H

R
O

N
IZ

A
TI

O
N



GE Multilin DGP Digital Generator Protection System 4-19

4 ACCEPTANCE TESTS 4.7 PROTECTION TESTS

4

4.7.3 T6: CURRENT UNBALANCE ALARM 46A

1. Settings:

46A

(302) PICKUP = 0.05 (0.01)
(303) TL14 = 1

2. Connect the relay as shown in Figure 4–7: CURRENT UNBALANCE TEST CONNECTIONS.

3. Set up relay in test mode for the 46A function; 46A ON will be displayed on the MMI.

4. Set the current inputs to:

IAS = 0.4 (0.08) A rms ∠0°
IBS = 0.4 (0.08) A rms ∠–120°
ICS = 0.4 (0.08) A rms ∠–240°

Test pickup and test trip should not operate. 

5. Change the current inputs to:

IAS = 0.25 (0.05) A rms ∠0°
IBS = 0.0 A rms ∠–120°
ICS = 0.0 A rms ∠–240°

The test pickup should operate immediately and test trip should operate in 1.00 to 1.03 seconds.

4.7.4 T7: CURRENT UNBALANCE TRIP 46T

1. Settings:

46T

(403) PICKUP = 2.0 (0.4)
(404) K2 = 1.0

2. Connect the relay as shown in Figure 4–7: CURRENT UNBALANCE TEST CONNECTIONS.

3. Set up relay in test mode for the 46T function; 46T ON will be displayed on the MMI.

4. Set the current inputs to:

IAS = 2.0 (0.4) A rms ∠0°
IBS = 2.0 (0.4) A rms ∠–120°
ICS = 2.0 (0.4) A rms ∠–240°.

The test pickup and test trip contacts should not operate. 

5. Change the current inputs to:

IAS = 6.3 (1.26) A rms ∠0°, IBS = 0.0 A rms ∠–120°, and ICS = 0.0 A rms ∠–240°.

The test pickup should operate immediately and test trip should operate in 5.5 to 5.7 seconds.

If this test is repeated, the operate time of the trip contact will change according to how soon
the test is repeated. The trip time can be calculated with to the following equation:

where T = the time between successive tests and Original Trip Time = the 5.5 to 5.7 seconds
it originally took to trip the relay. If the time between successive trips is greater than 230 sec-
onds, the relay will trip in the original trip time.

NOTE
New Trip Time T

230
---------- Original Trip Time×=
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Figure 4–7: CURRENT UNBALANCE TEST CONNECTIONS
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4.7.5 T8: LOSS OF FIELD PROTECTION ZONE 1 40-1

1. Make the following Settings changes:

40

(501) SELV2SUP = DISABLE (0)

40-1

(603) CENTER = 11 (55)
(604) RADIUS = 8.5 (42.5)
(605) TL12 = 0.06

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 40-1 function; 40-1 ON will be displayed on the MMI. Using the MMI and
the INFORMATION–VALUES command, verify that DIG IN 6 (EXT VTFF) = OPEN.

4. Using a 60 Hz source set the voltage inputs to: 

VA = 35 V rms ∠0°,
VB = 35 V rms ∠–120°,
VC = 35 V rms ∠–240°.

Set the current inputs according to the Table below.

5. The following results should be obtained:

Tests A & C: Test pickup and test trip do not operate.
Tests B & D: Test pickup operates immediately and test trip operates in 65 to 85 ms.

6. Apply DC voltage across DI6 (BE2—BE1). Using the MMI and the INFORMATION–VALUES command,
verify that DIG IN 6 (EXT VTFF) = CLOSE.

7. Repeat Test D from the above table and verify that the test pickup and test trip do not operate.

8. Remove DC from DI6 (BE2—BE1). Using the MMI and the INFORMATION–VALUES command, verify that
DIG IN 6 (EXT VTFF) = OPEN.

9. Change the following setting:

(501) SELV2SUP = ENABLE (1)

10. Set VA = 50 V rms ∠0°, IA = 2.7 (0.54) A rms ∠90°, and all other AC sources to 0 V. Verify that the test
pickup and test trip do not operate.

Table 4–2: CURRENT INPUTS FOR TESTS T8 & T9

TEST PHASE A PHASE B PHASE C

MAG. PHASE MAG. PHASE MAG. PHASE

A 14.5 (2.9) A 90° 14.5 (2.9) A –30° 14.5 (2.9) A –150°

B 12.5 (2.5) A 90° 12.5 (2.5) A –30° 12.5 (2.5) A –150°

C 1.7 (0.34) A 90° 1.7 (0.34) A –30° 1.7 (0.34)A –150°

D 1.9 (0.38) A 90° 1.9 (0.38) A –30° 1.9 (0.38) A –150°
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4.7.6 T9: LOSS OF FIELD PROTECTION ZONE 2, 40-2

1. Settings:

40-2

(703) CENTER = 11 (55)
(704) RADIUS = 8.5 (42.5)
(705) TL13 = 2

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 40-2 function; 40-2 ON will be displayed on the MMI.

4. Using a 60 Hz source, set the voltage inputs to: VA = 35 V rms ∠0°, VB = 35 V rms ∠–120°, and VC = 35 V
rms ∠–240°. Set the current inputs according to Table 4–2: CURRENT INPUTS FOR TESTS T8 & T9 on
page 4–21.

5. The following results should be obtained:

Tests A & C: Test pickup and test trip do not operate.
Tests B & D: Test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.

4.7.7 T10: ANTI-MOTORING & SEQUENTIAL TRIP SUPERVISION 32-1

1. Settings:

32-1

(803) SQ TR EN = YES [1/Y]
(804) REV PWR = 1.5 (0.3)
(805) TL1 = 5

DIG INP

(2501) SELBKDI1 = NO BLK (0)

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 32-1 function; 32-1 ON will be displayed on the MMI.

4. Using a 60 Hz source set the voltage inputs to: VA = 20 V rms ∠0°, VB = 20 V rms ∠–120°, and VC = 20 V
rms ∠–240°. Set the current input to IA = 0.1 (0.02) A rms ∠180°. Phases B and C should have no current.
Verify that test pickup operates and test trip do not operate.

5. Reduce IA to 0 A.

6. Apply DC across DI2 (BG6—BG5). Using the MMI and the INFORMATION–VALUES command, verify that
INLET VLV = CLOSED.

7. Set the current input to IA = 0.1 (0.02) A rms ∠180° and verify that the test pickup operates immediately
and the test trip operates in 5.0 to 5.05 seconds.

8. Reduce IA to 0 A and remove DC from DI2 (BG6—BG5). Using the MMI and the INFORMATION–VALUES
command, verify that INLET VLV = OPEN. Check that the test trip contact has dropped out.

9. Change the following setting:

(803) SQ TR EN = NO [3/N]

10. Repeat steps 7 to 8.
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4.7.8 T11: ANTI-MOTORING 32-2

Skip this test if your DGP model does not include this function. This function is not available
on DGP***ABA model relays.

1. Settings:

32-2

(903) REV PWR = 1.5 (0.3)
(904) TL2 = 1

DIG INP

(2501) SELBKDI1 = NO BLK (0)

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 32-2 function; 32-2 ON will be displayed on the MMI.

4. Using a 60 Hz source set the voltage inputs to:

VA = 20 V rms ∠0°,
VB = 20V rms ∠–120°,
VC = 20V rms ∠–240°.

5. Set the current input to IA = 0.1 (0.02) A rms ∠180°. Phases B and C should have no current.

6. Verify that test pickup operates immediately and test trip operates in 1.00 to 1.05 seconds.

4.7.9 T12: TIME OVERCURRENT WITH VOLTAGE RESTRAINT 51V

1. Settings:

51V

(1003) PICKUP = 0.5 (0.1)
(1004) TIME FAC = 1.0

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 51V function; 51V ON will be displayed on the MMI.

4. Using a 60 Hz source set the voltage inputs to:

VA = 70V rms ∠0°
VB = 70V rms ∠–120°
VC = 70V rms ∠–240°.

Set the current inputs according to the table below.

Table 4–3: CURRENT INPUTS FOR TEST T12

TEST PHASE A PHASE B PHASE C

MAG. PHASE MAG. PHASE MAG. PHASE

A 0.45 (0.09) A 0° 0.45 (0.09) A –120° 0.45 (0.09) A –240°

B 2.0 (0.4) A 0° 2.0 (0.4) A –120° 2.0 (0.4) A –240°

NOTE
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5. The following results should be obtained:

Test A: Test pickup and test trip do not operate.
Test B: Test pickup operates immediately and test trip operates in 1.00 to 1.04 sec.

6. Apply DC voltage across DI6 (BE2—BE1). Using the MMI and the INFORMATION–VALUES command,
verify that DIG IN 6 (EXT VTFF) = CLOSE.

7. Repeat test B from the table above. Verify that the test pickup operates but the test trip does not operate.

8. Remove DC from DI6 and all phase currents. Re-apply each phase current separately and verify that both
test contacts operate for each phase, as in step 5.

4.7.10 T13: ACCIDENTAL ENERGIZATION AE

1. Make the following settings:

AE
(2703) AE ARM = AND (0)

51V
(1002) ALARM = 1000 (enable 51V function)

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the AE function; AE ON will be displayed.

4. Using a 60 Hz source set the voltage inputs to:

VA = 29 V rms ∠0°
VB = 29 V rms ∠–120°
VC = 29 V rms ∠–240°.

Set the current inputs according to the table below:

5. Apply DC voltage across DI1 (BG8—BG7). Using the MMI and the INFORMATION–VALUES command,
verify that GEN = OFF LINE.

6. Reduce the three-phase voltage to 29 V rms and verify that test pickup and test trip operate in 5 to 5.05
seconds (see the NOTE below).

7. Remove DC from DI1 (BG8—BG7). Using the MMI and the INFORMATION–VALUES command, verify
that GEN = ON LINE. Notice that the test trip and test pickup drop out in 0.25 to 0.30 seconds.

8. Change the voltage of all three phases to 29 V rms and change the following setting:

(2703) AE - ARM = OR (1)

9. Verify that the test pickup and test trip operates in 5.00 to 5.05 seconds.

VA, VB, and VC must change from 70 V rms to 29 V rms with the source voltage continuously
on.

Table 4–4: CURRENT INPUTS FOR TEST T13

PHASE A PHASE B PHASE C

MAG. PHASE MAG. PHASE MAG. PHASE

0.45 (0.09) A 0° 0.45 (0.09) A –120° 0.45 (0.09) A –240°

NOTE
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Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS
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4.7.11 T14: STATOR GROUND ZONE 1 64G1

1. Make the following Settings changes:

64G1

(1103) PICKUP = 4.0
(1104) TL4 = 0.1

2. Connect the relay as shown in Figure 4–9: STATOR GROUND TEST CONNECTIONS on page 4–28.

3. Set up relay in test mode for the 64G1 function; 64G1 ON will be displayed on the MMI.

4. Set all current inputs to 0. Set the voltage inputs according to the table below.

5. The following results should be obtained:

Test A: Test pickup and test trip do not operate.
Test B: Test pickup operates immediately and test trip operates in 110 to 130 ms.

Table 4–5: VOLTAGE INPUTS FOR TEST T14

TEST PHASE A PHASE B PHASE C

MAG. PHASE MAG. PHASE MAG. PHASE

A 70 V 0° 70 V –120° 3.8 V –240°

B 70 V 0° 70 V –120° 4.2 V –240°
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4.7.12 T15: STATOR GROUND ZONE 2 64G2

Skip this test if your DGP model does not include this function. This function is not available
on DGP***ABA model relays.

1. Settings:

64G2

(1203) TL5 = 0.1

DIG INP

(2501) SELBKDI1 = NO BLK (0)

2. Connect the relay as shown in Figure 4–9: STATOR GROUND TEST CONNECTIONS.

3. Set up relay in test mode for the 64G2 function; 64G2 ON will be displayed on the MMI.

4. Set the following inputs using 60 Hz for phase A and 180 Hz for phases B and C.

5. The following results should be obtained:

Test A: Test pickup and test trip do not operate.
Test B: Test pickup operates immediately and test trip operates in 110 to 130 ms.

6. Change the following settings:

(2501) SELBKDI1 = BLK #2 (2)

7. Apply DC voltage across DI1 (BG8—BG7). Repeat test B and verify that the test contacts do not operate.
Remove DC from DI1 (BG8—BG7) and verify that test pickup operates immediately and test trip operates
in 110 to 130 ms.

Table 4–6: VOLTAGE INPUTS FOR TEST T15

TEST PHASE A (60 Hz) PHASE B (180 Hz) PHASE C (180 Hz)

MAG. PHASE MAG. PHASE MAG. PHASE

A 100 V 0° 10 V 0° 1 V 0°

B 100 V 0° 10 V 0° 0.5 V 0°

NOTE



4-28 DGP Digital Generator Protection System GE Multilin

4.7 PROTECTION TESTS 4 ACCEPTANCE TESTS

4

Figure 4–9: STATOR GROUND TEST CONNECTIONS
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4.7.13 T16: VOLTS/HERTZ OVEREXCITATION ALARM 24A

1. Settings:

24A

(1302) PICKUP = 1.5
(1303) TL6 = 1

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 24A function; 24A ON will be displayed on the MMI.

4. Set all current inputs to 0 A. Set the voltage inputs according to the table below:

5. The following results should be obtained:

TEST RESULTS:

Test A: Test pickup and test trip do not operate.
Tests B, C, and D: Test pickup operates immediately and test trip operates in 1.00 to 1.05 seconds.
Test E: Test pickup operates immediately and test trip operates in 1.20 to 1.40 seconds.

Table 4–7: VOLTAGE INPUTS FOR TEST T16

TEST PHASE A PHASE B PHASE C FREQ.

MAG. PHASE MAG. PHASE MAG. PHASE

A 69 V 0° 69 V –120° 69 V –240° 60 Hz

B 114 V 0° 69 V –120° 69 V –240° 60 Hz

C 69 V 0° 114 V –120° 69 V –240° 60 Hz

D 69 V 0° 69 V –120° 114 V –240° 60 Hz

E 69 V 0° 69 V –120° 69 V –240° 39 Hz
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4.7.14 T17: VOLTS/HERTZ OVEREXCITATION TRIP 24T

1. Settings:

24T

(1404) INV CURV = 1
(1405) INV PU = 1.5
(1406) TIME FAC = 99.99
(1407) INST PU = 1.5
(1408) TL7 = 1
(1409) RESET = 1

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 24T function; 24T ON will be displayed on the MMI.

4. Set all current inputs to 0. Using a 60 Hz source, set the voltage inputs according to the following table:

5. Verify that for all tests in the above table, test pickup operates immediately and test trip operates in 1.0 to
1.05 seconds.

6. Change the following settings:

24T

(1406) TIME FAC = 1
(1408) TL7 = 9.9

7. Repeat step 4. Verify that for all tests in the above except test trip should now operates in 5.0 to 5.5 sec-
onds.

If this test is repeated, the operate time of the trip contact will change according to how soon
the test is repeated. The trip time can be calculated according to the following equation:

where T = the time between successive tests, Original Trip Time = the 5.0 to 5.5 seconds it
originally took to trip the relay, and RESET = Setting 1409. If the time between successive
trips is greater than the RESET time, the relay will trip in the original trip time.

Table 4–8: VOLTAGE INPUTS FOR TEST T17

TEST PHASE A PHASE B PHASE C

MAG. PHASE MAG. PHASE MAG. PHASE

A 114 V 0° 69 V –120° 69 V –240°

B 69 V 0° 114 V –120° 69 V –240°

C 69 V 0° 69 V –120° 114 V –240°

NOTE
New Trip Time T

RESET
-------------------- Original Trip Time×=
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4.7.15 T18: POSITIVE-SEQUENCE OVERVOLTAGE 59

1. Make the following Settings changes:

59

(1503) PICKUP = 120
(1504) TIME FAC = 1
(1505) CURVE # =1 (not available for DGP***AAA models)
(1506) INST PU = 240 (available on DGP****CA models only)

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 59 function; 59 ON will be displayed on the MMI.

4. Set all current inputs to 0 A. Using a 60 Hz source set the voltage inputs according to the following table.

5. The following results should be obtained::

TEST RESULTS

Test A: Test pickup and test trip do not operate.
Test B: Test pickup operates immediately and test trip operates in 2.18 to 2.32 seconds.
Test C: Test pickup operates immediately and test trip operates in 540 to 570 ms (see note below).

For DGP****CA models, the trip time should be approximately 30 ms since the instantaneous unit
should operate before the inverse curve. 

Table 4–9: CURRENT INPUTS FOR TEST T18

TEST PHASE A PHASE B PHASE C

MAG. PHASE MAG. PHASE MAG. PHASE

A 65 V 0° 65 V –120° 65 V –240°

B 100 V 0° 100 V –120° 100 V –240°

C 200 V 0° 200 V –120° 200 V –240°

NOTE
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4.7.16 T19: UNDERFREQUENCY UNIT #1 81-1U

1. Make the following Settings changes:

81

(1601) CUTOFF = 90%

81-1U

(1703) SET PNT = 60
(1704) TL8 = 2

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 81-1U function; 81-1U ON will be displayed on the MMI.

4. Set all current inputs to 0. Using a 61 Hz source, set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°,
VC = 70 V rms ∠–240°.

5. Verify that test pickup and test trip do not operate.

6. Change the frequency of the voltage inputs to 59 Hz.

7. Verify that test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.

4.7.17 T20: UNDERFREQUENCY UNIT #2 81-2U

1. Make the following Settings changes:

81-2U

(1803) SET PNT = 60
(1804) TL9 = 2

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 81-2U function; 81-2U ON will be displayed on the MMI.

4. Set all current inputs to 0. Using a 61 Hz source, set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°,
VC = 70 V rms ∠–240°.

5. Verify that test pickup and test trip do not operate.

6. Change the frequency of the voltage inputs to 59 Hz.

7. Verify that test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.



GE Multilin DGP Digital Generator Protection System 4-33

4 ACCEPTANCE TESTS 4.7 PROTECTION TESTS

4

4.7.18 T21: UNDERFREQUENCY UNIT #3 81-3U

Skip this test if your DGP model does not include this function. This function is not available
on DGP***ABA model relays.

1. Make the following Settings changes:

81-3U

(1903) SET PNT = 60
(1904) TL10 = 2

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 81-3U function; 81-3U ON will be displayed on the MMI.

4. Set all current inputs to 0. Using a 61 Hz source, set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°,
VC = 70 V rms ∠–240°.

5. Verify that test pickup and test trip do not operate.

6. Change the frequency of the voltage inputs to 59 Hz.

7. Verify that test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.

4.7.19 T22: UNDERFREQUENCY UNIT #4 81-4U

Skip this test if your DGP model does not include this function. This function is not available
on DGP***ABA model relays.

1. Make the following Settings changes:

81-4U

(2003) SET PNT = 60
(2004) TL11 = 2

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 81-4U function; 81-4U ON will be displayed on the MMI.

4. Set all current inputs to 0. Using a 61 Hz source, set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°,
VC = 70 V rms ∠–240°.

5. Verify that test pickup and test trip do not operate.

6. Change the frequency of the voltage inputs to 59 Hz.

7. Verify that test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.

NOTE

NOTE
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4.7.20 T23: OVERFREQUENCY UNIT #1 81-1O

1. Make the following Settings changes:

81-1O

(2103) SET PNT = 60
(2104) TL15 = 2

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 81-1O function; 81-1O ON will be displayed on the MMI.

4. Set all current inputs to 0. Using a 59 Hz source set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°,
VC = 70 V rms ∠–240°.

5. Verify that the test pickup and test trip do not operate.

6. Change the frequency of the voltage inputs to 61 Hz.

7. Verify test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.

4.7.21 T24: OVERFREQUENCY UNIT #2 81-2O

1. Make the following Settings changes:

81-2O

(2203) SET PNT = 60
(2204) TL16 = 2

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 81-2O function; 81-2O ON will be displayed on the MMI.

4. Set all current inputs to 0. Using a 59 Hz source set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°,
VC = 70 V rms ∠–240°.

5. Verify that the test pickup and test trip do not operate.

6. Change the frequency of the voltage inputs to 61 Hz.

7. Verify test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.



GE Multilin DGP Digital Generator Protection System 4-35

4 ACCEPTANCE TESTS 4.7 PROTECTION TESTS

4

4.7.22 T25: OVERFREQUENCY UNIT #3 81-3O

Skip this test if your DGP model does not include this function. This function is not available
on DGP***ABA and DGP****CA model relays.

1. Make the following Settings changes:

81-3O

(2303) SET PNT = 60
(2304) TL17 = 2

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 81-3O function; 81-3O ON will be displayed on the MMI.

4. Set all current inputs to 0. Using a 59 Hz source set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°,
VC = 70 V rms ∠–240°.

5. Verify that the test pickup and test trip do not operate.

6. Change the frequency of the voltage inputs to 61 Hz.

7. Verify test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.

4.7.23 T26: OVERFREQUENCY UNIT #4 81-4O

Skip this test if your DGP model does not include this function. This function is not available
on DGP***ABA and DGP****CA model relays.

1. Make the following Settings changes:

81-4O

(2403) SET PNT = 60
(2404) TL18 = 2

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 81-4O function; 81-4O ON is displayed on the MMI.

4. Set all current inputs to 0. Using a 59 Hz source set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°
VC = 70 V rms ∠–240°.

5. Verify that the test pickup and test trip do not operate.

6. Change the frequency of the voltage inputs to 61 Hz.

7. Verify test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.

NOTE

NOTE
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4.7.24 T27: VOLTAGE TRANSFORMER FUSE FAILURE VTFF

1. Make the following Settings changes:

DIG INP

(2501) SELBKDI1 = NO BLK (0)
VTFF

(2601) VTFF = DISABLE (0) – set for TEST mode only

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the VTFF function; VTFF ON will be displayed on the MMI.

4. Set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°,
VC = 70 V rms ∠–240°.

5. Set the current inputs to: 

IAS = 0.5 A rms ∠90°,
IBS = 0.5 A rms ∠–30°,
ICS = 0.5 A rms ∠–150°. 

6. Verify that neither the test pickup nor the test trip operates.

7. Decrease the voltage in all three phases to 49 V rms. Verify that test pickup and test trip operate in 12.4 to
13.0 seconds.

4.7.25 T28: TOC GROUND OVERCURRENT 51GN

Skip this test if your DGP model does not include this function. This function is not available
on DGP***AAA model relays.

1. Make the following Settings changes:

51GN

(2803) PICKUP = 0.5 (0.1)
(2804) TIME FAC = 1.0

2. Connect as shown in Figure 4–6: GENERATOR DIFFERENTIAL TEST CONNECTIONS on page 4–18.

3. Set up relay in test mode for the 51GN function; 51GN ON will be displayed on the MMI.

4. Set the current input to: IAR = 0.45 (0.09) A rms. Set the voltage inputs to:

VA = 70 V rms ∠0°,
VB = 70 V rms ∠–120°,
VC = 70V rms ∠–240°. 

5. Verify that neither the test pickup nor the test trip operates.

6. Increase the current input to: IAR = 1.5 (0.3) A rms. Verify that test pickup operates immediately, and test
trip operates in 1.30 to 1.45 seconds.

7. Repeat steps 4 and 5, but use 20 (4.0) A rms in step 4, and verify that test pickup operates immediately
and test trip operates in 184 to 204 ms.

NOTE
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4.7.26 T29: UNDERVOLTAGE 27

Skip this test if your DGP model does not include this function. This function is not available
on DGP***AAA model relays.

1. Make the following Settings changes:

27

(2903) PICKUP = 100
(2904) TIME FAC = 1.0
(2905) CURVE # = 1

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the 27 function; 27 ON will be displayed on the MMI.

4. Set the voltage inputs to: VA = 70 V rms ∠0°, VB = 70 V rms ∠–120°, and VC = 70 V rms ∠–240°. Verify
that neither the test pickup nor the test trip operates.

5. Decrease the voltage inputs to: VA = 30 V rms ∠0°, VB = 30 V rms ∠–120°, and VC = 30 V rms ∠–240°.
Verify that test pickup operates immediately, and test trip operates in 1.03 to 1.15 seconds.

4.7.27 T30: THIRD HARMONIC NEUTRAL UNDERVOLTAGE 27TN

Skip this test if your DGP model does not include this function. This function is not available
on DGP***AAA and DGP***ABA model relays.

1. Settings:

27TN

(3003) PICKUP = 0.9
(3004) TL20 = 2.0
(3005) FORPWR-L = 10
(3006) FORPWR-H = 20

2. Connect relay as shown in Figure 4–10: STATOR GROUND TEST FOR 27TN FUNCTION on page 4–38.

3. Set up relay in test mode for the 27TN function; 27TN ON will be displayed on the MMI.

4. Set the voltage and current (rms) inputs to:

VA = 80 V ∠0°, 60 Hz
VN = 1 V ∠0°, 180 Hz
IAS = 0.1 A ∠0°, 60 Hz

5. Verify that neither the test pickup nor the test trip operates.

6. Reduce VN to 0 V. Verify that test pickup operates immediately and test trip operates in 2.0 to 2.1 seconds.

7. Change IAS to 0.2 A ∠0°, 60Hz. Verify that test pickup and test trip do not operate. 

8. Change IAS to 0.3 A ∠0°, 60Hz. Verify that test pickup operates immediately, and test trip operates in 2.0
to 2.1 seconds.

NOTE

NOTE
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Figure 4–10: STATOR GROUND TEST FOR 27TN FUNCTION
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4.8 END OF ACCEPTANCE TESTING 4.8.1 DESCRIPTION

Make sure that the relay is no longer in test mode; by selecting END TEST MODE.

Print out or scroll through all of the settings. Compare them with the initial Settings of the relay, and change to
initial values.

If the initial settings were saved to a disk file before testing using DGP-PC, download the file to the relay!
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5 PERIODIC TESTS 5.1 INTRODUCTION 5.1.1 DESCRIPTION

Power Down the relay by removing the test plugs before removing or inserting modules. Fail-
ure to do so can permanently damage the relay.

The formulas below will permit the calculation of pickup currents and voltages for testing the DGP system
with settings specific to a particular application. The test circuits and procedures are the same as used and
illustrated in Chapter 4: ACCEPTANCE TESTS.

It is up to the user to determine the extent of the testing to be performed. The tests shown are guides for per-
forming the test; they are not strictly required to be done at every periodic test of the relay. The desired test
procedures can be incorporated into the user's standard test procedures.

However, it is suggested that the relay's built-in self-tests be incorporated into the user's test procedures. They
will give the operational status of the unit.

It is assumed that the user is familiar with testing the DGP system. If not, refer to Chapter 4: ACCEPTANCE
TESTS for details.

5.1.2 GENERAL TESTS

• T1: MMI Status and Display Tests (Self Tests)

• T2: Digital Output Test

• T3: Digital Input Test

• T4: AC System Input Test

5.1.3 PROTECTION FUNCTION TESTS

• T5: Generator Differential, 87G

• T6: Current Unbalance Alarm, 46A

• T7: Current Unbalance Trip, 46T

• T8: Loss of Excitation, 40-1

• T9: Anti-Motoring with Accidental Energization
and Sequential Trip Supervision, 32-1

• T10: Time Overcurrent with Voltage Restraint,
51V

• T11: Stator Ground Zone1, 64G1

• T12: Stator Ground Zone2, 64G2 *

• T13: Overexcitation (Volts/Hz) Alarm, 24A

• T14: Overexcitation (Volts/Hz) Trip, 24T

• T15: Overvoltage, 59

• T16: Underfrequency, 81-1U

• T17: Overfrequency, 81-1O

• T18: Voltage Transformer Fuse Failure, VTFF

• T19: TOC Ground Overcurrent, 51GN *

• T20: Undervoltage, 27 *

* Functions available on some models only. 

5.1.4 GENERAL INSTRUCTIONS

1. Refer to Chapter 4: ACCEPTANCE TESTS for general information on preparing the DGP for testing.

2. Before beginning the test, the relay settings should be printed for reference and verification. If no printer is
available, scroll through each setting and make sure they match the required settings of the relay.

CAUTION
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5.2 RELAY TESTS 5.2.1 T1: RELAY STATUS & MMI

The DGP status is reported through the MMI, the non-critical alarm contact, and the critical alarm contact. If a
system error causes relaying functions to cease, the LED on the MMI turns red, a FAIL message is displayed,
and the critical alarm relay de-energizes. A failure that did not interrupt relaying is indicated by energization of
the non-critical alarm relay and a WARN message on the MMI display.

If a STATUS error is detected, see Section 6.3.5: SERVICING SYSTEM STATUS FAILURES on page 6–6 for
further information.

a) STATUS CHECK

1. Apply rated DC power and wait for initialization to complete, as indicated by the green LED.

2. Press the [INF] key. Then scroll with the arrow keys until the heading INF: STATUS is displayed.

3. Press the [ENT] key.

The display should read STATUS OK.

b) DISPLAY TEST

The MMI test is built into the software. It allows the user to test the keypad, the printer, and the display. If no
printer is to be used with your relay, then skip the printer port testing.

1. Apply rated DC power and wait for initialization to complete, as indicated by the green LED.

2. Press the [ACT] key. Then scroll with the arrow keys until the heading ACT: MMI TEST is displayed.

3. Press the [ENT] key.

The display should show NEXT?.

4. Press the [1/Y] followed by the [ENT] key.

The display will change to LED TST?.

5. Press the [1/Y] followed by the [ENT] key.

If the green LED is on, it will be extinguished and the red LED will be lit. If the red LED is lit, it will be extin-
guished and the green LED will be lit. The target LEDs will then flash on/off 4 times. Then each Target LED
will be lit individually. When the test is over the target LEDs will be returned to their original state.

6. Next, the display will prompt for the keyboard test with KEYBRD TST?.

7. Press the [1/Y] key followed by the [ENT] key.

8. At this point the MMI is in the keyboard test. Press every key on the keypad, except for the [CLR] key. As
you press each key, verify that the display indicates the key that was pressed.

9. When all the keys have been checked, press the [CLR] key.

10. The display will prompt PRINTER TST?. If you do not have a printer, the press the [3/N] followed by the
[ENT] key. If you have a printer, press the [1/Y] followed by the [ENT] key.

The printout will be 40 characters, which include the alphabet, the numbers 0 through 9, as well as the “:”,
“=”, “/” and “.” characters. Forty lines will be printed.
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5.2.2 T2: DIGITAL OUTPUT TEST

This test is used to check all outputs of the relay. It is a convenient way to determine proper system connec-
tions and verify the operation of all relay contacts, without having to apply currents and voltages to simulate
faults.

If DGP-Link is used to perform this test, the outputs will not operate unless jumper J1 on the
MMI module is removed. Refer to Figure 3–4: DGP MMI MODULE on page 3–5 .

1. Connect the relay as shown in Figure 4–3: DIGITAL OUTPUT TEST CONNECTIONS on page 4–12.

2. Enter the Control Level password.

3. Press the [ACT] key and then select DIG OUT TEST. Press the [ENT] key.

4. Select the output to test. Use the arrow keys to scroll to the desired output, such as 94G, and press the
[ENT] key.

Before the contact is allowed to close, you will be prompted to turn protection off during the test. The
prompt is: DISABLE PROT?. Press the [1/Y] key followed by the [ENT] key to turn protection off. Protec-
tion will remain off until the test mode is ended.

Verify that the output under test has closed, using an ohmmeter or other suitable device.

5. After the output is tested, scroll to the next output to test, then press the [ENT] key. This output will close
and the previously selected output will open. Continue in this fashion until all outputs are tested.

6. End the test mode by scrolling to the END TEST MODE selection, then press the [ENT] key. Alternatively,
[END] followed by the [ENT] can be pressed to end the test and re-enable protection.

5.2.3 T3: DIGITAL INPUT TEST

This test is used to check all digital inputs of the relay. It is a convenient way to determine proper system con-
nections and verify the operation of all dual optically isolated digital inputs. All digital inputs should be between
35 and 300 V DC.

Protection can be enabled or disabled, as deemed necessary by the user.

1. Connect the relay as shown in Figure 4–4: DIGITAL INPUT TEST CONNECTIONS on page 4–14.

2. Apply DC across digital input DI1 (BG8—BG7). Using the MMI and the INFORMATION–VALUES com-
mand, verify that GEN = OFF-LINE.

3. Remove DC from digital input DI1 (BG8—BG7). Using the MMI and the INFORMATION–VALUES com-
mand, verify that GEN = ON-LINE.

4. Apply DC across digital input DI2 (BG6—BG5). Using the MMI and the INFORMATION–VALUES com-
mand, verify that INLET VLV=CLOSED.

5. Remove DC from digital input DI2 (BG6—BG5). Using the MMI and the INFORMATION–VALUES com-
mand, verify that INLET VLV=OPEN.

6. Apply DC across digital input DI3 (BG4—BG3). Using the MMI and the INFORMATION–VALUES com-
mand, verify that DIG IN 3 = CLOSE.

7. Remove DC from digital input DI3 (BG4—BG3). Using the MMI and the INFORMATION–VALUES com-
mand, verify that DIG IN 3 = OPEN.

8. Apply DC across digital input DI4 (BG2—BG1). Using the MMI and the INFORMATION–VALUES com-
mand, verify that DIG IN 4 = CLOSE.

NOTE
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9. Remove DC from digital input DI4 (BG2—BG1). Using the MMI and the INFORMATION–VALUES com-
mand, verify that DIG IN 4 = OPEN.

10. Apply DC across digital input DI5 (BE4—BE3). Using the MMI and the INFORMATION–VALUES com-
mand, verify that OSC TRIG = CLOSE.

NOTE: This input is not active on some DGP models.

11. Remove DC from digital input DI5 (BE4—BE3). Using the MMI and the INFORMATION–VALUES com-
mand, verify that OSC TRIG = OPEN.   

NOTE: This input is not active on some DGP models.

12. Apply DC across digital input DI6 (BE2—BE1). Using the MMI and the INFORMATION–VALUES com-
mand, verify that DIG IN 6 = CLOSE.

13. Remove DC from digital input DI6 (BE2—BE1). Using the MMI and the INFORMATION–VALUES com-
mand, verify that DIG IN 6 = OPEN.

5.2.4 T4: AC SYSTEM INPUT TEST

This initial test uses the INFORMATION–VALUES command to determine that the voltages and currents are
applied to the proper connections on the terminal strip. The INFORMATION–VALUES command can be used
at any time during the test to verify that the relay has the correct voltages and currents applied.

1. Connect the relay as shown in Figure 4–5: AC SYSTEM INPUT TEST CONNECTIONS on page 4–16.

2. Using a 60 Hz source set the current (rms) inputs to:

IA = 0.5 (0.1) A ∠0°,
IB = 2.0 (0.4) A ∠–120°,
IC = 15.0 (3.0) A ∠–240°

3. Set the voltage (rms) inputs to: 

VA = 20 V ∠0°,
VB = 70 V ∠–120°,
VC = 120 V ∠–240°.

4. Press the [INF] key. Scroll with arrow keys to the INF: VALUES heading, then press the [ENT] key. The
present values are now selected.

5. With the arrow keys, scroll through the values of:

IAS, ANGLE IAS

IBS, ANGLE IBS

ICS, ANGLE ICS

IAR, ANGLE IAR

IBR, ANGLE IBR

ICR, ANGLE ICR

VAN, ANGLE VAN

VBN, ANGLE VBN

VCN, ANGLE VCN

GEN FREQ
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6. Check that all frequency measurements are within 0.01 Hz and all voltage and current measurements are
within 3% of their set amplitude and 1° of their set phase.

There are other quantities listed between the values of ANGLE VCN and GEN FREQ these will
be tested in another section.

7. If a PC is connected to the DGP, the present values can be read with the DGP-Link software. Alternately,
whenever the MMI display is blank, pressing the [CLR] key will automatically scroll through all of the
present values.

8. Repeat steps 2 through 6 using the following source frequencies: 30.5 and 79.5 Hz.

NOTE
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5.3 MEASURING UNIT TESTS 5.3.1 DESCRIPTION

The test contacts will chatter when the unit under test is near its threshold. DO NOT LET IT
CONTINUE. REMOVE THE TEST CURRENT. A single contact closure is enough to determine
that the unit has picked up or tripped.

Prior to each test there is space provided to record the user specific setting for the function under test.

Where appropriate, current levels are defined with two numbers as xx (yy); xx represents the value to be used
for relays rated at 5 A and yy represents the value to be used for 1 A relays.

5.3.2 T5: GENERATOR DIFFERENTIAL TEST 87G

1. Record the following Settings:

87G
(203) K1 = ______%
(204) PICKUP (Differential Current) = ______ A rms

2. Differential Protection is calculated with the following equation:

(equation 5–1)

IAR and IAS are the return and source current for phase A. The unit should pick up when equation 5–1 is
true and the differential is greater than the pickup setting.

3. Connect the relay as shown in Figure 4–6: GENERATOR DIFFERENTIAL TEST CONNECTIONS on page
4–18.

4. Set up relay in test mode for the 87G function; 87G ON will be displayed on the MMI.

5. Set the in-phase currents of IAR and IAS to make equation 5–1 true. This should operate the test pickup
and test trip relays. Set the currents of IAR and IAS to make equation 5–1 false. This should not operate the
test pickup and test trip relays.

5.3.3 T6: CURRENT UNBALANCE ALARM 46A

1. Record the following Settings:

46A
(302) PICKUP (I2) = ______ A rms
(303) TL14 (time delay) = ______ sec.

2. Current Unbalance Alarm is calculated with the following equation:

I2 > PICKUP (equation 5–2)

I2 is equal to the negative-sequence current. The unit should pick up when I2 > PICKUP. The unit should
trip with time delay as set in TL14 after it has picked up.

3. Connect relay as shown in Figure 4–7: CURRENT UNBALANCE TEST CONNECTIONS on page 4–20.

4. Set up relay in test mode for the 46A function; 46A ON will be displayed on the MMI.

5. Set the negative-sequence current to PICKUP + 0.1 (0.02) =______ A rms and apply to the relay. The test
pickup relay should operate and TL14 seconds later the test trip relay should operate. Lower the negative-
sequence current to PICKUP – 0.1 (0.02) =______ A rms and the test pickup and test trip relays should
not operate.

CAUTION

IAR IAS–
2 K1

100
---------- IAR IAS⋅ ⋅>
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5.3.4 T7: CURRENT UNBALANCE TRIP 46T

1. Record the following Settings:

46T

(403) PICKUP (I2) = ______ A rms
(404) K2 (Time Factor) = ______ sec.

2. Current Unbalance Trip is calculated with the following equation:

(equation 5–3)

I2 is equal to the negative-sequence current, K2 is equal to the time factor, and Irated is equal to the rated
current (Setting 115: RATEDCUR). The unit should pick up when I2 > PICKUP. If the unit has been picked
up for a time equal to the Trip Time, the test trip relay will operate.

3. Connect relay as shown in Figure 4–7: CURRENT UNBALANCE TEST CONNECTIONS on page 4–20.

4. Set up relay in test mode for the 46T function; 46T ON will be displayed on the MMI.

5. Set the negative-sequence current to PICKUP + 0.1 (0.02) =______ A rms and apply to the relay. The test
pickup relay should operate and the test trip relay should operate after the Trip Time has expired. 

6. Lower the negative-sequence current to PICKUP – 0.1 (0.02) =______ A rms and the test pickup and test
trip relays should not operate.

If this test is repeated, the operate time of the trip contact will change according to how soon
the test is repeated. The trip time can be calculated according to the following equation:

where T = the time between successive tests and Original Trip Time = the time to trip the relay
when the test was first run. If the time between successive trips is greater than 230 seconds,
the relay will trip in the original trip time.

Trip Time K2
I2 Irated⁄( )2

-----------------------------=

NOTE
New Trip Time T

230
---------- Original Trip Time×=
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5.3.5 T8: LOSS OF EXCITATION 40-1

1. Make/record the following Settings:

40

(501) SELV2SUP = DISABLE (0)

40-1

(603) CENTER (Center of Zone 1) = ______ ohms
(604) RADIUS (Radius of Zone 1) = ______ ohms
(605) TL12 (Time Delay) = ______ sec.

2. Loss of Excitation is calculated with the following equation:

(equation 5–4)

Va and Vb are vector-phase voltages, Ia and Ib are vector-phase currents, and Z is the corresponding
impedance. If the value of Z falls within the Mho circle of the relay, the test pickup will operate and the test
trip will operate TL12 seconds later.

3. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

4. Set up relay in test mode for the 40-1 function; 40-1 ON will be displayed on the MMI. Using the MMI and
the INFORMATION–VALUES command, verify that EXT VTFF = OPEN.

5. Using a 60 Hz source set the voltage (rms) inputs to:

VA = 35 V ∠0°
VB = 35 V ∠–120°
VC = 35 V ∠–240°.

6. Set the phase current so that the impedance falls within the Mho circle and apply to the relay. The test
pickup relay should operate immediately and TL12 seconds later the test trip relay should operate. 

7. Change the phase current so that the impedance falls outside the Mho circle, and apply to the relay. The
test pickup and test trip relays should not operate.

8. Apply DC voltage across DI6 (BE2—BE1). Using the MMI and the INFORMATION–VALUES command,
verify that EXT VTFF = CLOSE.

9. Reapply the above phase current that placed the impedance inside the Mho circle. Verify that the test
pickup operates and the test trip does not operate.

1.

Z
Va Vb–

Ia Ib–
-------------------=
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5.3.6 T9 ANTI-MOTORING TEST 32-1

This is a periodic test of anti-motoring with accidental energization and sequential trip supervision.

1. Record the following Settings:

32-1

(803) SQ TR EN (Seq. Trip Enable) = ______ (Y/N)
(804) REV PWR (Reverse Power) = ______ W
(805) TL1 (Time Delay) = ______ S

2. Anti-Motoring is calculated with the following equation:

(equation 5–5)

Va, Vb, and Vc are vector-phase voltages, Isa, Isb and Isc are vector-phase currents, P is the real output
power, and Q is the imaginary output power. If the value of P is greater than Setting 804: REV PWR, the
test pickup will operate. Depending on the state of DI1, DI2, and Sequential Trip Enable (Setting 803: SQ
TR EN), the test trip will, or will not, operate. See Figure 1–3: SIMPLE LOGIC DIAGRAM – 87G, 32, 27, 59,
AND AE on page 1–13 for details.

3. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

4. Set up relay in test mode for the 32-1 function; 32-1 ON will be displayed on the MMI.

5. Change Setting 803: SQ TR EN to YES [1/Y].

6. Set the phase voltages and currents to REV PWR + 0.1 =______ W and apply to the relay. The test pickup
relay should operate immediately.

7. Apply DC to DI2 (BG6—BG5). Using the MMI and the INFORMATION–VALUES command, verify that
INLET VLV = CLOSED.

8. The test pickup relay should operate immediately and TL1 seconds later the test trip relay should operate.

9. Leaving all of the AC signals applied, remove DC from DI2 (BG6—BG5). Using the MMI and the INFOR-
MATION–VALUES command, verify that INLET VLV = OPEN. Check that the test trip contact has dropped
out.

10. Change Setting 803: SQ TR EN to NO (3/N). Leaving all of the AC signals applied, notice that the test
pickup operates immediately and the test trip operates in 5.0 to 5.1 seconds.

11. Return Setting 803: SQ TR EN to its original value.

P jQ+ Va Isa⋅ Vb Isb⋅ Vc Isc⋅+ +=
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5.3.7 T10: TIME OVERCURRENT WITH VOLTAGE RESTRAINT 51V

1. Record the following Settings:

51V

(1003) PICKUP (Overcurrent Pickup) = ______ A
(1004) TIME FAC (Time Factor K) = ______ sec.

2. Time Overcurrent is calculated with the following equation:

(equation 5–6)

where: K = time factor
I = phase current
VNOM = nominal voltage
Ipu = pickup level for overcurrent 
V = phase to phase voltage 

The time factor K is Setting 1004: TIME FAC. Phase current I is the current applied to any one phase.
Nominal voltage VNOM is Setting 114: NOM VOLT, the pickup level for overcurrent Ipu is Setting 1003:
PICKUP, and the phase to phase voltage V is the voltage in the corresponding phase. If the value of phase
current is greater than Setting 1003: PICKUP, the test pickup will operate. If the phase current is above
Setting 1003: PICKUP for a time equal to Trip Time, the test trip relay will operate.

3. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

4. Set up relay in test mode for the 51V function; 51V ON will be displayed on the MMI.

5. Using a 60 Hz source set the voltage (rms) inputs to:

VA = 70 V ∠0°
VB = 70 V ∠–120°
VC = 70 V ∠–240°

6. Set the current input to PICKUP + 0.1 (0.02) =______ A rms and apply to the relay. The test pickup relay
should operate immediately and the test trip relay should operate after the Trip Time has expired.

7. Lower the current to PICKUP – 0.1 (0.02) =______ A rms and the test pickup and test trip relays should
not operate.

8. Apply DC voltage across DI6 (BE2—BE1). Using the MMI and the INFORMATION–VALUES command,
verify that EXT VTFF = CLOSE.

9. Set the current input to PICKUP + 0.1 (0.02) =______ A rms and apply to the relay. Verify that the test
pickup operates but the test trip does not operate.

10. While continuing to input the current, remove the DC from DI6 (BE2—BE1). The test pickup operates
immediately and test trip operates after Trip Time expires.

Trip Time K
I VNOM⋅( ) Ipu V⋅( )⁄ 1–

----------------------------------------------------------------=
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5.3.8 T11: STATOR GROUND ZONE 1 64G1

1. Record the following Settings:

64G1

(1103) PICKUP (Neutral Overvoltage) = ______ V rms
(1104) TL4 (Time Delay) = ______ sec.

2. The Fundamental Frequency Neutral Overvoltage is calculated with the following equation:

Vn > PICKUP (equation 5–7)

Vn is equal to the neutral voltage. The unit should pick up when Vn > PICKUP. The unit should trip TL4 sec-
onds after it has picked up.

3. Connect the relay as shown in Figure 4–9: STATOR GROUND TEST CONNECTIONS on page 4–28.

4. Set up relay in test mode for the 64G1 function; 64G1 ON will be displayed on the MMI.

5. Using a 60 Hz source, set the voltage (rms) inputs to: VA = 70 V ∠0° and VB = 70 V ∠–120°. Set the VC
(paralleled with Vn) to PICKUP + 0.1 (0.02) =______ V rms and apply to the relay. The test pickup relay
should operate, and TL4 seconds later the test trip relay should operate. 

6. Lower the VC voltage to PICKUP – 0.1(0.02) =______ V rms and the test pickup and test trip relays should
not operate.

5.3.9 T12: STATOR GROUND ZONE 2 64G2

Skip this test if your model of DGP does not have this function. This function is not available
on DGP***ABA models.

1. Record the following Settings:

64G2
(1203) TL5 (Time Delay) = ______ sec.

DIG INP
(2501) SELBKDI1 (Blocking Scheme) = ______ 

2. The Percentage of 3rd Harmonic in the Neutral is calculated with the following equation:

(equation 5–8)

Vn3 is the 3rd harmonic voltage in the generator neutral and Vp3 is the sum of all 3rd harmonic voltages in
all phases. The unit should pick up when equation 5–8 is true and trip TL5 seconds after it has picked up.

3. Connect the relay as shown in Figure 4–9: STATOR GROUND TEST CONNECTIONS on page 4–28.

4. Set up relay in test mode for the 64G2 function; 64G2 ON will be displayed on the MMI.

5. Set Setting 2501: SELBKDI1 to NO BLK (0). Set the AC inputs using 60 Hz for phase A and 180 Hz for
phases B and C. The phase angles for all three signals should be 0°. VA should be 100 V rms and VB and
VC (paralleled with VN) should be changed to make equation 5–8 true. This will cause the test pickup relay
to operate, and TL5 seconds later the test trip relay will operate.

6. Change Setting 2501: SELBKDI1 to BLK#2 (2). Apply DC voltage across DI1 (BG*—BG7). Re-apply the
AC inputs of step 3 and verify that only the test pickup operates.

NOTE

Vn3
Vp3 3⁄( ) Vn3+

------------------------------------- 0.15<
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5.3.10 T13: VOLTS/HERTZ OVEREXCITATION ALARM 24A

1. Record the following Settings:

24A

(1302) PICKUP (V/Hz Pickup) = ______ 
(1303) TL6 (V/Hz Time Delay) = ______ sec.

2. Volt/Hertz Overexcitation Alarm is calculated with the following relation:

equation 5–9

Actual V/Hz is the voltage applied to any one phase divided by the frequency applied. PICKUP is Setting
1302: PICKUP, VNOM is defined by

equation 5–10

where NOM VOLT is the nominal voltage Setting 114: NOM VOLT, and x = 1.732 or 1, depending on Set-
ting 116: VTCONN (for WYE, x = 1.732; for DELTA, x = 1). SYSFREQ is Setting 102. If equation 5–9 is sat-
isfied, the test pickup relay will operate. If this condition persist for a time equal to TL-6, the test trip relay
will operate.

3. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

4. Set up relay in test mode for the 24A function; 24A ON will be displayed on the MMI.

5. Set all current inputs to 0. Set:

VA = 70 V rms ∠0°
VB = 70 V rms ∠–120°
VC = 70 V rms ∠–240°

6. Change the voltage of any one phase until Voltage/Frequency is equal to: V/Hz setting + 0.1 = ______.
This will cause the test pickup relay to operate and the test trip relay will operate after the Trip Time has
expired. 

7. Change the voltage of any one phase until Voltage/Frequency is equal to: V/Hz setting – 0.1 =______. The
test pickup and test trip relays will not operate.

Actual V/Hz
PICKUP VNOM×

SYSFREQ
--------------------------------------------=

VNOM
NOM VOLT

x
-------------------------------=
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5.3.11 T14: VOLTS/HERTZ EXCITATION TRIP 24T

1. Record the following Settings:

24T

(1404) INV CURV (Curve Type) = _____
(1405) INV PU (V/Hz Inverse Pickup) = ______ 
(1406) TIME FAC (Time Factor, K) = ______ sec.
(1407) INST PU (V/Hz Pickup) = _____ 
(1408) TL7 (Time Delay for INST PU) = ______ sec.
(1409) RESET (Reset Time between Trips) = ______ 

2. Volt/Hertz Overexcitation Trip Time is calculated with the following equations

For Inverse Operation: 

where N = 2, 1, and 0.5 for Curves 1, 2, and 3, respectively.

For Instantaneous Operation:

K is the time factor, Setting 1406: TIME FAC. Both forms of the equation (inverse and instantaneous) are
calculated and the relay trips whenever either Trip Time has expired. Actual V/Hz is the voltage applied to
any one phase divided by the frequency applied. INV PU and INST PU are Settings 1405: INV PU and
1407: INST PU, respectively. VNOM is the nominal voltage, defined by Setting 114: NOM VOLT / x, where x
= 1.732 or 1, depending on Setting 116: VTCONN (for WYE, x = 1.732; for DELTA, x = 1). SYSFREQ is
Setting 102: SYSFREQ. If either of the above equations are satisfied, the test pickup relay will operate. If
this condition persist for a time equal to the respective Trip Time, the test trip relay will operate.

3. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

4. Set up relay in test mode for the 24T function; 24T ON will be displayed on the MMI.

5. Set all current inputs to 0. Set VA = 70 V rms ∠0°, VB = 70 V rms ∠–120°, and VC = 70 V rms ∠–240°.
Change the voltage of any one phase until Voltage/Frequency is equal to: Inverse or Inst. V/Hz setting +
0.1 = ______. This will cause the test pickup relay to operate, and the test trip relay will operate after the
appropriate Trip Time has expired. Change the voltage of any one phase until Voltage/Frequency is equal
to: Inverse or Inst. V/Hz setting – 0.1 = ______. The test pickup and test trip relays will not operate.

If this test is repeated, the operate time of the trip contact will change according to how soon
the test is repeated. The trip time can be calculated according to the following equation:

where T = the time between successive tests, Original Trip Time = the 5.0 to 5.5 seconds it
originally took to trip the relay, and RESET is Setting 1409. If the time between successive
trips is greater than the RESET time, the relay will trip in the original trip time.

Actual Volts/Hz
INV PU VNOM⋅

SYSFREQ
--------------------------------------->

Trip Time K
Actual V/Hz INV PU⁄( )N 1–

-------------------------------------------------------------------------    for inverse curves 1, 2 and 3=

                or
Trip Time K   for inverse curve 4=

Actual Volts/Hz
INV PU VNOM⋅

SYSFREQ
--------------------------------------->

Trip Time TL7=

NOTE
New Trip Time T

RESET
-------------------- Original Trip Time×=
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5.3.12 T15: POSITIVE-SEQUENCE OVERVOLTAGE 59

1. Record the following Settings:

59

(1503) PICKUP (Phase-Phase Voltage) =______ V rms
(1504) TIME FAC (Time Factor, K) = ______ sec.

2. Trip time is calculated using the following equation:

K is Setting 1504: TIME FAC, V1 is the positive-sequence voltage applied phase-to-phase, and PICKUP is
Setting 1503: PICKUP. If the value of V1 is greater than PICKUP, the test pickup will operate. If the value of
V1 is greater than PICKUP for a time equal to Trip Time, the test trip relay will operate.

3. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

4. Set up relay in test mode for the 59 function; 59 ON will be displayed on the MMI.

5. Set all current inputs to 0. Apply a signal to all three phases with a positive-sequence phase-phase voltage
equal to PICKUP + 2 =______ V rms. This will cause the test pickup to operate and the test trip will oper-
ate after the Trip Time has expired.

6. Lower the positive-sequence voltage to PICKUP – 2 =______ V rms. This will prevent the test pickup and
the test trip relays from operating.

5.3.13 T16: UNDERFREQUENCY UNIT #1 81-1U

1. Record the following Settings:

81-1U

(1703) SET PNT (Set Point for Min. Frequency)= ______ Hz
(1704) TL8 (Time Delay) = ______ sec.

2. Underfrequency is calculated with the following equation:

Input Frequency < SET PNT

Input Frequency is equal to the frequency in any phase. The unit should pick up when the above equation
is true. The unit should trip TL8 seconds after it has picked up.

3. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

4. Set up relay in test mode for the 81-1U function; 81-1U ON will be displayed on the MMI.

5. Set all current inputs to 0. Set the voltage (rms) inputs to:

VA = 70 V ∠0°
VB = 70 V ∠–120°
VC = 70 V ∠–240°

6. Set the frequency at SET PNT + 0.04 =______ Hz. This will prevent the test pickup and the test trip from
operating. 

7. Change the frequency to SET PNT – 0.04 =______ Hz. This will cause the test pickup relay to operate and
the test trip relay will operate TL8 seconds later.

Trip Time K
V1 PICKUP⁄( ) 1–

-----------------------------------------------=
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5.3.14 T17: OVERFREQUENCY UNIT #1 81-1O

1. Record the following Settings:

81-1O

(2103) SET PNT (Set Point for Maximum Frequency) = ______ Hz
(2104) TL15 (Time Delay) = ______ sec.

2. Overfrequency is calculated with the following equation:

Input Frequency > SET PNT

Input Frequency is equal to the frequency in any phase. The unit should pick up when the equation above
is true. The unit should trip TL15 seconds after it has picked up.

3. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

4. Set up relay in test mode for the 81-1O function; 81-1O      ON will be displayed on the MMI.

5. Set all current inputs to 0. Set the voltage (rms) inputs to: 

VA = 70 V ∠0°
VB = 70 V ∠–120°
VC = 70 V ∠–240°

6. Set the frequency at SET PNT – 0.04 =______. This will prevent the test pickup and the test trip from oper-
ating. 

7. Change the frequency to SET PNT + 0.04 =______. This will cause the test pickup relay to operate and
the test trip relay will operate TL15 seconds later.

5.3.15 T18: VOLTAGE TRANSFORMER FUSE FAILURE VTFF

1. Record the following Settings:

DIG INP

(2501) SELBKDI1 = NO BLK (0)

VTFF

(2601) VTFF = ENABLE (1)

2. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

3. Set up relay in test mode for the VTFF function; VTFF ON will be displayed on the MMI.

4. Set the current (rms) inputs to:

IAS = 0.5A ∠90°
IBS = 0.5A ∠–30°
ICS = 0.5A ∠–150°

Set the voltage (rms) inputs to:

VA = 70V 0°
VB = 70V ∠–120°
VC = 70V ∠–240°

Verify that neither the test pickup nor the test trip operates.

5. Decrease the voltage in all three phases to 49 V rms. Verify that test pickup operates and that test trip
operates in 12.4 to 13.0 seconds.
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5.3.16 T19: TOC GROUND OVERCURRENT 51GN

Skip this test if your model of DGP does not have this function. This function is not available
on DGP***AAA models.

1. Record the following Settings:

51GN

(2803) PICKUP (Ground Current Pickup)= ______A
(2804) TIME FAC (Time Factor, K) = ______ sec.

2. Time Overcurrent is calculated with the following equation:

K is Setting 2804: TIME FAC. Ground Current is the current applied to neutral side (INR), and PICKUP is
Setting 2803: PICKUP. If the value of Ground Current is greater than the PICKUP setting, the test pickup
will operate. If the Ground Current is above the PICKUP setting for a time equal to Trip Time, the test trip
relay will operate.

3. Connect as shown in Figure 4–6: GENERATOR DIFFERENTIAL TEST CONNECTIONS on page 4–18.

4. Set up relay in test mode for the 51GN function; 51GN ON will be displayed on the MMI.

5. Set the current input to PICKUP + 0.1 (0.02) = ______ A rms. 

6. Set the voltage (rms) inputs to:

VA = 70 V ∠0°
VB = 70 V ∠–120°
VC = 70 V∠–240°

The test pickup relay should operate immediately and the test trip relay should operate after the Trip Time
has expired. 

7. Lower the current to PICKUP – 0.1 (0.02) = ______ A rms and the test pickup and test trip relays should
not operate.

5.3.17 T20: POSITIVE-SEQUENCE UNDERVOLTAGE 27

Skip this test if your model of DGP does not have this function. This function is not available
on DGP***AAA models.

1. Record the following Settings:

27

(2903) PICKUP (Phase-Phase Voltage)= ______V rms
(2904) TIME FAC (Time Factor, K) = ______ sec.
(2905) CURVE # (Characteristic curve) = ______ 

2. Trip time for the function is calculated using equation (15):

for CURVE # = 1

for CURVE # = 2

NOTE

Trip Time K
Ground Current PICKUP⁄ 1–

---------------------------------------------------------------------------------=

NOTE

Trip Time K
PICKUP V1⁄( )

-------------------------------------=

Trip Time K
PICKUP V1⁄( )

-------------------------------------=
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K is Setting 2904: TIME FAC. V1 is the positive-sequence voltage applied phase-to-phase, and PICKUP is
Setting 2903: PICKUP. If the value of Phase Voltage is lower than PICKUP, the test pickup will operate. If
the Phase Voltage is lower than PICKUP for a time equal to Trip Time, the test trip relay will operate.

3. Connect relay as shown in Figure 4–8: STANDARD FUNCTIONAL TEST CONNECTIONS on page 4–25.

4. Set up relay in test mode for the 27 function; 27 ON will be displayed on the MMI.

5. Set all current inputs to 0. 

6. Apply a signal to all three phases with a positive-sequence phase-phase voltage equal to PICKUP – 2 =
______. This will cause the test pickup to operate and the test trip will operate after the Trip Time has
expired. 

7. Raise the positive-sequence voltage to PICKUP + 2 = ______. This will prevent the test pickup and the
test trip relays from operating.
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5.4 END OF PERIODIC TESTING 5.4.1 ENDING PERIODIC TESTS

Make sure that the relay is no longer in test mode; select END TEST MODE from the test mode menu.

Print out or scroll through all of the settings. Compare them with the initial Settings of the relay, and change to
initial values.

If the initial settings were saved to a disk file before testing using DGP-Link, download the file to the relay.

When testing is completed, verify that all settings are returned to your specified values. It is
helpful to print out the settings and check them one by one.

CAUTION
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6 SERVICING 6.1 SPARES 6.1.1 DESCRIPTION

There are two possible servicing methods for the DGP system: spare module replacement and component
level repair. The preferred method is module replacement using the DGP’s automatic self-tests to isolate failed
modules. When the defective module is found, it can be replaced with a spare, and the system can be returned
to service. This method typically yields the shortest system down-time. To further reduce down-time, it is rec-
ommended that a complete set of spare modules be kept at the maintenance center.

It is not recommended that the relay be serviced at the component level. This requires a substantial investment
in test/repair equipment and technical expertise, and usually results in longer down-times than module replace-
ment. For those who do wish to trouble-shoot to the component level, drawings can be obtained by requesting
them from the factory. When requesting drawings, the following information must be supplied to the factory:

1. The model number of the module. This is found on the lower part of the front nameplate of each module,
e.g. MGM781

2. The assembly number of the module. This is found on the component side of the printed circuit board. It is
an eight digit number with a letter inserted between the fourth and fifth digit and suffixed with a group iden-
tification, e.g. 0215B8012G001.

3. The revision number. This is found on the printed circuit board adjacent to the assembly number of the
board.

Power down the relay by removing the test plugs or turn OFF the PS1 & PS2 switches before
removing or inserting modules. Failure to do so can permanently damage the relay.

CAUTION
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6.2 RELAY SELF-TESTS 6.2.1 DESCRIPTION

The DGP automatically performs tests of major functions and critical hardware components and reports their
status via the MMI display and the non-critical and critical alarm contacts. The failure report is dependent on
the type or level of the failure. Some failures will operate the critical alarm contact and the status LED, while
others will only operate the non-critical alarm contact.

There are three levels of self-test performed by the relay. The first level indicates severe relaying failures. They
are indicated by a FAIL message on the MMI, a de-energizing of the critical alarm relay, and the status LED
turning red. These failures are the most critical because they indicate that the relay is not providing protection.

The second level of self-test displays warning messages. They are indicated by a WARN message on the
MMI, and energizing of the non-critical alarm relay. These failures are a less critical condition, where the relay
is still providing some degree of protection.

The third level of tests indicate system status errors that are due to power system errors (Trip Circuit Open), or
caused by a DGP command that disables the relay (Disable Outputs). They are indicated by the non-critical
alarm relay being energized, a red LED, or by the critical alarm relay being de-energized. However, no MMI
display is provided until the INFORMATION–STATUS command is used.

The types of self-tests performed are described in Section 1.4: OTHER FEATURES on page 1–18. The com-
ponents tested during the start-up self-tests are listed in the table below. The components tested during run
time background and foreground self-tests are listed in the next two tables, respectively.

Table 6–1: START-UP SELF-TESTS 

COMPONENT METHOD PROCESSOR NATURE

PROM CRC-type check on DAP and SSP; checksum 
on DSP

All Critical

Local RAM Patterns to check for stuck bits, stuck address 
lines, cross-talk between adjacent bits

All Critical

Shared RAM Same as Local RAM All Critical

Non- volatile 
RAM

CRC-type check on settings area; CRC-type 
check on serial NVRAM in DAP; checksum on 
fault storage area

SSP, DAP Critical if settings area 
or Serial NVRAM

Timer Chip Test all processor timers and their interrupts DAP, SSP Critical if DAP,
Non-Critical if SSP

Interrupt Chips Test all processor and external Interrupt 
Controllers

DAP, SSP Critical

Serial Chips Wrap around and Interrupt tests for serial 
interface

SSP Non-Critical

A/D Controller DMA Interface DAP Critical, DGP will restart

Digital Output 
Circuitry

Loop-back via parallel port SSP Critical, DGP will restart

Real Time Clock Test of real time clock Operation and 
Interrupts

SSP Non-Critical

LED display Self-test built in by manufacturer SSP Non-critical
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Table 6–2: RUN-TIME BACKGROUND SELF-TESTS

COMPONENT METHOD PROCESSOR NATURE

PROM CRC-type check on DAP and SSP; 
checksum on DSP

All Critical, Restart

RAM CRC-type check on areas holding 
settings

All Critical, Restart

Non- volatile RAM CRC-type check on settings area; 
checksum on fault storage area

SSP Critical if settings area

Timer Chip Test that all timers are counting DAP, SSP Critical if DAP
Non-Critical if SSP

Power Supply Monitor Supply Health contact output SSP Critical if no backup 
supply

Table 6–3: RUN-TIME FOREGROUND SELF-TESTS

COMPONENT METHOD PROCESSOR NATURE

A/D Controller DMA Interface DAP Critical

Digital Input 
Circuitry

Comparison of bits read via 2 separate 
optocouplers

DAP, SSP Non-Critical

Digital Output 
Circuitry

Loop-back via parallel port SSP Critical, Restart

Trip Voltage 
Monitor

Bit read via parallel port SSP Non-Critical

MMI Operator-initiated, visual feedback SSP Non-Critical

DSP and DAP 
Communication

DSP finished flag DAP Critical

ANI Current Summation Check DSP Critical

ANI Ground and Reference range check DAP Critical

Power Supply Range check +12V, _12V DAP, SSP Critical if no backup 
supply
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6.3 TROUBLESHOOTING 6.3.1 DESCRIPTION

Troubleshooting the relay requires three steps.

1. Determine the type of failure. The type is either a critical, non-critical, or a system-status failure. 

2. Use the list of failure codes, warning codes, or the INFORMATION–STATUS command to determine which
module is defective. 

3. Replace the defective module in accordance with safety and static-discharge precautions.

The troubleshooting sections are as follows:

• Servicing a Critical Failure FAIL

• Servicing a Non-Critical Failure WARN

• Servicing a System Status Failure

Refer to Chapter 4: ACCEPTANCE TESTS for test of the MMI display, keypad, and printer port,
and of the measuring units.

6.3.2 USING THE INFORMATION STATUS COMMAND

Tables 6–6: ERROR MESSAGES AT STARTUP and 6–7: ERROR MESSAGES AT RUNTIME have been pro-
vided as a listing of all the FAIL and WARN messages. They can be used to decode FAIL xxx and WARN xxx
codes. A list of failure and warning codes is provided, but the INFORMATION–STATUS command can be used
to extract the same data from the MMI display. The INFORMATION–STATUS command can be used locally at
the relay site or remotely over a modem link.

The INFORMATION–STATUS command is invoked as follows:

1. Apply rated DC power to the relay and wait for initialization to complete.

2. Press the [INF] key. Then scroll with the arrow keys until the heading INF: STATUS is displayed. If you
have a printer, press the [PRT] key.

3. Press the [ENT] key.

The display will indicate that there is a failure with the words STATUS: FAIL.

4. Press the [↑] key to get a detailed report of the failure. A complete list of the possible errors is shown in the
following tables:

•Table 6–4: SYSTEM STATUS ERROR MESSAGES on page 6–6

•Table 6–5: MISCELLANEOUS MESSAGES on page 6–6

•Table 6–6: ERROR MESSAGES AT STARTUP on page 6–7

The FAIL and WARN messages are also included. Their descriptions can also be displayed on the MMI,
by using the INFORMATION–STATUS command.

After initial power up or loss of power exceeding 24 hours, the time and date will reset to
00:00:00 01/01/90. All event and fault data will be reset

NOTE

NOTE
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6.3.3 SERVICING A CRITICAL FAILURE FAIL

A critical failure indicates total interruption of the protection function. When an extended failure is detected on
one of the modules (excluding the power supply) the critical alarm relay will drop out, and the MMI LED will turn
red. Remove and re-apply the DC power to bring up the FAIL message on the display. If the DGP successfully
restarts, the LED will turn green.

The FAIL message has the format FAIL xxx. The xxx field represents the numeric code indicating the nature of
the critical failure. The FAIL message remains on the display until a key is pressed or until the DGP restarts
successfully (with no self-test failures).

As an alternative, the INFORMATION–STATUS command can be used to display the failure type
directly on the MMI.

A Failure message may appear in the Events or on the display, but not be displayed from INFORMATION–
STATUS. This is the result of a Removable Critical Alarm, REMCRIT, shown in Section 6.4: ERROR CODES.
This is caused by the DGP detecting a critical alarm, then later detecting that the condition has cleared up, and
thus being able to restore protection.

LOCATING THE DEFECTIVE MODULE:

Use Tables 6–6: ERROR MESSAGES AT STARTUP, 6–7: ERROR MESSAGES AT RUNTIME, or the INFOR-
MATION–STATUS command, to isolate the cause of the failure. When the suspected module is found, power
down the unit and replace it. Re-apply power. If the FAIL message is gone, then the unit has been successfully
repaired. If the message has changed, it is possible that another module requires replacement.

6.3.4 SERVICING A NON-CRITICAL FAILURE WARN

A non-critical failure indicates a possible interruption in the relay's protection, but not a total loss. When a
WARN condition occurs, the DGP system's non-critical alarm contact will close. The LED will remain green.
Turn off the DC input power, then re-apply. The WARN xxx message should appear if the failure still exists.

The WARN message has the format WARN xxx. The xxx field represents the numeric code indicating the
nature of the failure. The WARN message remains on the display until a key is pressed or until the DGP
restarts successfully (with no self-test failures). See Table 6–6: ERROR MESSAGES AT STARTUP on page 6–
7 for the list of Warning codes and their meanings.

As an alternative to using the table of warnings, the INFORMATION–STATUS command can be used
to display the warning type directly on the MMI.

A Failure message may appear in the Events or on the display, but not be displayed from "Informa-
tion Status". This is the result of a Removable Non-Critical Alarm, REMNONCRIT in Table 6–7:

ERROR MESSAGES AT RUNTIME on page 6–9. This is caused by the DGP detecting a non-critical alarm,
then later detecting that the condition has cleared up, and thus being able to restore protection.

LOCATING THE DEFECTIVE MODULE:

Use Tables 6–6: ERROR MESSAGES AT STARTUP, 6–7: ERROR MESSAGES AT RUNTIME, or the INFOR-
MATION–STATUS command to isolate the cause of the failure. Power down the unit and replace the sus-
pected module if appropriate. Re-apply power and the WARN message should clear. If the WARN message is
gone, then the unit has been successfully repaired. If the message has changed, it is possible that another
module requires replacement.

NOTE

NOTE
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6.3.5 SERVICING SYSTEM STATUS FAILURES

A system failure is one that indicates a failure of a power system input, or indicates that the relay has been dis-
abled by a user command. They are indicated by the non-critical alarm contacts, by a red LED, or by the critical
alarm contacts. However, no MMI display is provided until the INFORMATION–STATUS command is used.

Turn off then re-apply the DC input power. The non-critical alarm contact (N.O.) will be closed if the failure still
exists. Use the INFORMATION–STATUS to determine the cause of the trouble.

Table 6–4: SYSTEM STATUS ERROR MESSAGES

SYSTEM STATUS ERROR INDICATION DESCRIPTION

WARN NCA WARN condition, press up arrow 

FAIL CA/LED FAIL condition, press up arrow

MISC LED Miscellaneous condition, press up arrow

Note: LED = red LED on the MMI; NCA = energizing the non-critical alarm relay
CA = de-energizing the critical alarm relay.

Table 6–5: MISCELLANEOUS MESSAGES

MISCELLANEOUS MESSAGES DESCRIPTION INDICATION

PROT OFF Protection off LED

DIS OUTS Outputs Disabled LED

RELAY TEST Relay in Test Mode LED

D O TEST Digital Output test LED
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6.4 ERROR CODES 6.4.1 ERROR MESSAGES AT STARTUP

Table 6–6: ERROR MESSAGES AT STARTUP (Sheet 1 of 2)

ERROR 
NUMBER

BOARD ALARM INF STATUS/DISPLAY INF STATUS/PRINT

100 DAP Critical DAP:PROM DAP BOARD:PROM

101 DAP Critical DAP:LOCAL RAM DAP BOARD:LOCAL RAM

103 DAP Critical DAP:DSPRAM DAP BOARD:DSPRAM

104 DAP Critical DAP:SYSRAM DAP BOARD:SYSRAM

105 DAP Critical DAP:INTERRUPT DAP BOARD:INTERUPT

106 DAP Critical DAP:TIMER DAP BOARD:TIMER

124 DAP Critical DAP:VERSION NUM DAP BOARD:VERSION NUMBER

207 DSP Critical DSP1:PROM DSP BOARD1:PROM

208 DSP Critical DSP1:LOCAL RAM DSP BOARD1:LOCAL RAM

209 DSP Critical DSP1:DSPRAM DSP BOARD1:DSPRAM

210 DAP Remcrit DAP:NO DSP 1 RSP DAP BOARD:NO DSP 1 RESPONSE

225 DSP Critical DSP1:VERSION NUM DSP BOARD:DSP1 VERSION NUMBER

226 DSP Critical DSP2:PROM DSP BOARD:DSP2 PROM

227 DSP Critical DSP2:LOCAL RAM DSP BOARD:DSP2 LOCAL RAM

228 DSP Critical DSP2:DSPRAM DSP BOARD:DSP2 DSPRAM

229 DAP Remcrit DAP:NO DSP 2 RSP DAP BOARD:NO DSP 2 RESPONSE

230 DSP Critical DSP2:VERSION NUM DSP BOARD:DSP2 VERSION NUMBER

231 DSP Critical DSP3:PROM DSP BOARD:DSP3 PROM

232 DSP Critical DSP3:LOCAL RAM DSP BOARD:DSP3 LOCAL RAM

233 DSP Critical DSP3:DSPRAM DSP BOARD:DSP3 DSPRAM

234 DAP Remcrit DAP:NO DSP 3 RSP DAP BOARD:NO DSP 3 RESPONSE

235 DSP Critical DSP3:VERSION NUM DSP BOARD:DSP3 VERSION NUMBER

311 ANI Critical ANI:CONTROLLER ANI BOARD:CONTROLLER

312 ANI Critical ANI:SERIAL MEMRY ANI BOARD:SERIAL MEMORY

336 ANI Critical ANI:GROUND ANI BOARD:GROUND FAILURE

414 MGM Critical MGM1:SERIAL MEM MGM BOARD1:SERIAL MEMORY

422 MGM Critical MGM1:MODEL NUM MGM BOARD1:MODEL NUMBER

449 MGM Critical MGM2:SERIAL MEM MGM BOARD2:SERIAL MEMORY
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450 MGM Critical MGM2:MODEL NUM MGM BOARD2:MODEL NUMBER

515 SSP Critical SSP:PROM SSP BOARD:PROM

516 SSP Critical SSP:LOCAL RAM SSP BOARD:LOCAL RAM

518 SSP Critical SSP:SYSRAM SSP BOARD:SYSRAM

519 SSP Critical SSP:INTERRUPT SSP BOARD:INTERRUPT

520 SSP Remcrit SSP:EEPROM SSP BOARD:EEPROM

523 SSP Critical SSP:VERSION NUM SSP BOARD:VERSION NUMBER

553 SSP Critical SSP: SET RANGE SSP BOARD SETTING RANGE

556 SSP Noncrit SSP:TIMER SSP BOARD:TIMER

557 SSP Noncrit SSP:CAPRAM SSP BOARD:CAPRAM

558 SSP Noncrit SSP:CLOCK SSP BOARD:REAL TIME CLOCK

621 MMI Critical MMI:DIG OUT MMI BOARD:DIGITAL OUTPUT

655 MMI Noncrit MMI:SERIAL CHP 1 MMI BOARD:SERIAL CHIP #1

659 MMI Noncrit MMI:LED DISPLAY MMI BOARD:LED DISPLAY

663 MMI Noncrit MMI:SERIAL CHP 2 MMI BOARD:SERIAL CHIP #2

664 MMI Noncrit MMI:SERIAL CHP 3 MMI BOARD:SERIAL CHIP #3

Table 6–6: ERROR MESSAGES AT STARTUP (Sheet 2 of 2)

ERROR 
NUMBER

BOARD ALARM INF STATUS/DISPLAY INF STATUS/PRINT
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6.4.2 ERROR MESSAGES AT RUNTIME

Table 6–7: ERROR MESSAGES AT RUNTIME (Sheet 1 of 2)

ERROR 
NUMBER

BOARD ALARM INF STATUS/DISPLAY INF STATUS/PRINT

60 MISC Noncrit LOGON FAILURE LOGON FAILURE

71 MISC Noncrit CASE GND SHORTED CASE TO GND SHORTED

100 DAP Crit+Wdreset DAP:PROM DAP BOARD:PROM

102 DAP Crit+Wdreset DAP:DSPRAM DAP BOARD:DSPRAM

106 DAP Crit+Wdreset DAP:TIMER DAP BOARD:TIMER

207 DSP Remcrit DSP1:PROM DSP BOARD1:PROM

209 DSP Remcrit DSP1:DSPRAM DSP BOARD1:DSPRAM

210 DAP Remcrit DAP:NO DSP 1 RSP DAP BOARD:NO DSP 1 RESPONSE

226 DSP Remcrit DSP2:PROM DSP BOARD2:PROM

228 DSP Remcrit DSP2:DSPRAM DSP BOARD2:DSPRAM

229 DAP Remcrit DAP:NO DSP 2 RSP DAP BOARD:NO DSP 2 RESPONSE

231 DSP Remcrit DSP3:PROM DSP BOARD3:PROM

233 DSP Remcrit DSP3:DSPRAM DSP BOARD3:DSPRAM

234 DAP Remcrit DAP:NO DSP 3 RSP DAP BOARD:NO DSP 3 RESPONSE

246 DSP Remcrit DSP1:SET CHKSUM DSP BOARD1:SETTING VERSION

247 DSP Remcrit DSP2:SET CHKSUM DSP BOARD2:SETTING VERSION

248 DSP Remcrit DSP3:SET CHKSUM DSP BOARD3:SETTING VERSION

313 ANI Remcrit ANI:REFERENCE ANI BOARD:REFERENCE

336 ANI Remcrit ANI:GROUND ANI BOARD:GROUND FAILURE

351 ANI Remcrit ANI:CURRENT SUM ANI BOARD:CURRENT SUM FAILURE

352 ANI Crit+Wdreset ANI:CHAN SATURAT ANI BOARD:CHANNEL SATURATED

373 ANI Remnoncrit                   _ ANI BOARD: SAMPLE CORRECTED

515 SSP Crit+Wdreset SSP:PROM SSP BOARD:PROM

517 SSP Crit+Wdreset SSP:SYSRAM CRC SSP BOARD:SYSRAM CRC

520 SSP Noncrit SSP:EEPROM SSP BOARD:EEPROM

556 SSP Noncrit SSP:TIMER SSP BOARD:TIMER

557 SSP Noncrit SSP:CAPRAM SSP BOARD:CAPRAM

621 MMI Crit+Wdreset MMI:DIG OUT MMI BOARD:DIGITAL OUTPUT

737 PS Remcrit PS1 + 2: SELFTEST POWER SUPPLY 1 & 2: FAILURE SELFTEST
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738 PS Remcrit PS1+2:+12V BAD POWER SUPPLY 1 AND 2:(FAIL) +12V BAD

739 PS Remcrit PS1+2:_12V BAD POWER SUPPLY 1 AND 2:(FAIL) _12V BAD

740 PS Remcrit PS1 + 2: SELFTEST POWER SUPPLY 1 & 2: FAILURE SELFTEST

741 PS Remcrit PS1+2:+12V BAD POWER SUPPLY 1 AND 2:(FAIL) +12V BAD

742 PS Remcrit PS1+2:_12V BAD POWER SUPPLY 1 AND 2:(FAIL) _12V BAD

743 PS Remcrit PS:SELFTEST POWER SUPPLY:(FAILURE) SELFTEST

744 PS Remcrit PS:+12V BAD POWER SUPPLY:(FAILURE) +12V BAD

745 PS Remcrit PS:_12V BAD POWER SUPPLY:(FAILURE) _12V BAD

765 PS Remnoncrit PS1:SELFTEST POWER SUPPLY 1:(WARNING SELFTEST)

766 PS Remnoncrit PS1:+12V BAD POWER SUPPLY 1:(WARNING) +12V BAD

767 PS Remnoncrit PS1:_12V BAD POWER SUPPLY 1:(WARNING) _12V BAD

768 PS Remnoncrit PS2:SELFTEST POWER SUPPLY 2:(WARNING SELFTEST)

769 PS Remnoncrit PS2:+12V BAD POWER SUPPLY 2:(WARNING) +12V BAD

770 PS Remnoncrit PS2:_12V BAD POWER SUPPLY 2:(WARNING) _12V BAD

972 DIT Noncrit DIT:DIG INP DIT BOARD:DIGITAL INPUT

Table 6–7: ERROR MESSAGES AT RUNTIME (Sheet 2 of 2)

ERROR 
NUMBER

BOARD ALARM INF STATUS/DISPLAY INF STATUS/PRINT
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7 SPECIFICATIONS 7.1 DGP SPECIFICATIONS 7.1.1 DESCRIPTION

ELECTRICAL RATINGS
Nominal Frequency: 50 to 60 Hz
Nominal Voltage: 140 V AC (phase-to-phase)
Rated Current In: 1 A or 5 A
DC Control Voltage, operating range:

48 V DC 38.5 to 60 V DC
110/125 V DC 88 to 150 V DC
220/250 V DC 176 to 300 V DC

Maximum Permissible AC voltage:
Continuous 2 x rated
1 minute (one per hr.)3.5 x rated

Maximum Permissible current:
Continuous 2 x In
3 seconds 50 x In
1 second 100 x In

Insulation Test Voltage:2 kV @ 50/60 Hz, one minute
2.8 kV DC, one minute

Impulse Voltage Withstand Fast Transient:
5 kV peak, 1.2/50 µs, 0.5 J

Radio Frequency Interference Withstand:
SWC, per ANSI C37.90.1

Vibration Test Withstand:IEC 255-21-1
Humidity: 95% without condensation
Ambient Temperature Range

Storage: –30°C to 70°C
Operation: –20°C to 55°C

BURDEN RATINGS
Current Circuit: In = 1 A: 0.12 Ω, 30°

In = 5 A: 0.022 Ω,5°
Voltage Circuit: 0.30 VA @ 60 Hz

0.40 VA @ 50 Hz
DC Battery

(contact converters):1.0 mA at 48 V DC
1.5 mA at 125 V DC
2.5 mA at 250 V DC

(power supply): 19 W with one supply
25 W with two supplies

INTERFACE DATA
System Interface: RS232 port – rear panel

RS232 port – front panel
Printer interface (serial) optional
IRIG-B (demodulated) optional

The printer interface and IRIG-B are optional functions.

CONTACT DATA
Trip Outputs: Four Programmable Relays with two 

Form A contacts each.
Continuous Rating: 3 A
Make and Carry: 30 A (per ANSI C 37.90)
Break 60 VA inductive, max. 250 V or 0.5 A
Leakage Current: 2.36 mA (average)

Alarm Outputs: Four Programmable Relays with 
one Form C contact each.
One critical self-test alarm
One non-critical self-test alarm
One VT Fuse Failure alarm
One power supply alarm per power

supply
Auxiliary Contacts (including Alarms):

Continuous Rating: 3 A
Make and Carry: 5 A for 30 seconds
Break 60 VA inductive, max. 250 V or 0.5 A

Trip Circuit Monitor Sensitivity:
150 mA

Trip Voltage Monitor: 30 to 300 V DC
Digital Inputs: 30 to 300 V DC

1 to 3 mA

ACCURACY
RMS measurements: ±3% of reading
Phase Angle measurements:

±1°
Frequency measurements:

±0.01 Hz
Timers: ±3% of setting or 10 to 40 ms, 

whichever is greater
Data Sample Time Tag Resolution:

±1 msec.

DIMENSIONS AND WEIGHT
Height: 14 inches, 352 mm

standard 8-rack unit
Width: 19.0 inches, 484 mm

standard 19-inch rack
Depth: 14 inches, 356 mm
Weight: 51 pounds, 23 kg

SPECIFICATONS ARE SUBJECT TO CHANGE WITHOUT NOTICE
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7.1.2 PROTECTION FUNCTIONS AND SETTING RANGES

FUNCTION SETTING RANGE STEP
5 A 1 A

Differential (87G) Differential Current Pickup 0.20 to 1.00 A 0.04 to 0.20 A 0.01

Current Unbalance (46) Negative Sequence Current 0.05 to 2.99 A 0.01 to 0.60 A 0.01

Machine Constant - K2 1.0 to 45.0 0.1

Loss of Excitation (40)
(Two Independent Zones)

Zone 1 & Zone 2 Center 2.5 to 60 Ω 12.5 to 300 Ω 0.01

Zone 1 & Zone 2 Radius 2.5 to 60 Ω 12.5 to 300 Ω 0.01

Zone 1 & Zone 2 Timer 0.01 to 9.99 sec. 0.01

Anti-Motoring (32)
(Two Independent Steps) !

Reverse Power 0.5 to 99.9 W 0.1 to 19.9 W 0.1

Time Delay (step 1) 1 to 120 sec. 1

Time Delay (step 2) ! 1 to 60 sec. 1

Stator Ground (64G1)
(Fundamental frequency)

Zone 1 Neutral OV Pickup 4.0 to 40.0 V 0.1

Zone 1 Timer 0.1 to 9.9 sec. 0.1

Stator Ground (64G2)
(3rd Harmonic comparator) !

Zone 2 Timer 0.1 to 9.9 sec. 0.1

Stator Ground (27TN)
(Third Harmonic UV)

Voltage Pickup 0.1 to 9.9 V 0.1

Time Delay 0.5 to 99.9 sec. 0.1

Forward Power Limit - Low 0 to 999 W 0 to 200 W 1

Forward Power Limit - High 0 to 999 W 0 to 200 W 1

Overexcitation (24) V/Hz Pickup (Inverse) 1.00 to 1.99 per unit 0.01

Time Factor (Inverse) 0.10 to 99.99 sec. 0.01

V/Hz Pickup (Instantaneous) 1.00 to 1.99 per unit 0.01

Timer (Instantaneous) 0 to 9.9 sec. 0.1

Rate of Reset Timer 0 to 999 sec. 1

Overvoltage (59) Voltage Pickup (Inverse) 100 to 200 V # 1

Time Factor 0.10 to 99.99 sec. 0.01

Voltage Pickup (Instantaneous) ! 100 to 300 V # 1

Over/Underfrequency (81)
(2 or 4  Independent Steps) !

Set Point (Under) 40.00 to 65.00 Hz 0.1

Set Point (Over) 45.00 to 79.99 Hz 0.1

Timer (Each Step) 0.05 to 99.99 sec. " 0.01

System Backup
(51V)

Phase Time OC Pickup 0.5 to 16 A 0.1 to 3.2 A 0.1

Time Factor 0.10 to 99.99 sec 0.01

Ground Overcurrent
(51GN) !

Ground Time OC Pickup 0.10 to 5.00 A 0.02 to 1.00 A 0.01

Time Factor 0.1 to 99.99 sec. 0.01

Undervoltage (27) ! Voltage Pickup 40 to 120 volt # 1

Time Factor 0.10 to 99.99 sec. 0.01

! Indicates an optional function. Refer to the DGP selection guide for available functions in a specific model.
" Timer range for Under Frequency Step 1 is 0.1 to 999.9 sec.
# Wider range available in DGP***ACA models; refer to Table 2–1 for detail.
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8 INTERFACE 8.1 DISPLAY 8.1.1 DESCRIPTION

The display consists of 16 LED alphanumeric character positions arranged side-by-side horizontally. There are
also 19 Target LEDs and 1 Status LED.

All messages on the display are the result of some keypad action, with four exceptions: 

• the Trip message when the DGP has caused a protective trip,

• the Fail message when the DGP has discovered a critical self-test failure, 

• the Warning message when the DGP has discovered a non-critical self-test failure, 

• the Initialization message when the DGP is initializing during a power up.

All messages other than the Trip message are displayed at the same intensity, about half of full-intensity. User
input for setting changes is echoed at a lower intensity to help distinguish the stored setting value from one that
has not yet been entered into the DGP system.

The Trip message is displayed at highest intensity and has the following format: TRIP xxx xxx. The word TRIP
blinks to indicate that the DGP system has caused a protective trip. The two fields of information following the
word TRIP are non-blinking and contain the following information: a three-character fault type (e.g. ABC) and a
three-character trip type (see Section 8.3.10: INFORMATION KEY [INF] on page 8–12 for a list of the trip
types). The message will remain on the display permanently until removed by a keyboard operation. If the DGP
restarts or is powered down and up, the trip indicator is remembered and redisplayed. As soon as any key is
pressed, the Trip message is removed and no longer remembered.

The Fail message has the format FAIL xxx. The field following the word FAIL is a numeric code that indicates
the nature of the critical self-test failure. The Fail message remains on the display until a key is pressed or until
the DGP system restarts successfully (with no self-test failures). A list of the failure numbers and their mean-
ings can be found in Section 6.4: ERROR CODES on page 6–7.

The Warning message has the format WARN xxx. The field following the word WARN is a numeric code that
indicates the nature of the non-critical self-test failure. The Warning message remains on the display until the a
key is pressed or until the DGP system restarts successfully (with no self-test failures). A list of the warning
numbers and their meanings can be found in Section 6.4: ERROR CODES on page 6–7.

The Initialization message has the format INITIALIZING and is displayed while the DGP system is initializing
itself during a power-up sequence. The display is blanked as soon as initialization is complete.

All other messages that are the result of keypad operations remain on the display until another key is pressed,
or until no keys have been pressed for a period of 15 minutes. At the end of this time-out interval, the display is
blanked. The time-out interval is set to 10 seconds when the [END] and [ENT] keys are pressed successively;
at the end of this time-out interval, the display is blanked. Time-out also causes the MMI access privilege to be
set at View Level.
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8.2 TARGET LEDs & TARGET RESET KEY 8.2.1 TARGET LEDs

There are 18 LEDs that indicate all of the protection functions that operated during a fault. The Target LEDs
display the information for the TRIP message that is currently on the display.

Figure 8–1: TARGET LEDS

8.2.2 TARGET RESET KEY

The Target Reset Key is the [CLR] key on the keypad. Operation of the [CLR] key is explained in the section
below.
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8.3 KEYPAD 8.3.1 DESCRIPTION

The MMI keypad is an interface method on the DGP system. The keypad is comprised of twenty keys. See the
figure below for details on keypad layout.

Figure 8–2: MMI KEYPAD

8.3.2 CLEAR KEY [CLR]

The [CLR] key is used to abort a keyboard sequence in progress (for example, when the user needs to correct
an error). When the [CLR] key is pressed, all or part of the display is blanked. If there is user-entered informa-
tion on the display, only that information will be blanked. For example, if the user is entering a Setting value
when the [CLR] key is pressed, only the user's input will be blanked; the name of the setting remains on the
display. As another example, if the user is responding to an Action prompt, only the user's input will be blanked;
the prompt question remains on the display. If there is no user-entered information on the display, the entire
display is blanked and the DGP expects a command key to be pressed.

If a Trip, Fail, or Warn message is being displayed, the user must press the [CLR] key to blank the error mes-
sage (all other keys will be ignored). When the error message is blanked, the last message will be displayed,
allowing the user to re-enter the correct response.

Fault data is displayed by pressing the [CLR] key while a TRIP message is displayed. Only target information
(TRIP messages) and the time of the trips for the accumulated faults are displayed. Pressing [CLR] while the
current TRIP message is displayed shows its time of occurrence. Pressing [CLR] again shows the date. Press-
ing [CLR] one more time shows target information for the previous fault. This continues until all the accumu-
lated fault information is displayed. At this point the display becomes blank. TRIP messages for the recorded
faults are displayed in normal intensity and non-blinking; the latest TRIP message is displayed blinking with
high intensity. The target LEDs display the protection functions that operated for the current TRIP message.

Present values scrolling is activated by pressing the [CLR] key when the display is blank (items displayed are
described later under [INF] command key processing). Each item is displayed four seconds before proceeding
to the next item. After scrolling through all of the items, the display is blanked.

Both the fault data display and the present value display are stopped by a TRIP or a keypress.



8-4 DGP Digital Generator Protection System GE Multilin

8.3 KEYPAD 8 INTERFACE

8

8.3.3 PRINT KEY [PRT]

Printer output is not active in some DGP models (see the model selection guide).

For applicable DGP models, the [PRT] key is used to direct information to the printer instead of to the display.
When information is sent to the display, only one item at a time is displayed. When information is sent to the
printer, all items within a category (or, in the case of settings, all settings) are printed. When the [PRT] key is
pressed, the characters PRT are displayed.

8.3.4 ARROW KEYS

The arrow keys are used to scroll through the list of categories within a Command ([SET], [INF], [ACT]) key or
to scroll through the list of items within a category. For example, pressing the [INF] key displays the name of
the first category (e.g., STATUS). Pressing the [↑] key next displays the name of the second category (e.g.,
FAULT). When the desired category is reached, pressing the [ENT] key displays the first item of that category.
From that point on, pressing the [↑] key will display each subsequent item in the category.

While the [↑] key scrolls in a forward direction through a list of categories or items, the [↓] key scrolls backward
through a list. That is, the user may return to the previously displayed item by pressing the [↓] key.

If the user is scrolling through items within a category and wants to exit that category, pressing a command key
([SET], [INF], [ACT]) will display the current category name. The arrow keys can then be used to scroll through
the categories.

8.3.5 ENTER KEY [ENT]

The [ENT] key is used to enter data or a choice. It is also used in conjunction with the [END] key to confirm a
setting change to be stored into non-volatile memory (see the [END] key description below). 

8.3.6 DATA ENTRY KEYS

The data entry keys consist of the numeric keys and the decimal point. These keys are used to enter data into
the DGP or to make choices in response to prompts. The numeric keys [1/Y] and [3/N] have two meanings:

• If entering numeric values, the [1/Y] and [3/N] keys are processed and displayed as 1 and 3.

• If responding to a YES/NO prompt, the [1/Y] key is processed and displayed as YES and the [3/N] key is
processed and displayed as NO.

NOTE
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8.3.7 END KEY [END]

The [END] key causes two actions:

• It is used to indicate that no more setting changes will be made.

• It is used to end a session. That is, when the user presses the [END] key, the MMI becomes idle (without
the 15 minute time-out) and remote communication actions and settings are enabled if previously locked
by the MMI.

The key sequence for indicating the end of setting changes and/or the end of a session is:   [END] [ENT]

When the user presses the [END] key, the display shows HIT ENT TO END. When the user follows with the
[ENT] key, the display shows ENDED.

1. If no setting values have been entered, the DGP takes no action in response to the [END]/[ENT] key
sequence other than to enable action items locked previously by the MMI, to allow action commands from
remote communications to be executed.

2. If the Digital Output Test was activated from the MMI, the [END]/[ENT] key sequence will deactivate the
test and turn protection on. This will also set the MMI Privilege Level to View Level.

3. If settings are changed, the [END]/[ENT] key sequence causes the DGP to re-initialize itself with the new
settings and the event SETTING CHANGE DONE is logged in the sequence of events. The DGP then
checks whether or not outputs have been disabled by the user. If outputs have been disabled, the status
LED remains red; if outputs are enabled, and there are no critical self-test failures, the LED turns green.
The DGP protection software re-initializes itself to use the new setting values. The displayed message
changes to ENDED. The MMI unlocks the settings lock to allow remote communication to display and
change settings from the DGP system.

The ENDED message is blanked from the display when another key is pressed or after a 10 second delay.
In the latter case, the display remains blank until another key is pressed.

8.3.8 SETTINGS KEY [SET]

The [SET] key is used to display or change settings. See Table 2–1: DGP SYSTEM SETTINGS & RATINGS on
page 2–3 for a complete list of settings. The figure below shows the [SET] key menu structure.

The user may scroll through all the settings in a category using the arrow keys. Press the [SET] key will cause
the current category name to be displayed. The user may go to another category by using an arrow key or
enter a setting number, followed by the [ENT] key, to go to another setting.

To change a setting, the setting must first be displayed as shown above. The data entry keys are then used to
enter a new value. When the first data entry key is pressed, the abbreviated name remains on the display but
the value is blanked and a blinking colon (:) appears in place of the equals sign (=). Each data entry key is dis-
played as it is pressed, in a lower intensity, and the colon (:) continues to blink. There are some settings that
logically represent a state rather than a number (i.e., YES/NO). For these settings, the [1/Y] and [3/N] keys are
used to indicate the state ([1/Y] = YES and [3/N] = NO) and the words YES or NO are displayed. After the last
digit is entered and the [ENT] key pressed, the blinking colon (:) is replaced by an equals sign (=), the value is
displayed at normal intensity, and the DGP stores the new value. If the [PRT] key, [CLR] key, arrow keys, or
any command key is pressed instead of [ENT], the new value is not stored and the old value retained.

It is important to note that as soon as any value is entered, the DGP system does not stop
its protection activities. Settings are stored in a temporary buffer until the user presses the
[END] [ENT] key sequence. This causes a transfer of settings from the buffer to EEPROM
and re-initialization of protection. If the [END] [ENT] sequence is not performed and the
DGP is allowed to time out, all of the settings in temporary storage will be lost.

NOTE



8-6 DGP Digital Generator Protection System GE Multilin

8.3 KEYPAD 8 INTERFACE

8

Figure 8–3: [SET] KEY MENU STRUCTURE

SET
(Settings)

CONFIG

24T

24A

64G2

64G1

51V

32-2

32-1

40-2

40-1

40

46T

87G

46A

AE

VTFF

DIG. INP.

81-1O
81-2O
81-3O
81-4O

81-1U
81-2U
81-3U
81-4U

59

51GN

27TN *

27

UNIT ID
SYS FREQ
SEL TVM
PRI/SEC

CT RATIO
VT RATIO

COMMPORT
PHASE SEQ
TIME SYNC
NUM FLTS
PRE FLTS
OSC TRIG
NOM VOLT
RATEDCUR
VT CONN

NCT RATIO

* DGP****CA and DGP****BA-0005 models only

NOTE: These menu items require the Setting
password to make changes.
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8.3.9 ACTIONS KEY [ACT]

The [ACT] key is used to perform actions. The action categories can be scrolled through using the arrow keys.
The 11 possible actions are listed below. The names of the actions displayed are in parentheses. For conve-
nience, each category has also been assigned a number so that the action can be accessed directly. The key
sequence for selecting an actions is: [ACT] n [ENT], where n is the action category shown below:

Note that n is optional; if omitted, action category 1 is assumed. When the user presses the [ENT] key following
the displayed action category name, the first item or prompt in that category is displayed. If the category con-
tains a list of items, the user may scroll through the items with the arrow keys. Figure 8–4: [ACT] KEY MENU
STRUCTURE on page 8–11 shows the menu structure of the [ACT] key.

1. DISABLE OUTPUTS

This category is used to inhibit the DGP from energizing any of the Digital Output channels. This includes the
four Trip outputs, the four Alarm outputs, and the VTFF output. After the [ENT] key is pressed, the display
prompts with the message DIS OUTPUTS?. The user presses the [3/N] key for NO or [1/Y] for YES followed
by the [ENT] key. If the user responds NO, the message CANCELLED is displayed and no DGP action occurs.
If the user responds YES, the action is performed and the message OUTPUTS DISABLED is displayed, the
status LED turns red, and the event LOCAL - DISABLE OUTPUTS is logged in the sequence of events.

2. ENABLE OUTPUTS

This category permits the DGP to energize all the Digital Output channels. After the [ENT] key is pressed, the
display prompts with the message EN OUTPUTS?. The user presses [3/N] for NO or [1/Y] for YES followed by
the [ENT] key. If the user responds with NO, the message CANCELLED is displayed and no DGP action
occurs. If the user responds with YES, the action is performed, the message OUTPUTS ENABLED is dis-
played, the status LED turns green, and the event LOCAL - ENABLE OUTPUTS is logged.

n = 1: Disable Outputs (DISABLE)

2: Enable Outputs (ENABLE)

3: Trip (TRIP)

4: Reset (RESET)

5: Enter Date and Time (DATE/TIME)

6: Relay Test (RELAY TEST)

7: MMI Test (MMI TEST)

8: Fix Up Settings CRC (COMPUTE CRC)

9: Enter Password (ENTER PASSWORD)

10: Change Password (CHANGE PASSWORD)

11: Digital Output Test (DIG OUTPUT TEST)
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3. TRIP

This category is used to manually operate any one of the four trip output relays.

When the [ENT] key is pressed, the display prompts with the message WHICH RLY?. The number of the
desired Trip output is entered and the [ENT] key pressed. The number for each Trip contact is shown in the fol-
lowing table:

The display then prompts with the message TRIP xxxx? (where xxxx is the name of the Trip Contact). The
user presses [3/N] for NO or [1/Y] for YES followed by the [ENT] key. If the user responds NO, the message
CANCELLED is displayed and no DGP action occurs. If the user responds YES, then the action is performed,
the message xxxx TRIPPED appears on the display, and the event LOCAL - MANUAL TRIP is logged.

4. RESET

This category is used to delete various pieces of information stored in the DGP memory. The following informa-
tion can be cleared.

FAULT REPORTS

SEQUENCE OF EVENTS

When the [ENT] key is pressed, the DGP prompts with the message RST WHAT?. The user enters 0 to delete
FAULT REPORTS or 1 to delete SEQUENCE OF EVENTS followed by the [ENT] key. The display then
prompts with RST FLT RPT? or RST SOE?. The user presses [3/N] for NO or [1/Y] for YES followed by the
[ENT] key. If the user responds NO, the message CANCELLED is displayed and no DGP action occurs. If the
user responds YES, the action is performed and the message FLT RPT RESET or SOE RESET is displayed.

5. DATE/TIME

This category is used to display or change the current date and/or time stored in the DGP. When the [ENT] key
is pressed, the display shows DATE: mm/dd/yy. To change the date, enter 6 digits from the numeric keypad
corresponding to mm/dd/yy an press the [ENT] key. If the user presses any key other than [ENT], or the digits
do not comprise a valid date, the old date is retained and an error message appears.

After initial power up or loss of power exceeding 24 hours, the time and date will reset to
00:00:00 01/01/90. All event and fault data will be reset.

If the [↑] key is pressed after viewing or changing the date, TIME: hh:mm:ss is displayed. To change the time,
enter 6 digits followed by the [ENT] key. If the user presses any key other than [ENT], or the digits entered do
not comprise a valid time, the old time is retained and an error message displayed.

Input # Trip Contact

0 94G

1 94G1

2 94G2

3 94G3

NOTE
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6. RELAY TEST

This category tests the relay functions of the DGP system. If the [ENT] key is pressed and the DGP is already
in Test Mode, the current Test Mode selection is displayed. When not in Test Mode, the first item, END TEST
MODE, is displayed. The user may then select or cancel a test by using the [↑] and [↓] keys followed by the
[ENT] key. The displayed test is selected for execution by pressing the [ENT] key. When the test is selected,
the word ON will be displayed and the pickup of the selected function will result in the output of the DOR12
contact. The trip of the selected function will result in the output of the DOR13 contact. The user will be able to
monitor only one function at a time. That is, if a user selects a function to monitor, any previously selected func-
tion will no longer be monitored. Each test function may be selected by scrolling through the menu or entering
the test number and pressing [ENT].

To remove the DGP from test mode, the user can either press the arrow keys until END TEST MODE is dis-
played, then press the [ENT] key, or press the [1/Y] key followed by the [ENT] key twice. In either case, the cur-
rently selected function will stop being monitored.

7. MMI TEST

This selection is used to test the display, keyboard, status LED, target LEDs, and printer. If the [ENT] key is
pressed, the entire left 8-character display is lit, enabling the user to verify that all the LED segments are work-
ing. The right 8-character display prompts with NEXT?. If the user presses [3/N] followed by [ENT], the next
test (testing the right 8-character display) is skipped. If the user presses [1/Y] followed by [ENT], the right 8-
character display is lit, enabling the user to verify that all the LED segments are working.

The left 8-character display then prompts with LED TST?. If the user presses [3/N] followed by [ENT], the LED
test is skipped. If the user presses [1/Y] followed by [ENT], the LEDs will be tested. If the green LED is on, it will
be extinguished and the red LED lit. If the red LED is lit, it will be extinguished and the green LED lit. The target
LEDs will flash on/off 4 times and then each will be lit individually. When the test is over, the Target LEDs will be
returned to their original state.

The display then prompts with KEYBRD TEST?. If the user presses [3/N] followed by [ENT], the keyboard test
is skipped. If the user presses [1/Y] followed by [ENT], the keyboard test is initiated. First the display is blanked
and the user is expected to press keys on the keyboard. The key mnemonics are echoed on the display, verify-
ing that each key is being sensed correctly. The [CLR] key terminates the keyboard test.

When the keyboard test is complete (or the user has skipped the keyboard test), the display prompts with
PRINTER TEST?. If the user presses [3/N] followed by [ENT], the printer test is skipped and the MMI test ter-
minated. If the user presses [1/Y] followed by [ENT], the printer is tested for the applicable DGP models. Pat-
terns containing all printable characters would are printed in all possible columns.

8. FIX UP SETTINGS CRC

This category recalculates the CRC (cyclic redundancy check) of the settings in non-volatile memory. This cat-
egory is used after the DGP has reported an EEPROM failure, indicating that the stored settings do not match
their CRC code. When using this command, it is imperative that the user EXAMINE EVERY SETTING IN
THE DGP SYSTEM to assure that each setting is still correct, before performing the [END]/[ENT] key
sequence to resume Protection.

After the [ENT] key is pressed, the display prompts with the message RECALC CRC?. If the user presses the
[3/N] key, the message CANCELLED is displayed and no action is taken. If the user presses the [1/Y] key, two
checks are performed: 1) privilege level must be Setting or Control level, and 2) Communication must not be in
the process of changing settings. If the checks fail, an error message is displayed and the action is not per-
formed. If the checks pass, then the Setting's CRC code is recalculated, the message CHECK SETTINGS is
displayed, and the LOCAL – SETTINGS CHANGE DONE event is logged in the sequence of events.

Once the Setting's CRC code has been calculated and EVERY DGP SETTING HAS BEEN EXAMINED, the
[END] [ENT] key sequence is entered to resume Protection.
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9. ENTER PASSWORD

This category is used to enter the MMI password that activates one of the two areas of input:

• The first area of input allows the user to change settings (Settings Level). 

• The second area of input allows the user to access control actions (Control Level). 

The privilege level reverts back to View Level when the MMI becomes idle, either by using the [END] key or if
the MMI times out (15 minutes). When the privilege level is View, values can be viewed but not changed.

After the [ENT] key is pressed, the display prompts the user with the message ENTER PASSWORD. The user
responds by pressing the digit keys representing the password. The digits are echoed with an asterisk (*). The
user then presses the [ENT] key, which displays SELECTED if the password was valid or REQUEST INVALID
if it was not. MMI privilege is set to the level associated with the selected password.

10. CHANGE PASSWORD

This category is used to change the password currently in effect. A password becomes effective through selec-
tion of Enter Password in this category.

After the [ENT] key is pressed, the display prompts with the message NEW PASSWORD. The user presses
digit keys that represent the new password. For security, the digits are echoed with an asterisk (*). The user
then presses the [ENT] key and is prompted with the message REPEAT. The new password must be entered
again followed by the [ENT] key. If the two entered passwords are the same, then the message CHANGED is
displayed. If they are not the same, then NOT CHANGED is displayed and the old password remains selected.

11. DIGITAL OUTPUT TEST

This category is used to test digital outputs of the DGP system.

After the [ENT] key is pressed, the display will show the first menu item, END TEST MODE. The user may then
select a test from the menu by using the arrow keys followed by the [ENT] key.

At this point the privilege level must be Control level. If the privilege level is wrong, then an
error message is displayed and the test is not performed.

If outputs are enabled, the user must specify if they want to disable protection. The message DISABLE
PROT? is displayed. The user presses [1/Y] for YES or [3/N] for NO followed by [ENT]. If the user indicates
NO, then the message CANCELLED is displayed and test selection is stopped. If user indicated YES, then the
test name will be redisplayed. The word ON will also be shown in the rightmost two characters of the display
and the test is performed.

To stop the digital output test and re-enable protection, the press the arrow keys until END TEST MODE is dis-
played, then press the [ENT] key. The test can also be stopped by pressing [END] [ENT] key sequence, which
ends the DGP session.

The available digital output tests are shown in Figure 8–4: [ACT] KEY MENU STRUCTURE on page 8–11.

NOTE
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Figure 8–4: [ACT] KEY MENU STRUCTURE

ACT
(Actions)

DISABLE
(Prot. Outputs)

DIG OUT TEST

CHNG PASSWD

ENTER PASSWD

COMPUTE CRC

MMI TEST

RELAY TEST

DATE/TIME

RESET

ENABLE
(Prot. Outputs)

TRIP
(Manual)

END TEST MODE
87G

46A, T
40-1, 2
32-1, 2

51V
64G1, 2 *

24A, T
59

81-1, 2, 3, 4U *
81-1, 2, 3, 4O *

VTFF
AE

51GN *
27 *

27TN *

END TEST MODE
94G
94G1
94G2
94G3
74A
74B
74C
74D

74CR
74NC
74FF

TEST PICKUP
TEST TRIP

* Functions available on some
models only. See the

selection guide for details

NOTE: The above menu items (except TIME/DATE) require an Action password to
initiate the action. Resetting of the TIME/DATE requires a Setting password.
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8.3.10 INFORMATION KEY [INF]

The [INF] key is used to request information. The 8 information categories are listed below. The names dis-
played at the MMI are in parentheses. The categories can be scrolled through with the arrow keys. For conve-
nience, however, each category is also assigned a number so that the user may access the category directly.

The key sequence for requesting information is: [INF] n [ENT], where n is the information category below:

If the optional information category number n is omitted, Category 1 (Status Info) is assumed. See Figure 8–5:
[INF] KEY MENU STRUCTURE on page 8–14 for details.

1. REQUEST DGP STATUS

This category is used to display the present status of the DGP system.

If the [ENT] key is pressed, the first item displayed is the overall status of the DGP system. If the DGP is work-
ing properly and protecting the generator, the display reads STATUS: OK. If there is a critical failure, the dis-
play reads STATUS: FAIL. If there is a non-critical failure, the display reads STATUS: WARN. If the DGP
hardware is working properly, there may be a miscellaneous status, displayed as STATUS: MISC. The above
order represents the hierarchy in which the overall status is displayed. For example, if there is a critical alarm
and a non-critical alarm, the display reads STATUS: FAIL indicating the critical alarm.

The user may use the arrow keys for further information if the status is a critical failure, a non-critical failure, or
not protecting the generator.

2. REQUEST FAULT INFORMATION

This category is used to display (or print in applicable models) information associated with any of the last three
faults that the DGP system has stored.

When [ENT] is pressed, the display prompts FAULT #?. The user presses a digit (1 to 3) followed by the [ENT]
key. (where 1 = most recent fault, 2 = second most recent fault, etc.). If there is no valid fault information avail-
able, the message NO FAULT DATA is displayed. If the user presses a number not between 1 and 3, an error
message is displayed.

The first item of the fault occurrence chosen is displayed as DATE: xx/xx/xx. Repeatedly pressing the [↑] key
invokes the following displays:

DATE: xx/xx/xx
TIME: xx:xx:xx
OP TIME: xx (time in ms)
FAULT TYPE: xxx (examples: ABC,AB,AC)
TRIP TYPE: xxx   (see list below)

n = 1: Status Info (STATUS)

2: Fault Info (FAULT)

3: Present Values (VALUES)

4: Events (EVENTS)

5: Password (PASSWORD)

6: Model (MODEL)

7: Station Id (STATION ID)

8: Generator Id (GENERATOR ID)
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OP TIME is the time difference between any protection function pickup and any protection
function trip, as long as all protection functions do not drop out simultaneously. The OP TIME
counter will reset if all protection functions are reset at the same time.

A more detailed fault report can be obtained by using DGP-PC. See Chapter 10: SOFTWARE for details. The
abbreviations for the trip and trigger types are as follows:

3. REQUEST PRESENT VALUES

This category displays the present analog values and status of the contact inputs monitored by the DGP.

If the [ENT] key is pressed, the first item is displayed as IAS = xxx.xx. Pressing the [↑] key displays ANGLE
IAS = xxx.xx, etc. Continuing to press the [↑] key will display each of the quantities shown in Figure 8–5: [INF]
KEY MENU STRUCTURE on page 8–14.

The values are periodically updated while on display.

4. REQUEST EVENTS

This category is used to print Sequence-of-Events information in the applicable DGP models.

5. VIEW PASSWORD

This category is used to view the remote communication passwords in encrypted form.

If the user presses the [ENT] key, a check is made to verify that communication is not in the process of chang-
ing the passwords. If the check fails, then an error message is displayed and the action not performed. If the
check passes, then the word VIEW is displayed. Pressing the [↑] key displays the View level password. Press-
ing [↑] repeatedly displays the word SETTING, then the Setting level password; finally the word CONTROL, fol-
lowed by the Control level password, and back to the word VIEW. All passwords are displayed in encrypted
form. See Table 8–2: PASSWORD ENCRYPTION KEY TABLE on page 8–17 for password encryption details.

6. REQUEST DGP MODEL/VERSION

This category is used to display the DGP model number and the PROM version number.

If the user presses the [ENT] key, the model number is displayed as MD:DGPxxxxxxxxx. Pressing the [↑] key
will display the PROM version number as VER:Vxxxxxxxxxx.

7. STATION ID

This category is used to view the 32-character station ID string downloaded by the remote communication link.
Station ID is included in all system reports via DGP-PC. See Chapter 10: DGP-PC SOFTWARE for details.

If the [ENT] key is pressed, the first 16 characters of the Station ID are displayed. Pressing the [↑] or [↓] keys
displays the next 16 characters of the Station ID.

8. GENERATOR ID

This category is used to view the 32-character Generator ID string downloaded by remote communications.
Generator ID is included in all system reports via DGP-PC. See Chapter 10: DGP-PC SOFTWARE for details.

If the user presses the [ENT] key, the first 16 characters of the Generator ID are displayed. Pressing the [↑] or
[↓] keys displays the next 16 characters of the Generator ID.

87G 40-1 51V 24I 81-1O 81-2U 51GN DI3
46A 40-2 64G1 24T 81-2O VTFF 27 DI4
46T 32-1 24A 59 81-1U AE 27TN

NOTE
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Figure 8–5: [INF] KEY MENU STRUCTURE

INF
(Information)

STATUS
(Relay self-test)

EVENTS
(100 events)

FAULT
(3 records)

VALUES
(Metering)

IAS, Angle IAS
IBS, Angle IBS
ICS, Angle ICS
IAR, Angle IAR
IBR, Angle IBR
ICR, Angle ICR

I2 (% neg. seq. of nominal rated)
VAN, Angle VAN
VBN, Angle VBN
VCN, Angle VCN

P, % 3rd harmonic
N, % 3rd harmonic

WATTS
VARS

GEN FREQ
SMPL FREQ

GEN ON/OFF LINE
INLET VALVE
DIG IN 3 & 4
OSC TRIG
DIG IN 6

PASSWORD
(Remote Link)

MODEL

STATION ID

GENERATOR ID

1. Currents, voltages, watts, and vars are either primary or secondary RMS values as selected
by the user.

2. Voltages are either phase-ground or phase-phase, depending on wye or delta VT
connections, respectively.

3. Phase angles go from 0° to 180° (lead) or –1° to –179° (lag) referenced to either phase A or
AB voltage, depending on wye or delta VT connections, respectively. The reference voltage
must be present for this function to operate.

4. 100
Current Rated

Current Sequence Negative2   I

5. The third harmonic displayed is a percentage of the fundamental terminal voltage. However,
the DGP models with function 27TN display the third harmonic in volts.

6. Watts and vars are automatically displayed with prefix K for kilo and M for mega as
necessary.

NOTES:

VIEW
SETTING

CONTROL

MODEL NUMBER
FIRMWARE VERSION NO.
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8.4 ERROR MESSAGES 8.4.1 DESCRIPTION

If the user enters an incorrect response (either data or a choice), an error message is displayed. See the table
below for a list of the error messages.

If a Setting's CRC code becomes corrupted, certain MMI functions will be unavailable. Whenever the error
occurs, the user will be unable to change any settings (although they can still be viewed). If the error occurs
during startup, the user will be unable to perform any of the Action commands except recalculate the CRC.
Once the CRC has been recalculated with the COMPUTE CRC command, the user will be able to perform
Action commands and change settings. 

The CRC code is a cyclic redundancy check value stored in memory. It is automatically created whenever a
setting is changed. This CRC code enables the EEPROM self-test to verify the integrity of the settings area in
EEPROM.

Table 8–1: MMI ERROR MESSAGES

ERROR MESSAGE CAUSE OF ERROR

VAL OUT OF RANGE Setting value either greater than upper limit or less than lower limit.

SETT NUM INVALID Setting number is not valid.

Y/N NOT ENTERED Setting value or response to a prompt had to be YES or NO but [1/Y] or [3/N] 
key was not entered.

REQUEST INVALID Any key that is invalid during a key sequence.

Some examples are:

CATEGORY INVALID: A wrong category number was entered for either an 
action or information item.

DATE INVALID: The day, month, and/or year are not valid.

TIME INVALID: The hour, minute, and/or second are not valid.

FAULT # INVALID: A fault number greater than the number of faults 
selected, or 0, was entered.

REMOTE LINK ACT: The remote communications link is in use for actions or 
settings, local settings changes and action cannot be performed.

MMI KEY ERROR: MMI received an invalid key code from keyboard. 
(Hardware error)

ACT INVALID NOW: The current action that the user is attempting to 
perform is invalid because the setting's CRC code is in error.
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8.5 PASSWORDS 8.5.1 DESCRIPTION

There are two sets of passwords: MMI and Communications. These passwords are required to perform certain
DGP operations. A password for Actions or Settings is entered by selecting the ENTER PASSWD action and
entering the password after the prompt (see the [ACT] key section). If an action or setting change is not per-
formed for a period of 15 minutes, the password becomes inactive. For settings, after the key sequence [END]
[ENT] is pressed, the password privileges become inactive. The settings and actions may be viewed at any
time but may only be changed if the password for that function is active. Refer to the [ACT] key section for
additional information.

There are two MMI passwords, one for Actions and one for Settings access at the keypad. These passwords
are limited to the numeric digits on the keypad. The MMI passwords are different from the communications
passwords, which are for logging into the relay, remote settings changes, and performing remote actions. The
communication passwords can contain any of the allowable alpha-numeric characters in Table 8–2: PASS-
WORD ENCRYPTION KEY TABLE. All 5 password types are listed below with their factory default values:

All factory default passwords MUST BE CHANGED by the user before they can used effec-
tively.

The communications passwords can only be viewed using the [INF] key and the MMI passwords can only be
viewed from the Information menu in DGP-PC. All passwords are displayed in encoded form. Use the follow-
ing encryption table to decode the passwords.

MMI Passwords Factory Default

Actions 5678.

Setting Changes 1234.

Communications Passwords Factory Default

Actions CTRL!

Setting Changes SETT!

Viewing information only VIEW!

NOTE
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8.5.2 ENCRYPTED PASSWORD CONVERSION TABLE

Table 8–2: PASSWORD ENCRYPTION KEY TABLE

Displayed Decoded Displayed Decoded Displayed Decoded

(space) P 8 B M 7

! T 9 F P (space)

" X : J Q $

$ Q ; N R (

% U < C S ,

& Y = G T !

( R > K U %

) V ? O V )

* Z @ 0 W -

, S A 4 X "

- W B 8 Y &

1 D D 1 Z *

2 H E 5 [ .

3 L F 9 \ #

4 A H 2 ] '

5 E I 6 ^ +

6 I L 3 _ /

7 M
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9 COMMUNICATIONS 9.1 INTRODUCTION 9.1.1 HARDWARE JUMPERS

There are two factory-installed hardware jumpers in the MMI module set to inhibit the ability to perform the
Remote Manual Trip function, the Remote Change Settings function, the Remote Disable Outputs function,
and the Remote Enable Outputs function. These hardware jumpers must be removed if the above remote func-
tions are to be allowed (see Figure 3–4: DGP MMI MODULE on page 3–5 for details).

9.1.2 MODEM CONNECTIONS & SETTINGS

When establishing communication between the DGP and a remote PC, two modems connected via a phone
line are required. One modem is located at the DGP and the other modem is located at the PC. The cable that
connects the modems with the DGP and PC is shown in Figure 9–1: DGP COMMUNICATIONS WIRING on
page 9–3. Each of these modems must be "Hayes-compatible". This is necessary since the DGP-PC commu-
nications software sends a Hayes-compatible command string to the PC modem. The DGP does not send any
configuration commands to its modem. The DGP modem and the PC modem must be uniquely configured to
permit the user to log into and communicate with the DGP system with DGP-PC.

The required configuration settings are presented as changes to the factory-default configuration settings for a
Hayes SmartModem. These default settings are:

Other Hayes-compatible modems may implement a subset of the full Hayes command set. It is the responsibil-
ity of the user to ascertain the exact commands accepted by a particular modem. The proper syntax for enter-
ing the Hayes-compatible commands (sometimes referred to as the "AT" command set) is not described here.
Refer to the modem documentation for an explanation of this syntax.

9.1.3 PC MODEM

The PC modem must be configured for intelligent operation (that is, command recognition enabled). The
default settings listed above are valid for DGP-PC. Those configuration settings critical to the operation of
DGP-PC are changed by the software. The configuration commands sent to the modem from DGP-PC are:

+++ (set modem to command mode)
(delay 2 seconds)

ATE0L3Q0S7=60V0X4Y0 (see explanation below)

Command explanation:

AT Modem attention command
E0 Disable command state echo
L0 Low speaker volume 
Q0 Modem returns result codes
V0 Result codes returned in numeric form
X4 Enables features represented by result codes
Y0 Disable long space disconnect
S7=60 Allows modem to hang up if connection is not made within 60 seconds

B1 P Y0 &K3 &S0 S7=30 S11=95 S26=1
E1 Q0 &C0 &L0 &T4 S8=2 S12=50 S36=1
L2 V1 &D0 &P0 &X0 S9=6 S18=0 S37=0
M1 W0 &G0 &Q5 S0=0 S10=14 S25=5 S38=20
N1 X4 &J0 &R0 S6=2
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If all of the above commands are not programmable, the modem may not operate properly. In addition to the
required configuration settings above, it is suggested that two other settings be made. These are:

&D3 Causes the modem to reset on the ON-to-OFF transition of DTR (Data Terminal Ready)
&C1 Causes DCD (Data Carrier Detect) to track the received carrier signal

The modem will operate properly without making these two settings but the modem will not hang up if the
appropriate handshaking signal is lost.

A DGP-PC setting establishes the baud rate, which must match the DGP baud rate setting. DGP-PC then sets
the specified PC serial port (i.e., COM1, COM2) to the proper baud rate, parity, data bits, and stop bits. If the
PC modem is capable of operating at more than one baud rate, then it must be able to automatically configure
its baud rate, character length, and parity setting by examining the AT command prefix.

9.1.4 DGP MODEM

The DGP modem must be configured for "dumb" operation (that is, command recognition disabled). Since the
DGP does not send any configuration commands to its modem, the required configuration settings must be
made prior to connection. Additionally, the modem must be initialized to the required configuration settings
each time modem power is turned OFF then ON. Depending on the design of the modem, this is accomplished
by making the required settings via switches or saving the settings in non-volatile memory.

The required configuration settings are:

E0 Disable command state echo
L0 Low speaker volume
Q1 Disable result code display
&C1 Causes DCD (Data Carrier Detect) to track the received carrier signal
&D3 Causes the modem to reset on the ON-to-OFF transition of DTR (Data Terminal Ready)
&Q0 Asynchronous mode
S0=1 Enable auto-answer

If any of the above settings cannot be implemented, the modem may not answer, the DGP system may not
connect properly, or the user may not be able to log into the DGP.

With a Hayes SmartModem or equivalent, the DGP modem performs a modulation handshake with the PC
modem to set the DGP modem baud rate. The default setting N1 permits handshaking to occur at any baud
rate supported by both modems. This is one reason why it is preferable to use identical modems at each end.

Note that auto-answering is controlled with register S0. S0=0 disables auto-answer. S0=1 causes the DGP
modem to answer the incoming call after one ring. If it is desirable to delay modem answering, S0 can be set
for any value between 1 and 255 (for the Hayes-compatible modem assumed). Note that DGP-PC (versions
2.0 and higher) configures the PC modem to wait 60 seconds for the DGP modem to answer. If the DGP
modem register S0 is set higher than 12, the PC modem may time-out and hang up before the DGP modem
can answer. S0=12 sets the DGP modem to answer after twelve rings, corresponding to an approximate 60
second delay (S7=60) at the PC modem. However, the number of rings corresponding to 60 seconds should
be verified for a particular application.

9.1.5 NULL MODEM CONNECTIONS

A PC can be connected to the DGP without the intervening modems and phone line by using a "null modem"
cable. The required pin-to-pin connections for this null modem cable are shown in the following diagram. The
pin-to-pin connections for a null modem cable to DGP COMM connector are also shown below. Neither null
modem cable should exceed 50 feet in length.
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Figure 9–1: DGP COMMUNICATIONS WIRING
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E) REMOTE COMMUNICATIONS TO PC DIRECTLY OR SCI BOX
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9.1.6 RS485 COMMUNICATIONS

The DGP with Modbus communications can be used with a GE Multilin RS485 to RS232 converter when nec-
essary. For computers without RS485 capability, a “master” SCI box is required as shown in the figure below.
The SCI boxes are available from GE Multilin as catalog number RS485/RS232–X, where X specifies the volt-
age input (either 120 or 240). Please consult the SCI documentation for additional configuration information.

For RS485 communications, the Master SCI box switch #2 must be set for DIRECT (the factory
default) and the Slave switch #2 must be set for MODEM. Set switch #1 for DATA CONTROLLED.

Correct polarity is also essential. ALL wires from the Master SCI to the Slave SCI must be wired with the posi-
tive (+) terminals connected together and the negative (–) terminals connected together. Each relay must be
daisy-chained to the next. Avoid star or stub connected configurations. The last device (SCI box) at each end
of the daisy-chain should be terminated with a 120 Ω, ¼ W resistor in series with a 1 nF capacitor across the
positive (+) and negative (–) terminals.

Figure 9–2: RS485 COMMUNICATIONS

Table 9–1: SCI DIP SWITCH CONFIGURATION

SWITCH 1 1 2 3 4
Data Controlled ON OFF ON X
DTR Controlled OFF ON OFF X

SWITCH 2 1 2 3 4
Direct ON OFF ON OFF
Modem OFF ON OFF ON

NOTE
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9.2 MODBUS COMMUNICATIONS 9.2.1 INTRODUCTION

This section describes the Modicon Modbus RTU communication protocol used by the DGP Digital Generator
Protection Relay.

The device serial communication parameters, such as baud rate and DGP Unit ID, are set via the keypad. If
the DGP baud rate differs from the Modbus server baud rate, the device will not communicate to the server.
The Unit ID also must be set properly to avoid conflict with other devices connected on the same network.
Even though the setting range allows 16 bit values for Unit ID, the relay should be programmed for a Unit ID
ranging from 1 to 127.

The DGP implements a subset of protocols defined by the Modicon Modbus RTU protocol standard. Multiple
DGP relays can be configured as slaves to a single Modbus master through the RS485 port (using an RS485
to RS232 converter). The DGP is always a slave – it cannot be programmed as a master. Even though the
Modbus protocol is available in Modbus RTU, Modbus ASCII and Modbus Plus protocols, only the Modbus
RTU protocol is supported by the DGP.

9.2.2 DATA FRAME FORMAT & DATA RATE

One data frame of asynchronous transmission from the DGP is defaulted to 1 start bit, 8 data bits, no parity
bits, and 1 stop bit at 9600 baud. The baud rate, parity bits and number of stop bits can be changed through
the DGP keypad. This setting cannot be changed through the Modbus COM port.

9.2.3 DATA PACKET FORMAT

A complete request/response sequence consists of the following bytes.

a) SLAVE ADDRESS

This is the first byte of every transmission. It represents the Unit ID of the device programmed through the DGP
keypad. In the master request, the slave address represents the address of the slave the message is intended
for. In the slave response it is the address of the slave that is responding to the master request. Slave address
0 is reserved for broadcast transmissions by the master as specified by the Modbus protocol. The DGP does
not support the broadcast transmissions. The DGP will respond only if the slave address specified by the mas-
ter request matches its Unit ID; otherwise the DGP relay will not respond.

Modbus Request Transmission: Bytes
SLAVE ADDRESS 1
FUNCTION CODE 1
DATA STARTING ADDRESS 2
DATA  variable number depending on function code
REGISTER CODE 2 bytes
CRC Hi High byte of CRC
CRC Lo Low byte of CRC

Slave Response Transmission: Bytes
SLAVE ADDRESS 1
FUNCTION CODE 1
BYTE COUNT variable depending on number of registers
DATA variable number depending on the function
CRC Hi High Byte of CRC
CRC Lo  Low byte of CRC
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b) FUNCTION CODE

This is the second byte of every transmission. Modbus defines function codes 1 to 127 but the DGP imple-
ments only a subset of these functions. In a master request, the function code represents the action to be per-
formed by the slave. The slave responds with function code identical to that sent by the master if there are no
errors. In case of an error or exception, the slave sets the MS bit of the function code to 1 to indicate an error.

c) DATA

This will be a variable number of bytes depending on the function code.

d) CRC HI & CRC LO

This is a two-byte cyclic redundancy check. The MS byte is sent first and the LS byte next in accordance with
the Modbus protocol reference guide.

9.2.4 ERROR CHECKING

In RTU mode, messages include an error checking field that is based on a cyclic redundancy check method.
The CRC field checks the contents of the entire message. It is applied regardless of any parity check method
used for the individual characters of the message. 

The CRC field is two bytes, containing a 16-bit binary value. The CRC value is calculated by the transmitting
device, which appends the CRC to the message. The receiving device recalculates CRC and compares with
the value it received in the CRC field. If they are not equal an error message results.

The CRC is calculated by first pre-loading a 16-bit register to all 1’s (in GE relays, all registers are pre-loaded
with zeros). Then using a CRC polynomial specified by the CCITT, the CRC is computed (0xA001).

9.2.5 DATA FRAMING

Modbus RTU messages are separated by a silence period of at least 3.5 characters. The slave flushes the
COM port and reads for the first character. This marks the start of transmission. The slave keeps reading until
a silent interval of 3.5 characters which is about 3.65 ms at 9600 baud, which marks the end of transmission.
At this stage it builds the message and resets the port.
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9.3 MODBUS FUNCTIONS 9.3.1 FUNCTION CODE 03/04: READING HOLDING/INPUT REGISTERS

a) DESCRIPTION

Reads the binary contents holding/input registers (actual values) in the slave. They can be set point registers
or any of the information reports, such as actual values.

b) QUERY

The query message specifies the starting register and the number of registers to be read.

c) RESPONSE

The register data in the response is packed as two bytes per register. For each register the first byte contains
the higher order byte and the second contains the lower order byte.

Example of typical response message

Field: Bytes Example (hex):
SLAVE ADDRESS 1 11 Message for slave 17
FUNCTION CODE 1 03/04 Read registers
Starting address 2 Starting address of the register. High byte first and then the Low Byte
Num points 2 Number of registers to read. High Byte first then Low byte
CRC 2 CRC Calculated by master. High byte first. Low byte next

Field: Bytes Example (hex):
SLAVE ADDRESS 1 11 Message from slave 17
FUNCTION CODE 1 03/04 Read registers
Byte Count 1 Number of registers to read.
Data 1 2 High Byte first then Low byte

......
Data n 2 High Byte first then Low byte
CRC 2 CRC calculated by slave. High byte first, Low byte next
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9.3.2 FUNCTION CODE 05: FORCE SINGLE COIL

a) DESCRIPTION

This function code allows the master to request a DGP slave to perform a specific command operation.

b) QUERY

The query message specifies the command to be executed.

c) RESPONSE

The normal response is an echo of the query returned after the command has been executed. Example of
response to function 05H

Field: Bytes Example (hex):
SLAVE ADDRESS 1 11 Message for slave 17
FUNCTION CODE 1 05 Execute a command
Coil address 2 Starting address of the command to be executed. High byte first and 

then the Low Byte
Value 2 FF00 perform function
CRC 2 CRC Calculated by master. High byte first. Low byte next

Field: Bytes Example (hex):
SLAVE ADDRESS 1 11 Message from slave 17
FUNCTION CODE 1 05 Execute a coil command
Coil Address 2 Address of the command that has been executed
Value 2 FF00 Same as the master query
CRC 2 CRC Calculated by Slave High byte first. Low byte next
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9.3.3 FUNCTION CODE 06: STORE SINGLE SETPOINT

a) DESCRIPTION

This function code allows the master to preset a DGP setpoint or to write to some control registers during the
report reads.

b) QUERY

The query message specifies the setpoint to be preset

c) RESPONSE

The normal response is an echo of the query returned after the contents of the register have been preset.
Example of response to function 06H.

Field: Bytes Example (hex):
SLAVE ADDRESS 1 11 Message for slave 17
FUNCTION CODE 1 06 Store a single setpoint
Register address 2 Address of the register to be preset
Value 2 Value of the set point register
CRC 2 CRC Calculated by master. High byte first. Low byte next

Field: Bytes Example (hex):
SLAVE ADDRESS 1 11 Message from slave 17
FUNCTION CODE 1 06 Store a single setpoint
Register Address 2 Address of the register that has been set to the value specified by the 

Master
Value 2 Same as the value specified by the master query.
CRC 2 CRC Calculated by Slave High byte first. Low byte next
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9.3.4 FUNCTION CODE 16: PRESET MULTIPLE SETPOINTS

a) DESCRIPTION

This function code allows the master to preset Multiple Setpoint registers of the DGP Slave.

b) QUERY

The query message specifies the registers to be preset.

c) RESPONSE

The normal response returns the slave address the function ID, Starting Address and the number of registers
preset. An example is given below.

9.3.5 FUNCTION CODE 56: RETRANSMIT LAST PACKET

a) DESCRIPTION

This function is not supported by the Modbus protocol as it is a GE specific enhancement. When this command
is issued, the last response from the slave is simply repeated.

b) QUERY

Example of a query message.

c) RESPONSE

The DGP Slave responds with the last message it transmitted to the master.

Field: Bytes Example (hex):
SLAVE ADDRESS 1 11 Message for slave 17
FUNCTION CODE 1 10 Store setpoints
Starting Address 2 Starting address of the register to be preset
Number of registers 2 Number of set point registers
Byte Count 1 Number of bytes. Equal to twice the number specified by the Number 

of registers
Data1 2 Set point Value 1

.....
Data n 2 Set point value of the nth register from starting register
CRC 2 CRC Calculated by master. High byte first. Low byte next

Field: Bytes Example (hex):
SLAVE ADDRESS 1 11 Message from slave 17
FUNCTION CODE 1 10 Store setpoints
Starting Address 2 Starting address of the register to be preset
Number of registers 2 Number of set point registers
CRC 2 CRC Calculated by master. High byte first. Low byte next

Field: Bytes: Example (hex):
SLAVE ADDRESS 1 11 Message for slave 17
FUNCTION CODE 1 38 Retransmit last packet
CRC 2 CRC Calculated by Slave High byte first. Low byte next
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9.4 MODBUS ERRORS 9.4.1 ERROR RESPONSES

When a DGP slave detects an error a response will be sent to the master. The MSBit of the function code will
be set to 1 and the following byte is an exception code.

The Slave response will be

The DGP will implement the following exception response codes.

01: Illegal function

02: Illegal Data Value

03: Illegal Data Address

Field: Bytes Example (hex):
SLAVE ADDRESS 1 11 Message from slave 17
FUNCTION CODE 1 Function ID with MSbit set to 1
Exception Code 1 Exception Code
CRC 2 CRC Calculated by Slave High byte first. Low byte next
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9.5 MODBUS MEMORY MAPPING 9.5.1 DATA TYPES

The DGP implementation of Modbus uses a small set of data types to interpret the data in the relay. Unless
otherwise noted, all the data will be communicated with the MS byte first and then the LS bytes.

The following data types will be used by the DGP modbus communication.

1. ASCII: Each register is an ASCII character, with the high byte always zero and the low byte representing
the ASCII character.

2. DT0: The date and time in seven registers. The registers have the following format:

Register 1 – day range 1 to 31
Register 2 – month range 1 to 12
Register 3 – year range 00 to 99
Register 4 – hour range 0 to 23
Register 5 – minutes range 0 to 59
Register 6 – seconds range 0 to 59
Register 7 – milliseconds range 0 to 999.

3. DT1: Six registers with the same format as DT0 except without the millisecond field.

4. LONG0: Two registers. Byte order – Byte3 Byte2 Byte1 Byte0. No implied decimal point.

5. LONG1: Two registers. Byte order – Byte3 Byte2 Byte1 Byte0. One implied decimal place.

For example, 3.4 will be represented as long integer 34.

6. LONG2: Two registers. Byte order – Byte3 Byte2 Byte1 Byte0. One implied decimal place.

For example, 3.45 will be represented as long integer 345.

7. INT0: One register. Byte order – Byte2 Byte1. No implied decimal place, integer value only.

8. INT1: One register. Byte order – Byte2 Byte1. One implied decimal place.

For example, 3.4 will be represented as 16-bit integer 34.

9. INT2: One register. Byte order – Byte2 Byte1. Two implied decimal places.

For example, 3.45 will be represented as 16-bit integer 345.

10. BOOLEAN: High byte is always 0; low byte is either 0 or 1.

11. SOE: Eight registers. The first seven registers correspond to date and time according to format DT0. Reg-
ister 8 is the event code (see DGP event code list below). If the requested event contains no data, then all
8 registers contain a value of 0.

12. SP: Special processing needed. Most of the registers are bit fields..
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9.5.2 MEMORY MAP ORGANIZATION

The register maps have been designed by function basis as for GE-Modem to facilitate ease of design. For
example, the Set Date and Time function is implemented by writing to certain setpoint registers even though it
is not a part of the actual settings group. Settings are denoted by the register addresses with the most signifi-
cant two bits representing 01B. Reports are represented by addresses with most significant two bits having a
value of 00B. However, there are some control registers with in the report register map and they are read/write
registers for setting the appropriate registers. They are programmed by Function 06.

9.5.3 FIXED VALUE INPUT REGISTERS

Range: 0000 to 001BH

The fixed value registers contain the PROM version number and other details which do not normally change in
the field. These registers are read only registers and read by Function Codes03/04.

9.5.4 PRESENT VALUE REPORT REGISTER MAP

Range: 0400 to 0431H

This register map specifies the present values report. The report is read by the master by using Function Code
03/04. Any attempt to write to these read-only registers causes an ILLEGAL ADDRESS exception to be
returned.

Status Bits Representation:

Register 0438H: EVENT/FAULT FLAG

bit 0 - New Event(s)
bit 1 - New Fault(s)
bit 2 - In time sync
bit 3 - Local Settings change started
bit 4 - Local Settings change Done

Table 9–2: MEMORY MAP ORGANIZATION

MEMORY MAP SECTION ADDRESS RANGE DESCRIPTION

Fixed Value Input Registers 0000 to 001BH PROM version and other model details

Present Value Report 
Registers

0400 to 0431H DGP Present Values

Event Report Register Map 0800 to 0B20H The last 100 events

Fault Status Register Map 0C00 to 0C18H Faults 1 to 3 header

Fault Report Register Map 1000 to 129DH Fault Report Summary for up to 3 faults

Oscillography 1400 to 17FFH Oscillography header, settings, and data

DGP Status Register Map 1800 to 180CH DGP status and self-test diagnostics

MMI Passwords 1C00 to 1C1FH Passwords

Settings 4000 to 5D05H DGP relay protection settings

Station and Generator ID 7E00 to 7E1FH Station and Generator IDs
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9.5.5 EVENT REPORT MEMORY MAP

Range: 0800 to 0B20H

The event report memory map starts with the addresses with the six most-significant bits set to 000010B. All
the registers are read-only; they can be read by using function codes 03 and 04.

Register 0800H must be read first to determine the number of events. If a request is made for
more events than present, the extra events are padded with zeros to signify no event is
present. Registers 0801H to 0808H always contains the latest event; registers 0B19H to 0B20H
contain the oldest events.

9.5.6 FAULT STATUS MEMORY MAP

Range: 0C00 to 0C18H

The fault status map has the register address with most-significant bits set to 000011B. These read-only regis-
ters are read with Modbus function codes 03/04. The first register contains the number of faults. This register
must be read first to determine the number of faults. If a request is made for more faults than recorded, the
data is filled with zeros. The maximum number of faults is determined by Setting 111: NUM FLTS. If the master
attempts to read more faults than determined by this setting, an ILLEGAL ADDRESS exception is generated.

The TRIP TYPE field is a 16 bit binary value representing the function that has tripped due to the fault. The bit
assignments are as follows:

Registers 0C08H, 0C10H, and 0C18H: TRIP TYPE

bit 0 - 94G
bit 1 - 94G1
bit 2 - 94G2
bit 3 - 94G3
bits 4 to 15 - reserved and presently set to zero

9.5.7 FAULT REPORT REGISTER MAP

Range: 1000 to 129DH

The fault report memory map has the register address with most significant bits set to 000100B. These read-
only registers are read by Modbus Function Codes 03 and 04. The first register 1000H contains the number of
faults recorded. The user must read this register first to find the number of faults. If a request is made for more
faults than recorded, the data is filled with zeros. The maximum number of faults is determined by Setting 111:
NUM FLTS. If the master attempts to read more faults than determined by this setting, an ILLEGAL ADDRESS
exception is generated. 

The fault report summary can store up to 10 sequence of events, with the oldest event recorded in the lower
address (note that in the event report it is the opposite – the latest event is recorded in the lower address). If
there are fewer than 10 events, the remaining registers are filled with zeroes to signify there are no events.

The TRIP TYPE field is a 16-bit binary value representing the function that has tripped due to the fault. The bit
assignments are as follows:

bit 0 - 94G
bit 1 - 94G1
bit 2 - 94G2
bit 3 - 94G3
bits 4 to 15 - reserved and presently set to zero

NOTE
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9.5.8 OSCILLOGRAPHY REPORT MEMORY MAP

Range: 1400 to 16FBH

The oscillography report contains three parts: the oscillography header, active settings for the particular fault,
and oscillography data. Since the memory map is not sufficient for the entire oscillography report, the map is
designed such a way that the fault number and cycle number for the oscillography in interest are selected and
read from a fixed set of registers. The oscillography header and settings are unique for each fault number and
do not depend on the cycle number. The oscillography data depends both on cycle number and fault number.

All oscillography registers have an address with most significant 6 bits set to 000101B.

a) CONTROL REGISTERS

Range: 17FE to 17FFH

The control registers are written using Modbus Function Code 06/10. These registers are read-write registers
and can be read using Function Codes 03 and 04.

The fault number range is limited by Setting 111: NUM FLTS. The cycle number range is also limited by the
same setting. That is, for one fault the range is 1 to 120, for two faults the range is 1 to 60, and for three faults
it is 1 to 40. In addition, if the fault number is set higher than the number of faults recorded, the DGP slave
responds with ILLEGAL DATA VALUE exception. The number of faults recorded can be obtained by reading
the register 1400H. 

Fault Number 1 corresponds to the newest fault and Fault number 3 corresponds to the oldest fault.

You must write the fault number to register 17FFh and the cycle number to register 17FEh
before reading the oscillography data corresponding to this fault.

b) OSCILLOGRAPHY HEADER

Range: 0C00H to 129DH

The first register (0C000H) contains the number of faults recorded. The rest of the registers contain the pre-
fault values, fault values, and the sequence of events. In essence, this block is identical to the fault report
header. All registers are read-only and can be read by Function Codes 03/04.

When a request is made to read these registers, the DGP relay looks at register 17FFH. If it is with in range
then it responds with the oscillography header corresponding to the fault number in the register 17FFH. If the
number is not valid, the DGP slave responds with ILLEGAL DATA VALUE exception.

c) OSCILLOGRAPHY SETTINGS

Range: 1400 to 1483H

Oscillography settings start from register 1400H. All registers are read-only and can be read using function
codes 03H/04H.

When a request is made to read these registers, the DGP relay looks at register 17FFH. If it is with in the range
then it responds with the oscillography settings corresponding to the fault number put in the register 17FFH. If
the number is not valid the DGP slave responds with ILLEGAL DATA VALUE exception.

NOTE
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d) OSCILLOGRAPHY DATA

Range: 1600H to 16FBH

Oscillography data contains 16 registers per sample with 12 samples per cycle and therefore 192 registers per
cycle of interest. Before reading the data, the master has to program control registers 17FEH with the cycle of
interest and 17FFH with the fault number.

When a request is made to read these registers, the DGP looks at registers 17FEH and 17FFH. If they are
within range, it responds with the oscillography data corresponding to the fault number and cycle number in
registers 17FFH and 17FEH. If these numbers are not valid, then the DGP slave responds with an ILLEGAL
DATA VALUE exception.

All these registers are read-only registers and are read using Function Codes 03/04.

e) COMMUNICATION EXAMPLE

An example is given here to show the sequence of transactions for retrieving oscillography:

1. Read the Number of Faults at registers 1000H.
2. Select a fault and write the corresponding fault number into register 17FFH.
3. Read data from 0C00H to 1483H for the oscillography header or fault summary.
4. Read data from 1600H to 16FBH for the Active settings at the time of fault.
5. Cycle Num =1.
6. If (cycle num > Max_Num) go to step 10.
7. Write the Cycle Num into register 17FEH.
8. Read the oscillography data from registers 1600H to 16FBH.
9. Increment the Cycle Num and go to step 6.
10. Finished reading Oscillography.
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9.5.9 EVENT CODES & STATUS REGISTERS

a) EVENT CODES

A list of DGP event codes with their corresponding event messages is shown below:

0 FAIL - DAP BOARD: PROM
1 FAIL - DAP BOARD: LOCAL RAM
2 FAIL - DAP BOARD: DSPRAM CRC
3 FAIL - DAP BOARD: DSPRAM
4 FAIL - DAP BOARD: SYSRAM
5 FAIL - DAP BOARD: INTERRUPT
6 FAIL - DAP BOARD: TIMER
7 FAIL - DSP 1 BOARD: PROM
8 FAIL - DSP 1 BOARD: LOCAL RAM
9 FAIL - DSP 1 BOARD: SHARED RAM
10 FAIL - DSP 1 BOARD: NO RESPONSE
11 FAIL - ANI BOARD: CONTROLLER
12 FAIL - ANI BOARD: SERIAL MEMORY
13 FAIL - ANI BOARD: REFERENCE
14 FAIL - MGM 1 BOARD: SERIAL MEMORY
15 FAIL - SSP BOARD: PROM
16 FAIL - SSP BOARD: LOCAL RAM
17 FAIL - SSP BOARD: SYSRAM CRC
18 FAIL - SSP BOARD: SYSRAM
19 FAIL - SSP BOARD: INTERRUPT
20 FAIL - SSP BOARD: EEPROM
21 FAIL - MMI BOARD: DIGITAL OUTPUT
22 FAIL - MGM 1 BOARD: MODEL NUMBER
23 FAIL - SSP BOARD: VERSION NUMBER
24 FAIL - DAP BOARD: VERSION NUMBER
25 FAIL - DSP 1 BOARD: VERSION NUMBER
26 FAIL - DSP 2 BOARD: PROM
27 FAIL - DSP 2 BOARD: LOCAL RAM
28 FAIL - DSP 2 BOARD: SHARED RAM
29 FAIL - DSP 2 BOARD: NO RESPONSE
30 FAIL - DSP 2 BOARD: VERSION NUMBER
31 FAIL - DSP 3 BOARD: PROM
32 FAIL - DSP 3 BOARD: LOCAL RAM
33 FAIL - DSP 3 BOARD: SHARED RAM
34 FAIL - DSP 3 BOARD: NO RESPONSE
35 FAIL - DSP 3 BOARD: VERSION NUMBER
36 FAIL - ANI BOARD: GROUND REFERENCE
37 FAIL - PS1 BOARD: LOGIC VOLTAGE FAILED
38 FAIL - PS1 BOARD: +12 VOLTAGE FAILED
39 FAIL - PS1 BOARD: -12 VOLTAGE FAILED
40 FAIL - PS2 BOARD: LOGIC VOLTAGE FAILED
41 FAIL - PS2 BOARD: +12 VOLTAGE FAILED
42 FAIL - PS2 BOARD: -12 VOLTAGE FAILED
43 FAIL - PS BOARD: LOGIC VOLTAGE FAILED
44 FAIL - PS BOARD: +12 VOLTAGE FAILED
45 FAIL - PS BOARD: -12 VOLTAGE FAILED
46 FAIL - DSP 1 BOARD: SETTING CHECKSUM
47 FAIL - DSP 2 BOARD: SETTING CHECKSUM
48 FAIL - DSP 3 BOARD: SETTING CHECKSUM

49 FAIL - MGM 2 BOARD: SERIAL MEMORY
50 FAIL - MGM 2 BOARD: MODEL NUMBER
51 FAIL - ANI BOARD:CURRENT SUM
52 FAIL - ANI BOARD:CHANNEL SATURATED
53 FAIL - SSP BOARD:SETTINGS OUT OF RANGE
54 " "
55 WARN - MMI BOARD: PRINT SERIAL CHIP
56 WARN - SSP BOARD: TIMER
57 WARN - SSP BOARD: CAPRAM
58 WARN - SSP BOARD: REAL TIME CLOCK
59 WARN - MMI BOARD: LED DISPLAY
60 WARN - REMOTE COMM LOGIN FAILED
61 WARN - SPURIOUS TIME STROBES
62 WARN - DTA BOARD: SERIAL MEMORY
63 WARN - MMI BOARD: FRONT SERIAL CHIP
64 WARN - MMI BOARD: BACK SERIAL CHIP
65 WARN - PS1 BOARD: LOGIC VOLTAGE FAILED
66 WARN - PS1 BOARD: +12 VOLTAGE FAILED
67 WARN - PS1 BOARD: -12 VOLTAGE FAILED
68 WARN - PS2 BOARD: LOGIC VOLTAGE FAILED
69 WARN - PS2 BOARD: +12 VOLTAGE FAILED
70 WARN - PS2 BOARD: -12 VOLTAGE FAILED
71 WARN - CASE TO GROUND SHORTED
72 WARN - DIT BOARD: DIGITAL INPUT FAIL
73 WARN - ANI BOARD: SAMPLE CORRECTED
74 " "
75 " "
76 32-2 ON
77 32-2 OFF
78 51V PHASE A ON
79 51V PHASE B ON
80 51V PHASE C ON
81 51V PHASE A OFF
82 51V PHASE B OFF
83 51V PHASE C OFF
84 24A PHASE A ON
85 24A PHASE B ON
86 24A PHASE C ON
87 24A PHASE A OFF
88 24A PHASE B OFF
89 24A PHASE C OFF
90 59 ON
91 59 OFF
92 24T PHASE A ON
93 24T PHASE B ON
94 24T PHASE C ON
95 24T PHASE A OFF
96 24T PHASE B OFF
97 24T PHASE C OFF
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98 24I PHASE A ON
99 24I PHASE B ON
100 24I PHASE C ON
101 24I PHASE A OFF
102 24I PHASE B OFF
103 24I PHASE C OFF
104 64G1 ON
105 64G1 OFF
106 64G2 ON
107 64G2 OFF
108 81-1O ON
109 81-1O OFF
110 81-2O ON
111 81-2O OFF
112 81-3O ON
113 81-3O OFF
114 81-4O ON
115 81-4O OFF
116 81-1U ON
117 81-1U OFF
118 81-2U ON
119 81-2U OFF
120 81-3U ON
121 81-3U OFF
122 81-4U ON
123 81-4U OFF
124 51GN ON
125 51GN OFF
126 27 ON
127 27 OFF
128 94G TRIP SIGNAL ON
129 94G1 TRIP SIGNAL ON
130 94G2 TRIP SIGNAL ON
131 94G3 TRIP SIGNAL ON
132 94G TRIP SIGNAL RESET
133 94G1 TRIP SIGNAL RESET
134 94G2 TRIP SIGNAL RESET
135 94G3 TRIP SIGNAL RESET
136 94G TRIP CIRCUIT ENERGIZED
137 94G1 TRIP CIRCUIT ENERGIZED
138 94G2 TRIP CIRCUIT ENERGIZED
139 94G3 TRIP CIRCUIT ENERGIZED
140 94G TRIP CIRCUIT NOT ENERGIZED
141 94G1 TRIP CIRCUIT NOT ENERGIZED
142 94G2 TRIP CIRCUIT NOT ENERGIZED
143 94G3 TRIP CIRCUIT NOT ENERGIZED
144 94G TRIP CIRCUIT OPEN ALARM ON
145 94G1 TRIP CIRCUIT OPEN ALARM ON
146 94G2 TRIP CIRCUIT OPEN ALARM ON
147 94G3 TRIP CIRCUIT OPEN ALARM ON
148 94G TRIP CIRCUIT OPEN ALARM OFF
149 94G1 TRIP CIRCUIT OPEN ALARM OFF
150 94G2 TRIP CIRCUIT OPEN ALARM OFF
151 94G3 TRIP CIRCUIT OPEN ALARM OFF

152 GENERATOR OFF-LINE
153 GENERATOR ON-LINE
154 TURBINE INLET VALVE CLOSED
155 TURBINE INLET VALVE OPEN
156 DIGITAL INPUT 3 CLOSED
157 DIGITAL INPUT 4 CLOSED
158 DIGITAL INPUT 3 OPEN
159 DIGITAL INPUT 4 OPEN
160 OSC TRIGGER
161 VT FUSE FAILURE ALARM ON
162 VT FUSE FAILURE ALARM OFF
163 EXTERNAL VTFF CLOSED
164 EXTERNAL VTFF OPEN
165 ACCIDENTAL ENGERGIZATION ON
166 ACCIDENTAL ENGERGIZATION OFF
167 27TN ON
168 27TN OFF
169 " "
170 " "
171 " "
172 " "
173 " "
174 " "
175 " "
176 REMOTE - PASSWORD CHANGED
177 REMOTE - MANUAL TRIP
178 REMOTE - ENABLE OUTPUTS
179 REMOTE - DISABLE OUTPUTS
180 REMOTE - SETTINGS CHANGE STARTED
181 REMOTE - SETTINGS CHANGE DONE
182 REMOTE - MANUAL TRIP ATTEMPT
183 REMOTE - PROTECTION TURNED OFF
184 REMOTE - PROTECTION TURNED ON
185 REMOTE - FAULT REPORTS RESET
186 REMOTE - SEQUENCE OF EVENTS RESET
187 " "
188 " "
189 " "
190 " "
191 " "
192 LOCAL - MANUAL TRIP
193 LOCAL - ENABLE OUTPUTS
194 LOCAL - DISABLE OUTPUTS
195 LOCAL - SETTINGS CHANGE STARTED
196 LOCAL - SETTINGS CHANGE DONE
197 LOCAL - MANUAL TRIP ATTEMPT
198 LOCAL - PROTECTION TURNED OFF
199 LOCAL - PROTECTION TURNED ON
200 LOCAL - FAULT REPORTS RESET
201 LOCAL - SEQUENCE OF EVENTS RESET
202 " "
203 " "
204 " "
205 " "
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206 " "
207 DAP BOARD: PROCESSOR FAILURE CLEARED
208 DSP1 BOARD: FAILURE CLEARED
209 DSP2 BOARD: FAILURE CLEARED
210 DSP3 BOARD: FAILURE CLEARED
211 SSP BOARD: FAILURE CLEARED
212 DCI BOARD: FAILURE CLEARED
213 ANI BOARD: FAILURE CLEARED
214 MGM1 BOARD: FAILURE CLEARED
215 MGM2 BOARD: FAILURE CLEARED
216 MMI BOARD: FAILURE CLEARED
217 ANI BOARD: REFERENCE CORRECTED
218 DIT BOARD: DIGITAL INPUT CORRECTED
219 SSP BOARD: QUEUES REINITIALIZED
220 87G PHASE A ON
221 87G PHASE B ON
222 87G PHASE C ON
223 87G PHASE A OFF
224 87G PHASE B OFF
225 87G PHASE C OFF
226 46A ON
227 46A OFF
228 46T ON

229 46T OFF
230 40-1 ON
231 40-1 OFF
232 40-2 ON
233 40-2 OFF
234 32-1 ON
235 32-1 OFF
236 DSP1 BOARD: NO RESPONSE CLEARED
237 DSP2 BOARD: NO RESPONSE CLEARED
238 DSP3 BOARD: NO RESPONSE CLEARED
239 CASE TO GROUND SHORT REMOVED
240 ANI BOARD: GROUND FAILURE CLEARED
241 PS1 BOARD: LOGIC FAILURE CLEARED
242 PS1 BOARD: +12V FAILURE CLEARED
243 PS1 BOARD: -12V FAILURE CLEARED
244 PS2 BOARD: LOGIC FAILURE CLEARED
245 PS2 BOARD: +12V FAILURE CLEARED
246 PS2 BOARD: -12V FAILURE CLEARED
247 PS BOARD: LOGIC FAILURE CLEARED
248 PS BOARD: +12V FAILURE CLEARED
249 PS BOARD: -12V FAILURE CLEARED
250 ANI BOARD: CURRENT SUM FAILURE CLEARED
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b) SP (STATUS) REGISTERS

REGISTER BIT ASSIGNMENT
0431h:
Event/Fault 
Flag

bit 0 = New Event(s)
bit 1 = New Fault(s)
bit 2 = In Time Sync
bit 3 = Local Setting Change Started
bit 4 = Local Setting Done

100Ah:
Fault Type

1 = Phase A
2 = Phase B
3 = Phase A-B
4 = Phase C
5 = Phase A-C
6 = Phase B-C
7 = Phase A-B-C

100Bh:
Trip Type

0 = 87G
1 = 46A
2 = 46T
3 = 40-1
4 = 40-2
5 = 32-1
6 = 32-2
7 = 51V
8 = 64G1
9 = 64G2
 10 = 24A
 11 = 24T
 12 = 24I
 13 = 59
 14 = 81-1O
 15 = 81-2O
 16 = 81-3O
 17 = 81-4O
 18 = 81-1U
 19 = 81-2U
 20 = 81-3U
 21 = 81-4U
 22 = VTFF
 23 = OSC
 24 = DI-3
 25 = DI-4

 26 = AE
 27 = 51GN
 28 = 27
 29 = 27TN

4002h:
Trip Voltage 
Monitor (TVM)

bit 3 = 94G0
bit 2 = 94G1
bit 1 = 94G2
bit 0 = 94G3

4003h:
Trip Current 
Monitor (TCM)

bit 3 = 94G0
bit 2 = 94G1
bit 1 = 94G2
bit 0 = 94G3

4007h:
Comport

BBPS:
BB = baud rate, P = parity bit,
S = stop bit.
Example: 9600 baud, no parity, 1 stop 
bit would be represented as 9601.

4009h:
TIMESYNC

0 = Internal
1 = IRIG-B
2 = G-NET

4100h - 5D00h
xxx TRIP

bit 3 = 94G0
bit 2 = 94G1
bit 1 = 94G2
bit 0 = 94G3

4101h - 5D01h
xxx ALARM

bit 3 = 74A
bit 2 = 74B
bit 1 = 74C
bit 0 = 74D

1800h:
SSP STAT

bit 0 = SSP PROM Failure
bit 1 = SSP LOCAL RAM Failure
bit 2 = SSP SYSTEM CRC Failure
bit 3 = SSP SETTING Out of Range
bit 4 = SSP SYSRAM Failure
bit 5 = SSP Interrupt Failure
bit 6 = SSP Timer Failure
bit 7 = SSP EEPROM Failure
bit 8 = SSP CAPRAM Failure
bit 9 = SSP Real Time Clock Failure
bit 10 = Version Number Mismatch 

REGISTER BIT ASSIGNMENT
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bit 11 = No DAP Interrupt 
bit 12-13 = Spare
bit 14 = SSP Digital Output Enable 
Flag
bit 15 = SSP Processor in Reset

1801h:
DAP STAT

bit 0 = DAP PROM Failure
bit 1 = DAP LOCAL RAM Failure
bit 2 = DSPRAM CRC Failure
bit 3 = DSPRAM Failure
bit 4 = DAP SYSRAM Failure
bit 5 = DAP Interrupt Failure
bit 6 = DAP Timer Failure
bit 7 = No DSP1 Response
bit 8 = No DSP2 Response
bit 9 = No DSP3 Response
bit 10 = Version Number Mismatch
bit 11 = Spare
bit 12 = No SSP Interrupt
bit 13 = Spare
bit 14 = Digital Output Enable Flag
bit 15 = DAP Processor in Reset 

1802h:
DSP1 STAT

bit 0 = DSP1 PROM Failure
bit 1 = DSP1 LOCAL RAM Failure
bit 2 = Spare
bit 3 = DSPRAM Failure
bit 4 = Spare
bit 5 = DSP1 Setting Checksum 
Failure
bit 6-9 = Spare
bit 10 = DSP1 Version Number Failure
bit 11-14 = Spare
bit 15 = DSP1 Processor in Reset.

1803h:
DSP2 STAT

bit 0 = DSP2 PROM Failure
bit 1 = DSP2 LOCAL RAM Failure
bit 2 = Spare
bit 3 = DSPRAM Failure
bit 4 = Spare
bit 5 = DSP2 Setting Checksum 
Failure
bit 6-9 = Spare
bit 10 = DSP2 Version Number Failure
bit 11-14 = Spare
bit 15 = DSP2 Processor in Reset.

REGISTER BIT ASSIGNMENT
1804h:
DSP3 STAT

bit 0 = DSP3 PROM Failure
bit 1 = DSP3 LOCAL RAM Failure
bit 2 = Spare
bit 3 = DSPRAM Failure
bit 4 = Spare
bit 5 = DSP3 Setting Checksum 
Failure
bit 6-9 = Spare
bit 10 = DSP3 Version Number Failure
bit 11-14 = Spare
bit 15 = DSP3 Processor in Reset.

1805h:
ANI STAT

bit 0 = ANI Controller Failure
bit 1 = ANI EEPROM Failure
bit 2 = ANI Reference Failure 
bit 3 = ANI Reference Failure Corrected
bit 4 = ANI Ground Reference Failure
bit 5 = ANI No DMA Interrupt
bit 6 = ANI Current Sum Failure
bit 7 = ANI Channel Saturated
bit 8-15 = Spare

1806h:
MMISTAT

bit 0 = MMI LED Display Failure
bit 1 = MMI UART Chip #1 Failure
bit 2 = MMI Digital Output Failure
bit 3 = MMI UART Chip #2 Failure
bit 4 = MMI UART Chip #3 Failure
bit 5-15 = Spare

1807h:
MGM1STAT:

bit 0 = MGM1 EEPROM Failure
bit 1 = MGM1 Model Number Failure
bit 2-15= Spare

1808h:
MGM2STAT:

bit 0 = MGM2 EEPROM Failure
bit 1 = MGM2 Model Number Failure
bit 2-15 = Spare

1809h:
DITSTAT:

bit 0 = DIT Digital Input Error
bit 1 = DIT Digital Input Error Corrected
bit 2-15 = Spare

180Ah:
PWR1STAT:

bit 0 = POWER SUPPLY 1:
+12 V Warning

bit 1 = POWER SUPPLY 2:
+12 V Warning

REGISTER BIT ASSIGNMENT
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bit 2 = POWER SUPPLY 1:
+12 V Failed

bit 3 = POWER SUPPLY 1 & 2:
+12 V Failed

bit 4 = POWER SUPPLY 1:
–12 V Warning

bit 5 = POWER SUPPLY 2:
–12 V Warning

bit 6 = POWER SUPPLY 1:
–12 V Failed

bit 7 = POWER SUPPLY 1 & 2:
–12 V Failed

bit 8-15 = Spare
180Bh:
PWR2STAT:

bit 0 = POWER SUPPLY 1: Warning
bit 1 = POWER SUPPLY 2: Warning
bit 2 = POWER SUPPLY 1: Failed
bit 3 = POWER SUPPLY 1 & 2: Failed
bit 4-15 = Spare

180Ch:
MISCSTAT: 

bit 0 = Protection Enabled Flag
bit 1 = Digital Output Enable Flag
bit 2 = Case to Ground Shorted
bit 3 = Spare
bit 4 = Fuse Failure 
bit 5 = Logon Failure
bit 6 = Remote Manual-Trip Jumper 
Installed 
bit 7 = Remote Change-Settings 
Jumper Installed
bit 8 = TEST MODE Activated
bit 9 = Time Strobe Failed
bit 10 = Digital Output Test Activated
bit 11 = 94G-A Trip Continuity Error
bit 12 = 94G-B Trip Continuity Error
bit 13 = 94G-C Trip Continuity Error
bit 14 = 94G-D Trip Continuity Error
bit 15 = Spare

REGISTER BIT ASSIGNMENT
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c) OSC SETTINGS

Each register contains one Setting in sequential order according to Table 2–1: DGP SYSTEM SETTINGS &
RATINGS on page 2–3. Note that a cycle number and fault number must be selected (registers 17FEh to
17FF) prior to reading OSC Settings. 

REGISTER BIT ASSIGNMENT
160Ch:
DI SAMPx

bit 0 = DI-1, Generator Off Line
bit 1 = DI-2, Turbine Inlet Valve Closed
bit 2 = DI-3, External Trip 1
bit 3 = DI-4, External Trip 2
bit 4 = DI-5, Oscillography Trigger
bit 5 = DI-6, External VTFF / Disable 
Protections
bit 6 = not used
bit 7 = IRIG-B
bit 8-15 = not used

160Dh:
DO SAMPx 

bit 00 = Trip 94G
bit 01 = Trip 94G1
bit 02 = Alarm 74A
bit 03 = Alarm 74B
bit 04 = Alarm 74C
bit 05 = Alarm 74D
bit 06 = Alarm VTFF
bit 07 = Trip 94G2
bit 08 = Trip 94G3
bit 09 = not used
bit 10 = Non Critical Alarm
bit 11 = Critical Alarm
bit 12-15 = not used

160Eh:
PUFLG0

Protection pickup flags group 0
(1 = Active state; 0 = Inactive state)
bit 00    87G-A
bit 01    87G-B
bit 02    87G-C
bit 03    46A
bit 04    46T
bit 05    40-1
bit 06    40-2
bit 07    32-1
bit 08    32-2
bit 09    51V-A
bit 10    51V-B
bit 11    51V-C

bit 12    24A-A
bit 13    24A-B
bit 14    24A-C
bit 15    59

160Fh:
PUFLG1

Protection pickup flags group 1
(1 = Active state; 0 = Inactive state)
bit 00    24T-A
bit 01    24T-B
bit 02    24T-C
bit 03    24I-A
bit 04    24I-B
bit 05    24I-C
bit 06    64G1
bit 07    64G2
bit 08    81-1o
bit 09    81-2o
bit 10    81-3o
bit 11    81-4o
bit 12    81-1u
bit 13    81-2u
bit 14    81-3u
bit 15    81-4u

1610h:
PUFLG2

Protection pickup flags group 2
(1 = Active state; 0 = Inactive state)
bit 00    AE 
bit 01    27
bit 02    51GN
bit 03    DI3
bit 04    DI4
bit 05    27TN
bit 06 - bit 15 = not used

1611h:
PRFLG0

Protection function trip flags group 0. Bit 
assignment is same as pickup flags group 
0.

1612h:
PRFLG1

Protection function trip flags group 1. Bit 
assignment is same as pickup flags group 
1.

1613h:
PRFLG2

Protection function trip flags group 2. Bit 
assignment is same as pickup flags group 
2.

REGISTER BIT ASSIGNMENT
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9.5.10 MMI PASSWORDS

Range: 1C00 to 1C1FH

The master can read the MMI passwords from registers starting at address 1C00H by using function codes
03H/04H. Each register represents a ASCII character with the high-byte set to zero. The register addresses
have their most significant 6 bits set to 000111B.

9.5.11 SETTINGS

Range: 4000 to 5D05

The setting registers are read-write registers. The register addresses have their two most significant bits set to
01B. The next six significant bits represent the category number and the final eight bits denote the setting num-
ber. There is a direct correspondence between the register address and the category setting number. To obtain
the category setting number, add 1 to category number (the least significant six bits of the register address high
byte), multiply by 100, and add the low byte plus 1.

The setting registers can be read by using function codes 03H/04H. The setting registers can be preset by
using function codes 06H/10H. 

The settings register map contains all settings available in all DGP models. Since some settings are not valid
for some models, an ILLEGAL ADDRESS exception may be obtained when reading/writing multiple setpoints.

Settings change at the relay take place in a temporary local RAM. To make the settings permanent, the coil
command END must be executed. Upon executing this command, the relay copies the temporary settings from
local RAM to EEPROM, making the changes permanent.

9.5.12 STATION & GENERATOR ID REGISTER MAP

Range: 7E00 to 7E1FH

Station and Generator ID registers are read-writer registers. They are read using function codes 03/04H and
written using function code 10H.

9.5.13 DATE & TIME

Range: 7F00 to 7F05H

The master can change the date and time by writing into the registers starting at address 7F00H and by using
the function code 10H. All these registers are write-only registers. The individual registers cannto be pro-
grammed, either the date or time or both may be changed.
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9.5.14 MEMORY MAP

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 1 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX

FIXED VALUE REPORT

0 0 Model Number N/A ASCII 16

16 10 Version Number N/A ASCII 12

PRESENT VALUE REPORT

1024 400 Date and Time N/A DT0 7

1031 407 Mag IAS AMP LONG2 2

1033 409 Angle IAS DEGREE INTO 1

1034 40A Mag IBS AMP LONG2 2

1036 40C Angle IBS DEGREE INTO 1

1037 40D Mag ICS AMP LONG2 2

1039 40F Angle ICS Degree INTO 1

1040 410 Mag IAR AMP INTO 2

1042 412 Angle IAR DEGREE INTO 1

1043 413 Mag IBR AMP LONG2 2

1045 415 Angle IBR DEGREE INTO 1

1046 416 Mag ICR AMP LONG2 2

1048 418 Ang ICR DEGREE INTO 1

1049 419 Mag I2 AMP LONG2 2

1051 41B Mag VA VOLT LONG1 2

1053 41D Angle VA DEGREE INTO 1

1054 41E Mag VB VOLT LONG1 2

1056 420 Ang VB DEGREE INTO 1

1057 421 Mag VC VOLT LONG1 2

1059 423 Ang VC DEGREE INTO 1

1060 424 Third Harmonic PH VOLT INT1 1

1061 425 Third Harmonic N VOLT INT1 1

1062 426 Watts WATT LONG1 2

1064 428 VARS VAR LONG1 2

1066 42A Gen OFFLINE N/A BOOLEAN 1

1067 42B FUEL VALVE N/A BOOLEAN 1

1068 42C DI3 N/A BOOLEAN 1

1069 42D DI4 N/A BOOLEAN 1
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1070 42E DI6 N/A BOOLEAN 1

1071 42F SYS FREQ HZ INT2 1

1072 430 SAMP FREQ HZ INT1 1

1073 431 Event Fault Flags N/A SP 1

EVENT REPORT

2048 800 Num Events N/A INTO 1

2049 801 Event 1 SOE 8

2057 809 Event 2 SOE 8

2065 811 Event 3 SOE 8

2073 819 Event 4 SOE 8

2081 821 Event 5 SOE 8

2089 829 Event 6 SOE 8

2097 831 Event 7 SOE 8

2105 839 Event 8 SOE 8

2113 841 Event 9 SOE 8

2121 849 Event 10 SOE 8

2129 851 Event 11 SOE 8

2137 859 Event 12 SOE 8

2145 861 Event 13 SOE 8

2153 869 Event 14 SOE 8

2161 871 Event 15 SOE 8

2169 879 Event 16 SOE 8

2177 881 Event 17 SOE 8

2185 889 Event 18 SOE 8

2193 891 Event 19 SOE 8

2201 899 Event 20 SOE 8

2209 8A1 Event 21 SOE 8

2217 8A9 Event 22 SOE 8

2225 8B1 Event 23 SOE 8

2233 8B9 Event 24 SOE 8

2241 8C1 Event 25 SOE 8

2249 8C9 Event 26 SOE 8

2257 8D1 Event 27 SOE 8

2265 8D9 Event 28 SOE 8

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 2 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX
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2273 8E1 Event 29 SOE 8

2281 8E9 Event 30 SOE 8

2289 8F1 Event 31 SOE 8

2297 8F9 Event 32 SOE 8

2305 901 Event 33 SOE 8

2313 909 Event 34 SOE 8

2321 911 Event 35 SOE 8

2329 919 Event 36 SOE 8

2337 921 Event 37 SOE 8

2345 929 Event 38 SOE 8

2353 931 Event 39 SOE 8

2361 939 Event 40 SOE 8

2369 941 Event 41 SOE 8

2377 949 Event 42 SOE 8

2385 951 Event 43 SOE 8

2393 959 Event 44 SOE 8

2401 961 Event 45 SOE 8

2409 969 Event 46 SOE 8

2417 971 Event 47 SOE 8

2425 979 Event 48 SOE 8

2433 981 Event 49 SOE 8

2441 989 Event 50 SOE 8

2449 991 Event 51 SOE 8

2457 999 Event 52 SOE 8

2465 9A1 Event 53 SOE 8

2473 9A9 Event 54 SOE 8

2481 9B1 Event 55 SOE 8

2489 9B9 Event 56 SOE 8

2497 9C1 Event 57 SOE 8

2505 9C9 Event 58 SOE 8

2513 9D1 Event 59 SOE 8

2521 9D9 Event 60 SOE 8

2529 9E1 Event 61 SOE 8

2537 9E9 Event 62 SOE 8

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 3 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX
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2545 9F1 Event 63 SOE 8

2553 9F9 Event 64 SOE 8

2561 A01 Event 65 SOE 8

2569 A09 Event 66 SOE 8

2577 A11 Event 67 SOE 8

2585 A19 Event 68 SOE 8

2593 A21 Event 69 SOE 8

2601 A29 Event 70 SOE 8

2609 A31 Event 71 SOE 8

2617 A39 Event 72 SOE 8

2625 A41 Event 73 SOE 8

2633 A49 Event 74 SOE 8

2641 A51 Event 75 SOE 8

2649 A59 Event 76 SOE 8

2657 A61 Event 77 SOE 8

2665 A69 Event 78 SOE 8

2673 A71 Event 79 SOE 8

2681 A79 Event 80 SOE 8

2689 A81 Event 81 SOE 8

2697 A89 Event 82 SOE 8

2705 A91 Event 83 SOE 8

2713 A99 Event 84 SOE 8

2721 AA1 Event 85 SOE 8

2729 AA9 Event 86 SOE 8

2737 AB1 Event 87 SOE 8

2745 AB9 Event 88 SOE 8

2753 AC1 Event 89 SOE 8

2761 AC9 Event 90 SOE 8

2769 AD1 Event 91 SOE 8

2777 AD9 Event 92 SOE 8

2785 AE1 Event 93 SOE 8

2793 AE9 Event 94 SOE 8

2801 AF1 Event 95 SOE 8

2809 AF9 Event 96 SOE 8

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 4 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX
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2817 B01 Event 97 SOE 8

2825 B09 Event 98 SOE 8

2833 B11 Event 99 SOE 8

2841 B19 Event 100 SOE 8

FAULT STATUS

3072 C00 Num Faults INTO 1

3073 C01 Date & Time F1 DT0 7

3080 C08 Trip Type F1 INTO 1

3081 C09 Date and Time F2 DT0 7

3088 C10 Trip Type F2 INTO 1

3089 C11 Date and Time F3 DT0 7

3096 C18 Trip Type F3 INTO 1

FAULT REPORT

4096 1000 Num Faults INTO 1

4097 1001 Date&Time F1 DT0 7

4104 1008 Op Time F1 msec LONG0 2

4106 100A Fault Type F1 SP 1

4107 100B Trip Type F1 SP 1

4108 100C Prefault VA F1 VOLT LONG1 2

4110 100E Prefault VB F1 VOLT LONG1 2

4112 1010 Prefault VC F1 VOLT LONG1 2

4114 1012 Prefault IAS F1 AMP LONG2 2

4116 1014 Prefault IBS F1 AMP LONG2 2

4118 1016 Prefault ICS F1 AMP LONG2 2

4120 1018 Prefault Watts F1 WATT LONG1 2

4122 101A Prefault Vars F1 VAR LONG1 2

4124 101C Prefault SysFreq F1 HZ INT2 1

4125 101D Fault VA VOLT LONG1 2

4127 101F Fault VB VOLT LONG1 2

4129 1021 Fault VC VOLT LONG1 2

4131 1023 Fault VN VOLT LONG1 2

4133 1025 Fault IAS AMP LONG2 2

4135 1027 Fault IBS AMP LONG2 2

4137 1029 Fault ICS AMP LONG2 2

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 5 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX
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4139 102B Fault INS AMP LONG2 2

4141 102D Fault IAR AMP LONG2 2

4143 102F Fault IBR AMP LONG2 2

4145 1031 Fault ICR AMP LONG2 2

4147 1033 Fault INR AMP LONG2 2

4149 1035 SOE1 F1 SOE 8

4157 103D SOE2 F1 SOE 8

4165 1045 SOE3 F1 SOE 8

4173 104D SOE4 F1 SOE 8

4181 1055 SOE5 F1 SOE 8

4189 105D SOE6 F1 SOE 8

4197 1065 SOE7 F1 SOE 8

4205 106D SOE8 F1 SOE 8

4213 1075 SOE9 F1 SOE 8

4221 107D SOE10 F1 SOE 8

4229 1085 SOE11 F1 SOE 8

4237 108D SOE12 F1 SOE 8

4245 1095 SOE13 F1 SOE 8

4253 109D SOE14 F1 SOE 8

4353 1101 Date&Time F2 DT0 7

4360 1108 Op Time F2 msec LONG0 2

4362 110A Fault Type F2 SP 1

4363 110B Trip Type F2 SP 1

4364 110C Prefault VA F2 VOLT LONG1 2

4366 110E Prefault VB F2 VOLT LONG1 2

4368 1110 Prefault VC F2 VOLT LONG1 2

4370 1112 Prefault IAS F2 AMP LONG2 2

4372 1114 Prefault IBS F2 AMP LONG2 2

4374 1116 Prefault ICS F2 AMP LONG2 2

4376 1118 Prefault Watts F2 WATT LONG1 2

4378 111A Prefault Vars F2 VAR LONG1 2

4380 111C Prefault SysFreq F2 HZ INT2 1

4381 111D Fault VA VOLT LONG1 2

4383 111F Fault VB VOLT LONG1 2
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4385 1121 Fault VC VOLT LONG1 2

4387 1123 Fault VN VOLT LONG1 2

4389 1125 Fault IAS AMP LONG2 2

4391 1127 Fault IBS AMP LONG2 2

4393 1129 Fault ICS AMP LONG2 2

4395 112B Fault INS AMP LONG2 2

4397 112D Fault IAR AMP LONG2 2

4399 112F Fault IBR AMP LONG2 2

4401 1131 Fault ICR AMP LONG2 2

4403 1133 Fault INR AMP LONG2 2

4405 1135 SOE1 F2 SOE 8

4413 113D SOE2 F2 SOE 8

4421 1145 SOE3 F2 SOE 8

4429 114D SOE4 F2 SOE 8

4437 1155 SOE5 F2 SOE 8

4445 115D SOE6 F2 SOE 8

4453 1165 SOE7 F2 SOE 8

4461 116D SOE8 F2 SOE 8

4469 1175 SOE9 F2 SOE 8

4477 117D SOE10 F2 SOE 8

4485 1185 SOE11 F2 SOE 8

4493 118D SOE12 F2 SOE 8

4501 1195 SOE13 F2 SOE 8

4509 119D SOE14 F2 SOE 8

4609 1201 Date&Time F3 DT0 7

4616 1208 Op Time F3 msec LONG0 2

4618 120A Fault Type F3 SP 1

4619 120B Trip Type F3 SP 1

4620 120C Prefault VA F3 VOLT LONG1 2

4622 120E Prefault VB F3 VOLT LONG1 2

4624 1210 Prefault VC F3 VOLT LONG1 2

4626 1212 Prefault IAS F3 AMP LONG2 2

4628 1214 Prefault IBS F3 AMP LONG2 2

4630 1216 Prefault ICS F3 AMP LONG2 2
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4632 1218 Prefault Watts F3 WATT LONG1 2

4634 121A Prefault Vars F3 VAR LONG1 2

4636 121C Prefault SysFreq F3 HZ INT2 1

4637 121D Fault VA VOLT LONG1 2

4639 121F Fault VB VOLT LONG1 2

4641 1221 Fault VC VOLT LONG1 2

4643 1223 Fault VN VOLT LONG1 2

4645 1225 Fault IAS AMP LONG2 2

4647 1227 Fault IBS AMP LONG2 2

4649 1229 Fault ICS AMP LONG2 2

4651 122B Fault INS AMP LONG2 2

4653 122D Fault IAR AMP LONG2 2

4655 122F Fault IBR AMP LONG2 2

4657 1231 Fault ICR AMP LONG2 2

4659 1233 Fault INR AMP LONG2 2

4661 1235 SOE1 F3 SOE 8

4669 123D SOE2 F3 SOE 8

4677 1245 SOE3 F3 SOE 8

4685 124D SOE4 F3 SOE 8

4693 1255 SOE5 F3 SOE 8

4701 125D SOE6 F3 SOE 8

4709 1265 SOE7 F3 SOE 8

4717 126D SOE8 F3 SOE 8

4725 1275 SOE9 F3 SOE 8

4733 127D SOE10 F3 SOE 8

4741 1285 SOE11 F3 SOE 8

4749 128D SOE12 F3 SOE 8

4757 1295 SOE13 F3 SOE 8

4765 129D SOE14 F3 SOE 8

OSCILLOGRAPHY SETTINGS

5120 1400 Unit ID INTO 1

5121 1401 SYS FREQ HZ INTO 1

5122 1402 SEL TVM SP 1

5123 1403 SEL TCM SP 1
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5124 1404 SELPRIM BOOLEAN 1

5125 1405 CT RATIO INTO 1

5126 1406 VT RATIO INT1 1

5127 1407 COMMPORT SP 1

5128 1408 Not Used 1

5129 1409 PHASE BOOLEAN 1

5130 140A TIMESYNC SP 1

5131 140B NUM FLTS INTO 1

5132 140C PREFLT INTO 1

5133 140D OSC TRIG BOOLEAN 1

5134 140E NOM VOLT VOLT INT1 1

5135 140F RATEDCUR AMP INT2 1

5136 1410 VT CONN BOOLEAN 1

5137 1411 87G TRIP SP 1

5138 1412 87G ALARM SP 1

5139 1413 87G K1 % INT1 1

5140 1414 87G PICKUP AMP INT2 1

5141 1415 46A ALARM SP 1

5142 1416 46A Pickup AMP INT2 1

5143 1417 46A TL14 SEC INTO 1

5144 1418 46T TRIP SP 1

5145 1419 46T ALARM SP 1

5146 141A 46T PICKUP AMP INT2 1

5147 141B 46T K2 SEC INT1 1

5148 141C 40-1 TRIP SP 1

5149 141D 40-1 ALARM SP 1

5150 141E 40-1 CENTER OHM INT2 1

5151 141F 40-1 RADIUS OHM INT2 1

5152 1420 40-1 TL12 SEC INT2 1

5153 1421 40-2 TRIP SP 1

5154 1422 40-2 ALARM SP 1

5155 1423 40-2 CENTER OHM INT2 1

5156 1424 40-2 RADIUS OHM INT2 1

5157 1425 40-2 TL13 SEC INT2 1
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5158 1426 32-1 TRIP SP 1

5159 1427 32-1 ALARM SP 1

5160 1428 32-1 SQ TR EN LONG0 1

5161 1429 32- 1 REV PWR WATT INT1 1

5162 142A 32-1 TL1 SEC INTO 1

5163 142B AE ARM BOOLEAN 1

5164 142C 32-2 TRIP SP 1

5165 142D 32-2 ALARM SP 1

5166 142E 32- 2 REV PWR WATT INT1 1

5167 142F 32-2 TL2 SEC INTO 1

5168 1430 51V TRIP SP 1

5169 1431 51V ALARM SP 1

5170 1432 51V PICKUP AMP INT1 1

5171 1433 51V TIMEFAC SEC INT2 1

5172 1434 64G1 TRIP SP 1

5173 1435 64G1  ALARM SP 1

5174 1436 64G1  PICKUP VOLT INT1 1

5175 1437 64G1 TL4 SEC INT1 1

5176 1438 64G2 TRIP SP 1

5177 1439 64G2  ALARM SP 1

5178 143A 64G2 TL5 SEC INT1 1

5179 143B 24A  ALARM SP 1

5180 143C 24A  PICKUP PER UNIT INT2 1

5181 143D 24A TL6 SEC INT1 1

5182 143E 24T TRIP ON_line SP 1

5183 143F 24T TRIP OFF-line SP 1

5184 1440 24T  ALARM SP 1

5185 1441 24T CURVE # INTO 1

5186 1442 24T INV PU PER UNIT INT2 1

5187 1443 24T TIME FAC SEC INT2 1

5188 1444 24T INST PU PER UNIT INT2 1

5189 1445 24T TL7 SEC INT1 1

5190 1446 24T RESET SEC INTO 1

5191 1447 59 TRIP SP 1
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5192 1448 59  ALARM SP 1

5193 1449 59 INV PU VOLT INTO 1

5194 144A 59 TIME FAC SEC INT2 1

5195 144B 81 UV CUTOFF % INTO 1

5196 144C 81-1O TRIP SP 1

5197 144D 81-1O ALARM SP 1

5198 144E 81-1O SETPNT HZ INT2 1

5199 144F 81-1O TL15 SEC INT2 1

5200 1450 81-2O TRIP SP 1

5201 1451 81-2O ALARM SP 1

5202 1452 81-2O SETPNT HZ INT2 1

5203 1453 81-2O TL16 SEC INT2 1

5204 1454 Not Used 1

5205 1455 Not Used 1

5206 1456 Not Used 1

5207 1457 Not Used 1

5208 1458 Not Used 1

5209 1459 Not Used 1

5210 145A Not Used 1

5211 145B Not Used 1

5212 145C 81-1U TRIP SP 1

5213 145D 81-1U ALARM SP 1

5214 145E 81-1U SETPNT HZ INT2 1

5215 145F 81-1U TL8 SEC INT1 1

5216 1460 81-2U TRIP SP 1

5217 1461 81-2U ALARM SP 1

5218 1462 81-2U SETPNT HZ INT2 1

5219 1463 81-2U TL9 SEC INT2 1

5220 1464 81-3U TRIP SP 1

5221 1465 81-3U ALARM SP 1

5222 1466 81-3U SETPNT HZ INT2 1

5223 1467 81-3U TL10 SEC INT2 1

5224 1468 81-4U TRIP SP 1

5225 1469 81-4U ALARM SP 1
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5226 146A 81-4U SETPNT HZ INT2 1

5227 146B 81-4U TL11 SEC INT2 1

5228 146C DIG INP SELBKD11 INTO 1

5229 146D DI3 TRIP SP 1

5230 146E DI3 ALARM SP 1

5231 146F DI4 TRIP SP 1

5232 1470 DI4 ALARM SP 1

5233 1471 VTFF BOOLEAN 1

5234 1472 40 SELV2SUP BOOLEAN 1

5235 1473 AE TRIP SP 1

5236 1474 AE ALARM SP 1

5237 1475 27 TRIP SP 1

5238 1476 27 ALARM SP 1

5239 1477 27 PICKUP VOLT INTO 1

5240 1478 27 TIME FAC SEC INT2 1

5241 1479 27 CURVE # INTO 1

5242 147A 51GN TRIP SP 1

5243 147B 51GN ALARM SP 1

5244 147C 51GN PICKUP AMP INT2 1

5245 147D 51GN TIME FAC SEC INT2 1

5246 147E 59 CURVE # INTO 1

5247 147F 27TN TRIP SP 1

5248 1480 27TN ALARM SP 1

5249 1481 27TN  PICKUP VOLT INT1 1

5250 1482 27TN TL20 SEC INT1 1

5251 1483 27TN FORPWR_L WATT INTO 1

OSCILLOGRAPHY DATA

5632 1600 IAS SAMP1 AMP INT2 1

5633 1601 IBS SAMP1 AMP INT2 1

5634 1602 ICS SAMP1 AMP INT2 1

5635 1603 INS SAMP1 AMP INT2 1

5636 1604 IAR AMP1 AMP INT2 1

5637 1605 IBR SAMP1 AMP INT2 1

5638 1606 ICR SAMP1 AMP INT2 1
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5639 1607 INR SAMP1 AMP INT2 1

5640 1608 VA SAMP1 VOLT INT1 1

5641 1609 VB SAMP1 VOLT INT1 1

5642 160A VC SAMP1 VOLT INT1 1

5643 160B VN SAMP1 VOLT INT1 1

5644 160C DI SAMP1 SP 1

5645 160D DO SAMP1 SP 1

5646 160E PUFLG0 SAMP1 SP 1

5647 160F PUFLG1 SAMP1 SP 1

5648 1610 PUFLG2 SAMP1 SP 1

5649 1611 PRFLG0 SAMP1 SP 1

5650 1612 PRFLG1 SAMP1 SP 1

5651 1613 PRFLG2 SAMP1 SP 1

5652 1614 SAMPPD SAMP1 SP 1

5653 1615 IAS SAMP2 AMP INT2 1

5654 1616 IBS SAMP2 AMP INT2 1

5655 1617 ICS SAMP2 AMP INT2 1

5656 1618 INS SAMP2 AMP INT2 1

5657 1619 IAR AMP2 AMP INT2 1

5658 161A IBR SAMP2 AMP INT2 1

5659 161B ICR SAMP2 AMP INT2 1

5660 161C INR SAMP2 AMP INT2 1

5661 161D VA SAMP2 VOLT INT1 1

5662 161E VB SAMP2 VOLT INT1 1

5663 161F VC SAMP2 VOLT INT1 1

5664 1620 VN SAMP2 VOLT INT1 1

5665 1621 DI SAMP2 SP 1

5666 1622 PUFLG0 SAMP2 SP 1

5667 1623 PUFLG1 SAMP2 SP 1

5668 1624 PUFLG2 SAMP2 SP 1

5669 1625 PUFLG2 SAMP2 SP 1

5670 1626 PRFLG0 SAMP2 SP 1

5671 1627 PRFLG1 SAMP2 SP 1

5672 1628 PRFLG2 SAMP2 SP 1
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5673 1629 SAMPPD SAMP2 SP 1

5674 162A IAS SAMP3 AMP INT2 1

5675 162B IBS SAMP3 AMP INT2 1

5676 162C ICS SAMP3 AMP INT2 1

5677 162D INS SAMP3 AMP INT2 1

5678 162E IAR AMP3 AMP INT2 1

5679 162F IBR SAMP3 AMP INT2 1

5680 1630 ICR SAMP3 AMP INT2 1

5681 1631 INR SAMP3 AMP INT2 1

5682 1632 VA SAMP3 VOLT INT1 1

5683 1633 VB SAMP3 VOLT INT1 1

5684 1634 VC SAMP3 VOLT INT1 1

5685 1635 VN SAMP3 VOLT INT1 1

5686 1636 DI SAMP3 SP 1

5687 1637 DO SAMP3 SP 1

5688 1638 PUFLG0 SAMP3 SP 1

5689 1639 PUFLG1 SAMP3 SP 1

5690 163A PUFLG2 SAMP3 SP 1

5691 163B PRFLG0 SAMP3 SP 1

5692 163C PRFLG1 SAMP3 SP 1

5693 163D PRFLG2 SAMP3 SP 1

5694 163E SAMPPD SAMP3 SP 1

5695 163F IAS SAMP4 AMP INT2 1

5696 1640 IBS SAMP4 AMP INT2 1

5697 1641 ICS SAMP4 AMP INT2 1

5698 1642 INS SAMP4 AMP INT2 1

5699 1643 IAR AMP4 AMP INT2 1

5700 1644 IBR SAMP4 AMP INT2 1

5701 1645 ICR SAMP4 AMP INT2 1

5702 1646 INR SAMP4 AMP INT2 1

5703 1647 VA SAMP4 VOLT INT1 1

5704 1648 VB SAMP4 VOLT INT1 1

5705 1649 VC SAMP4 VOLT INT1 1

5706 164A VN SAMP4 VOLT INT1 1
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5707 164B DI SAMP4 SP 1

5708 164C DO SAMP4 SP 1

5709 164D PUFLG0 SAMP4 SP 1

5710 164E PUFLG1 SAMP4 SP 1

5711 164F PUFLG2 SAMP4 SP 1

5712 1650 PRFLG0 SAMP4 SP 1

5713 1651 PRFLG1 SAMP4 SP 1

5714 1652 PRFLG2 SAMP4 SP 1

5715 1653 SAMPPD SAMP4 SP 1

5716 1654 IAS SAMP5 AMP INT2 1

5717 1655 IBS SAMP5 AMP INT2 1

5718 1656 ICS SAMP5 AMP INT2 1

5719 1657 INS SAMP5 AMP INT2 1

5720 1658 IAR AMP5 AMP INT2 1

5721 1659 IBR SAMP5 AMP INT2 1

5722 165A ICR SAMP5 AMP INT2 1

5723 165B INR SAMP5 AMP INT2 1

5724 165C VA SAMP5 VOLT INT1 1

5725 165D VB SAMP5 VOLT INT1 1

5726 165E VC SAMP5 VOLT INT1 1

5727 165F VN SAMP5 VOLT INT1 1

5728 1660 DI SAMP5 SP 1

5729 1661 DO SAMP5 SP 1

5730 1662 PUFLG0 SAMP5 SP 1

5731 1663 PUFLG1 SAMP5 SP 1

5732 1664 PUFLG2 SAMP5 SP 1

5733 1665 PRFLG0 SAMP5 SP 1

5734 1666 PRFLG1 SAMP5 SP 1

5735 1667 PRFLG2 SAMP5 SP 1

5736 1668 SAMPPD SAMP5 SP 1

5737 1669 IAS SAMP6 AMP INT2 1

5738 166A IBS SAMP6 AMP INT2 1

5739 166B ICS SAMP6 AMP INT2 1

5740 166C INS SAMP6 AMP INT2 1
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5741 166D IAR AMP6 AMP INT2 1

5742 166E IBR SAMP6 AMP INT2 1

5743 166F ICR SAMP6 AMP INT2 1

5744 1670 INR SAMP6 AMP INT2 1

5745 1671 VA SAMP6 VOLT INT1 1

5746 1672 VB SAMP6 VOLT INT1 1

5747 1673 VC SAMP6 VOLT INT1 1

5748 1674 VN SAMP6 VOLT INT 1

5749 1675 DI SAMP6 SP 1

5750 1676 DO SAMP6 SP 1

5751 1677 PUFLG0 SAMP6 SP 1

5752 1678 PUFLG1 SAMP6 SP 1

5753 1679 PUFLG2 SAMP6 SP 1

5754 167A PRFLG0 SAMP6 SP 1

5755 167B PRFLG1 SAMP6 SP 1

5756 167C PRFLG2 SAMP6 SP 1

5757 167D SAMPPD SAMP6 SP 1

5758 167E IAS SAMP7 AMP INT2 1

5759 167F IBS SAMP7 AMP INT2 1

5760 1680 ICS SAMP7 AMP INT2 1

5761 1681 INS SAMP7 AMP INT2 1

5762 1682 IAR AMP7 AMP INT2 1

5763 1683 IBR SAMP7 AMP INT2 1

5764 1684 ICR SAMP7 AMP INT2 1

5765 1685 INR SAMP7 AMP INT2 1

5766 1686 VA SAMP7 VOLT INT1 1

5767 1687 VB SAMP7 VOLT INT1 1

5768 1688 VC SAMP7 VOLT INT1 1

5769 1689 VN SAMP7 VOLT INT1 1

5770 168A DI SAMP7 SP 1

5771 168B DO SAMP7 SP 1

5772 168C PUFLG0 SAMP7 SP 1

5773 168D PUFLG1 SAMP7 SP 1

5774 168E PUFLG2 SAMP7 SP 1
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5775 168F PRFLG0 SAMP7 SP 1

5776 1690 PRFLG1 SAMP7 SP 1

5777 1691 PRFLG2 SAMP7 SP 1

5778 1692 SAMPPD SAMP7 SP 1

5779 1693 IAS SAMP8 AMP INT2 1

5780 1694 IBS SAMP8 AMP INT2 1

5781 1695 ICS SAMP8 AMP INT2 1

5782 1696 INS SAMP8 AMP INT2 1

5783 1697 IAR AMP8 AMP INT2 1

5784 1698 IBR SAMP8 AMP INT2 1

5785 1699 ICR SAMP8 AMP INT2 1

5786 169A INR SAMP8 AMP INT2 1

5787 169B VA SAMP8 VOLT INT1 1

5788 169C VB SAMP8 VOLT INT1 1

5789 169D VC SAMP8 VOLT INT1 1

5790 169E VN SAMP8 VOLT INT1 1

5791 169F DI SAMP8 SP 1

5792 16A0 DO SAMP8 SP 1

5793 16A1 PUFLG0 SAMP8 SP 1

5794 16A2 PUFLG1 SAMP8 SP 1

5795 16A3 PUFLG2 SAMP8 SP 1

5796 16A4 PRFLG0 SAMP8 SP 1

5797 16A5 PRFLG1 SAMP8 SP 1

5798 16A6 PRFLG2 SAMP8 SP 1

5799 16A7 SAMPPD SAMP8 SP 1

5800 16A8 IAS SAMP9 AMP INT2 1

5801 16A9 IBS SAMP9 AMP INT2 1

5802 16AA ICS SAMP9 AMP INT2 1

5803 16AB INS SAMP9 AMP INT2 1

5804 16AC IAR AMP9 AMP INT2 1

5805 16AD IBR SAMP9 AMP INT2 1

5806 16AE ICR SAMP9 AMP INT2 1

5807 16AF INR SAMP9 AMP INT2 1

5808 16B0 VA SAMP9 VOLT INT1 1
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5809 16B1 VB SAMP9 VOLT INT1 1

5810 16B2 VC SAMP9 VOLT INT1 1

5811 16B3 VN SAMP9 VOLT INTO 1

5812 16B4 DI SAMP9 SP 1

5813 16B5 DO SAMP9 SP 1

5814 16B6 PUFLG0 SAMP9 SP 1

5815 16B7 PUFLG1 SAMP9 SP 1

5816 16B8 PUFLG2 SAMP9 SP 1

5817 16B9 PRFLG0 SAMP9 SP 1

5818 16BA PRFLG1 SAMP9 SP 1

5819 16BB PRFLG2 SAMP9 SP 1

5820 16BC SAMPPD SAMP9 SP 1

5821 16BD IAS SAMP10 AMP INT2 1

5822 16BE IBS SAMP10 AMP INT2 1

5823 16BF ICS SAMP10 AMP INT2 1

5824 16C0 INS SAMP10 AMP INT2 1

5825 16C1 IAR AMP10 AMP INT2 1

5826 16C2 IBR SAMP10 AMP INT2 1

5827 16C3 ICR SAMP10 AMP INT2 1

5828 16C4 INR SAMP10 AMP INT2 1

5829 16C5 VA SAMP10 VOLT INT1 1

5830 16C6 VB SAMP10 VOLT INT1 1

5831 16C7 VC SAMP10 VOLT INT1 1

5832 16C8 VN SAMP10 VOLT INT1 1

5833 16C9 DI SAMP10 SP 1

5834 16CA DO SAMP10 SP 1

5835 16CB PUFLG0 SAMP10 SP 1

5836 16CC PUFLG1 SAMP11 SP 1

5837 16CD PUFLG2 SAMP10 SP 1

5838 16CE PRFLG0 SAMP10 SP 1

5839 16CF PRFLG1 SAMP10 SP 1

5840 16D0 PRFLG2 SAMP10 SP 1

5841 16D1 SAMPPD SAMP10 SP 1

5842 16D2 IAS SAMP11 AMP INT2 1
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5843 16D3 IBS SAMP11 AMP INT2 1

5844 16D4 ICS SAMP11 AMP INT2 1

5845 16D5 INS SAMP11 AMP INT2 1

5846 16D6 IAR AMP11 AMP INT2 1

5847 16D7 IBR SAMP11 AMP INT2 1

5848 16D8 ICR SAMP11 AMP INT2 1

5849 16D9 INR SAMP11 AMP INT2 1

5850 16DA VA SAMP11 VOLT INT1 1

5851 16DB VB SAMP11 VOLT INT1 1

5852 16DC VC SAMP11 VOLT INT1 1

5853 16DD VN SAMP11 VOLT INT1 1

5854 16DE DI SAMP11 SP 1

5855 16DF DO SAMP11 SP 1

5856 16E0 PUFLG0 SAMP11 SP 1

5857 16E1 PUFLG1 SAMP11 SP 1

5858 16E2 PUFLG2 SAMP11 SP 1

5859 16E3 PRFLG0 SAMP11 SP 1

5860 16E4 PRFLG1 SAMP11 SP 1

5861 16E5 PRFLG2 SAMP11 SP 1

5862 16E6 SAMPPD SAMP11 SP 1

5863 16E7 IAS SAMP12 AMP INT2 1

5864 16E8 IBS SAMP12 AMP INT2 1

5865 16E9 ICS SAMP12 AMP INT2 1

5866 16EA INS SAMP12 AMP INT2 1

5867 16EB IAR AMP12 AMP INT2 1

5868 16EC IBR SAMP12 AMP INT2 1

5869 16ED ICR SAMP12 AMP INT2 1

5870 16EE INR SAMP12 AMP INT2 1

5871 16EF VA SAMP12 VOLT INT1 1

5872 16F0 VB SAMP12 VOLT INT1 1

5873 16F1 VC SAMP12 VOLT INT1 1

5874 16F2 VN SAMP12 VOLT INT1 1

5875 16F3 DI SAMP12 SP 1

5876 16F4 DO SAMP12 SP 1

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 19 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX



9-44 DGP Digital Generator Protection System GE Multilin

9.5 MODBUS MEMORY MAPPING 9 COMMUNICATIONS

9

5877 16F5 PUFLG0 SAMP12 SP 1

5878 16F6 PUFLG1 SAMP12 SP 1

5879 16F7 PUFLG2 SAMP12 SP 1

5880 16F8 PRFLG0 SAMP12 SP 1

5881 16F9 PRFLG1 SAMP12 SP 1

5882 16FA PRFLG2 SAMP12 SP 1

5883 16FB SAMPPD SAMP12 SP 1

OSCILLOGRAPHY CONTROL REGISTERS

6142 17FE Cycle Number INTO 1

6143 17FF Fault Number INTO 1

DGP STATUS

6144 1800 SSP STAT SP 1

6145 1801 DAP STAT SP 1

6146 1802 DSP1 STAT SP 1

6147 1803 DSP2 STAT SP 1

6148 1804 DSP3 STAT SP 1

6149 1805 ANI STAT SP 1

6150 1806 MMI STAT SP 1

6151 1807 MGM1 STAT SP 1

6152 1808 MGM2 STAT SP 1

6153 1809 DIT STAT SP 1

6154 180A PWR1 STAT SP 1

6155 180B PWR2 STAT SP 1

6156 180C MISC STAT SP 1

MMI PASSWORDS

7168 1C00 MASTER PSW ASCII 16

7184 1C10 SETT PSW ASCII 16

SETTINGS

16384 4000 Unit ID INTO 1

16385 4001 SYS FREQ HZ INTO 1

16386 4002 SEL TVM SP 1

16387 4003 SEL TCM SP 1

16388 4004 SELPRIM BOOLEAN 1

16389 4005 CT RATIO INTO 1

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 20 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX
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16390 4006 VT RATIO INT1 1

16391 4007 COMMPORT SP 1

16392 4008 PHASE BOOLEAN 1

16393 4009 TIMESYNC SP 1

16394 400A NUM FLTS INTO 1

16395 400B PREFLT INTO 1

16396 400C OSC TRIG BOOLEAN 1

16397 400D NOM VOLT VOLT INT1 1

16398 400E RATEDCUR AMP INT2 1

16399 400F VT CONN BOOLEAN 1

16400 4010 NCTRATIO INTO 1

16640 4100 87G TRIP SP 1

16641 4101 87G ALARM SP 1

16642 4102 87G K1 % INT1 1

16643 4103 87G PICKUP AMP INT2 1

16896 4200 46A ALARM SP 1

16897 4201 46A Pickup AMP INT2 1

16898 4202 46A TL14 SEC INTO 1

17152 4300 46T TRIP SP 1

17153 4301 46T ALARM SP 1

17154 4302 46T PICKUP AMP INT2 1

17155 4303 46T K2 SEC INT1 1

17408 4400 40 SELV2SUP BOOLEAN 1

17664 4500 40-1 TRIP SP 1

17665 4501 40-1 ALARM SP 1

17666 4502 40-1 CENTER OHM INT2 1

17667 4503 40-1 RADIUS OHM INT2 1

17668 4504 40-1 TL12 SEC INT2 1

17920 4600 40-2 TRIP SP 1

17921 4601 40-2 ALARM SP 1

17922 4601 40-2 CENTER OHM INT2 1

17923 4602 40-2 RADIUS OHM INT2 1

17924 4603 40-2 TL13 SEC INT2 1

18176 4700 32-1 TRIP SP 1

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 21 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX
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18177 4701 32-1 ALARM SP 1

18178 4702 32-1 SQ TR EN LONG0 1

18179 4703 32- 1 REV PWR WATT INT1 1

18180 4704 32-1 TL1 SEC INTO 1

18432 4800 32-2 TRIP SP 1

18433 4801 32-2 ALARM SP 1

18434 4802 32- 2 REV PWR WATT INT1 1

18435 4803 32-2 TL2 SEC INTO 1

18688 4900 51V TRIP SP 1

18689 4901 51V ALARM SP 1

18690 4902 51V PICKUP AMP INT1 1

18691 4903 51V TIMEFAC SEC INT2 1

18944 4A00 64G1 TRIP SP 1

18945 4A01 64G1  ALARM SP 1

18946 4A02 64G1  PICKUP VOLT INT1 1

18947 4A03 64G1 TL4 SEC INT1 1

19200 4B00 64G2 TRIP SP 1

19201 4B01 64G2  ALARM SP 1

19202 4B02 64G2 TL5 SEC INT1 1

19456 4C00 24A  ALARM SP 1

19457 4C01 24A  PICKUP PER UNIT INT2 1

19458 4C02 24A TL6 SEC INT1 1

19712 4D00 24T TRIP ON_line SP 1

19713 4D01 24T TRIP OFF-line SP 1

19714 4D02 24T  ALARM SP 1

19715 4D03 24T CURVE # INTO 1

19716 4D04 24T INV PU PER UNIT INT2 1

19717 4D05 24T TIME FAC SEC INT2 1

19718 4D06 24T INST PU PER UNIT INT2 1

19719 4D07 24T TL7 SEC INT1 1

19720 4D08 24T RESET SEC INTO 1

19968 4E00 59 TRIP SP 1

19969 4E01 59  ALARM SP 1

19970 4E02 59 INV PU VOLT INTO 1

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 22 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX
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19971 4E03 59 TIME FAC SEC INT2 1

19972 4E04 59 CURVE # INTO 1

19973 4E05 59 INST PU VOLT INTO 1

20224 4F00 81 UV CUTOFF % INTO 1

20480 5000 81-1U TRIP SP 1

20481 5001 81-1U ALARM SP 1

20482 5002 81-1U SETPNT HZ INT2 1

20483 5003 81-1U TL8 SEC INT1 1

20736 5100 81-2U TRIP SP 1

20737 5101 81-2U ALARM SP 1

20738 5102 81-2U SETPNT HZ INT2 1

20739 5103 81-2U TL9 SEC INT2 1

20992 5200 81-3U TRIP SP 1

20993 5201 81-3U ALARM SP 1

20994 5202 81-3U SETPNT HZ INT2 1

20995 5203 81-3U TL10 SEC INT2 1

21248 5300 81-4U TRIP SP 1

21249 5301 81-4U ALARM SP 1

21250 5302 81-4U SETPNT HZ INT2 1

21251 5303 81-4U TL11 SEC INT2 1

21504 5400 81-1O TRIP SP 1

21505 5401 81-1O ALARM SP 1

21506 5402 81-1O SETPNT HZ INT2 1

21507 5403 81-1O TL15 SEC INT2 1

21760 5500 81-2O TRIP SP 1

21761 5501 81-2O ALARM SP 1

21762 5502 81-2O SETPNT HZ INT2 1

21763 5503 81-2O TL16 SEC INT2 1

22016 5600 81-3O TRIP SP 1

22017 5601 81-3O ALARM SP 1

22018 5602 81-3O SETPNT HZ INT2 1

22019 5603 81-3O TL17 SEC INT2 1

22272 5700 81-4O TRIP SP 1

22273 5701 81-4O ALARM SP 1

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 23 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX
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22274 5702 81-4O SETPNT HZ INT2 1

22275 5703 81-4O TL18 SEC INT2 1

22528 5800 DIG INP SELBKD11 INTO 1

22529 5801 DI3 TRIP SP 1

22530 5802 DI3 ALARM SP 1

22531 5803 DI3 TIMER SEC INT2 1

22532 5804 DI4 TRIP SP 1

22533 5805 DI4 ALARM SP 1

22534 5806 DI4 TIMER SEC INT2 1

22535 5807 DI6 FUNC BOOLEAN 1

22784 5900 VTFF BOOLEAN 1

23040 5A00 AE TRIP SP 1

23041 5A01 AE ALARM SP 1

23042 5A02 AE ARM BOOLEAN 1

23296 5B00 51GN TRIP SP 1

23297 5B01 51GN ALARM SP 1

23298 5B02 51GN PICKUP AMP INT2 1

23299 5B03 51GN TIME FAC SEC INT2 1

23552 5C00 27 TRIP SP 1

23553 5C01 27 ALARM SP 1

23554 5C02 27 PICKUP VOLT INTO 1

23555 5C03 27 TIME FAC SEC INT2 1

23556 5C04 27 CURVE # INTO 1

23808 5D00 27TN TRIP SP 1

23809 5D01 27TN ALARM SP 1

23810 5D02 27TN  PICKUP VOLT INT1 1

23811 5D03 27TN TL20 SEC INT1 1

23812 5D04 27TN FORPWR_L WATT INTO 1

23813 5D05 27TN FORPWR_H WATT INTO 1

GENERATOR AND STATION ID

32256 7E00 STATION ID ASCII 32

32288 7E20 GENERATOR ID ASCII 32

Table 9–3: DGP MODBUS MEMORY MAP (Sheet 24 of 24)

ADDRESS ITEM NAME UNITS FORMAT NO. OF
REGISTERSDEC HEX
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9.6 COIL COMMANDS 9.6.1 DESCRIPTION

The following coil commands are accepted by the DGP relay. Multiple commands are not supported. They can
be executed only by the function code 05H. Both the hexadecimal and decimal coil addresses are offset.

* END COMMAND must be sent after new settings are sent to the DGP.

Table 9–4: COIL COMMANDS

ADDRESS COIL COMMAND

DEC HEX

0 0 END COMMAND*

1 1 ENABLE OUTPUT

1 1 DISABLE OUTPUT

2 2 RESET FAULT

3 3 RESET EVENTS

4 4 RESET TARGET

100 64 END RELAY TEST

101 65 RELAY TEST 87G

102 66 RELAY TEST 46A

103 67 RELAY TEST 46T

104 68 RELAY TEST 40-1

105 69 RELAY TEST 40-2

106 6A RELAY TEST 32-1

107 6B RELAY TEST 32-2

108 6C RELAY TEST 51V

109 6D RELAY TEST 64G1

110 6E RELAY TEST 64G2

111 6F RELAY TEST 24A

112 70 RELAY TEST 24T

113 71 RELAY TEST 59

114 72 RELAY TEST 81-1U

115 73 RELAY TEST 81-2U

116 74 RELAY TEST 81-3U

117 75 RELAY TEST 81-4U

118 76 RELAY TEST 81-1O

119 77 RELAY TEST 81-2O

120 78 RELAY TEST VTFF

121 79 RELAY TEST AE

122 7A RELAY TEST 51GN

123 7B RELAY TEST 27

124 7C RELAY TEST 27TN

200 C8 END DO TEST

201 C9 DO TEST 94G

202 CA DO TEST 94G1

203 CB DO TEST 94G2

204 CC DO TEST 94G3

205 CD DO TEST 74A

206 CE DO TEST 74B

207 CF DO TEST 74C

208 D0 DO TEST 74D

209 D1 DO TEST 74CR

210 D2 DO TEST 74NC

211 D3 DO TEST 74FF

300 12C TRIB BRKR 94G

301 12D TRIB BRKR 94G1

302 12E TRIB BRKR 94G2

303 12F TRIB BRKR 94G3

Table 9–4: COIL COMMANDS

ADDRESS COIL COMMAND

DEC HEX
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9.7 FACTORY SETTINGS (GE FACTORY TESTS ONLY) 9.7.1 DESCRIPTION

Normally the user can change the settings only if the settings that are in the relay are not corrupted. In a brand
new relay the contents of the EEPROM are undefined. Therefore the factory settings command should be used
to program the relay. 

The factory command will be executed when the master sends the command with a slave address 0FFH (255
decimal). Note that slave address 255 is not a valid modbus slave address and is being used by the relay only
for GE internal factory commands.

The DGP relay will not respond to a CRC failure, if the slave address is 255. When the relay is placed in multi-
drop configuration, it possible to receive a slave ID of 255, due to some communication error. Therefore the
relay will not respond.

The only function IDs supported in Factory command are 10H, 06H, and 05H with a coil address correspond-
ing to the END (29H).

The factory settings are down loaded in three groups.

• Settings

• Station and Generator ID

• Model Number

After the factory settings are downloaded, the MASTER should send a END command with slave address 255
to make the changes effective.

The Settings and Station Generator ID will have the same register map as described in previous sections. The
model number can be written into registers 0000 to 000FH. Normally the model number registers are Read
Only registers. The only exception where they can be written are with factory commands.
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10 DGP-PC SOFTWARE 10.1 INTRODUCTION 10.1.1 OVERVIEW

The Settings and Station Generator ID will have the same register map as described in previous sections. The
model number can be written into registers 0000 to 000FH. Normally the model number registers are Read
Only registers. The only exception where they can be written are by. using factory command

10.1.2 SYSTEM REQUIREMENTS

a) HARDWARE

• Minimum: X86 – based PC (Pentium or higher is recommended).

• High performance multiple serial port board. The driver for the serial board should be pre-installed
and configured (the system has been tested with the Equinox AT serial interface boards and also
with the standard COMM ports of the PC). 

• If a modem is used, it should be installed and the driver should be TAPI compatible.

b) SOFTWARE

• Windows NT 4.0 (SP 3 or later) or Windows 95/98.

• Minimum of 32 MB RAM.

• If a modem is used for communications, the modem driver must be installed and functional.

• PKZip software for DGP-PC file extraction.

10.1.3 INSTALLATION

1. Insert the GE Multilin Products CD into your local CD-ROM drive or point your web browser to the GE Mul-
tilin website at www.GEindustrial.com/pm. Under Windows 95/98, the Products CD will automatically
launch the welcome screen. Since the Products CD is essentially a “snapshot” of the GE Multilin website,
the installation procedures from the CD and the web are identical.

2. Click the Index by Product Name item from the main page and select DGP Digital Generator Protection
from the products list to open the DGP products page.

3. Click the Software item from the Product Resources list to go to the DGP software page.

4. The latest version of DGP-PC will be listed, along with additional installation instructions and release
notes. Click on the DGP-PC Version 2.0 (supports DGP) menu item to download the installation program to
your local PC. Run the installation program and follow the prompts to install the software in the desired
directory. When completed, a new GE Multilin group window will appear containing the DGP-PC icon.
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10.2 GENERAL OPERATION 10.2.1 PROTECTION JUMPERS

In order to have complete remote control of the unit, the factory-installed jumpers J1 and J2 of the MMI module
must be removed. Installing J1 disables remote closing of all of the output relays. Installing J2 disables all
remote setting changes and the disable/enable of outputs (see Figure 3–4: DGP MMI MODULE on page 3–5).

10.2.2 DGP-PC USER INTERFACE

All user actions are classified into these categories.

• Adding/Modifying/Deleting a Site (Location).

• Adding/Modifying/Deleting an IED.

• Modes of operation.

• Connecting to and disconnecting to an IED.

• Retrieving information from an IED.

• Read/Send setting changes from/to IED.

• Send control commands to IED.

• Copy/Paste/Print Settings.

10.2.3 ADDING/MODIFYING A SITE (LOCATION)

The diagram below shows how to add a new Location.

After adding, click the Save button to save the site in the database. To modify the properties of the site, click on
the site and change the name / description and then click the Save button.

Site Properties

Click on this button to add
a new site, or select the

menu item.File > Add New Location
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10.2.4 DELETING A SITE (LOCATION)

To delete a site:

1. Delete all IEDs associated with that site.

2. Select the Site and click the Delete button or the Delete menu icon (shown in the diagram below).

The diagram below shows how to delete a site.

Click on either of these
to delete the “New Site”
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10.3 IED CONNECTION 10.3.1 SERIAL CONNNECTION

1. Click the Connect to Relay menu icon or select the Communication > Connect Relay menu item.

2. If prompted for a password, enter the password appropriate to the desired access level and click OK.

3. To disconnect, click on the Disconnect button.

If an incorrect password is entered on three consecutive tries using DGP-PC, the DGP will dis-
play "WARN 60" and the 74NC relay will operate. To remove this condition, the user must log
in and log out correctly using DGP-PC.

10.3.2 MODEM CONNECTION

1. Click on Make Call menu icon or select the Communication > MakeCall menu item.

2. Enter the telephone number in the prompted dialog box and click OK.

3. DGP-PC will try to make the telephone connection with the remote modem. If the modem connection is
successful, click the Connect to Relay menu icon or select the Communication > Connect Relay menu
item.

4. If prompted for a password, enter the appropriate password for the desired access level and click OK. 

5. To disconnect, click on the Disconnect Relay icon or select the Communication > Disconnect Relay
menu item.

6. To hang up click on the Hang Up icon or select the Communication > Hangup menu item.

After disconnecting one relay, the user can connect to another relay on the same telephone
line without hanging up the telephone connection.

Connect to Relay Button

NOTE

Make Call menu icon

Disconnect Relay menu icon

Hang Up menu icon

NOTE
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10.3.3 IED MODES

A mode is the current state of the IED. The mode indicates whether the IED is connected or not, and if con-
nected, the access level of the connection.

The possible modes are:

• EDIT MODE: When the IED is in disconnected mode.

• VIEW MODE: When the IED is connected with the access level – VIEW.

• SETT MODE: When the IED is connected with the access level – SETTINGS.

• CTRL MODE: When the IED is connected with the access level – CONTROL.

10.3.4 ADDING/MODYFYING AN IED

a) ADDING AN IED

Figure 10–1: IED PROPERTIES WINDOW

The mode of the selected IED will be displayed on
the right bottom corner of the status bar pane.
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1. For any IED Type (except DGP with Modbus communication) the user must enter all three passwords (Set-
tings, View, and Control). Remote passwords can be obtained from the MMI and decoded to get the Set-
tings Password, Control Password, and View Password.

2. If a switch is being used as a multiplexer to have multiple IEDs on the same port, the Switch Code and
Termination Code need to be entered. These codes are dependent on the switch being used. If no
switches being used, leave them blank.

3. The Phone No must be entered without any spaces or hyphens between the digits. Also, the complete
number (including any long distance prefixes) needs to be entered. When using a modem line, enter the
telephone number of the modem connected to the relay.

4. The PC modem COM Port (where DGP-PC is running) must be entered even when using a modem. 

5. Optionally, the Modem INIT String can be used to initialize the modem. The INIT string should be con-
structed using the modem setting commands.

6. Click the Save button to save the IED. DGP-PC will populate the Information, Settings and Operations
branches under the IED in the Tree.

b) MODIFYING IED PROPERTIES

1. The IED must be placed in the Disconnected STATE or EDIT MODE.

2. Make any necessary changes as shown earlier.

3. Click the Save button to save the changes.

c) DELETING AN IED

1. The IED must be placed in the Disconnected state or EDIT MODE.

2. Select the appropriate IED to be deleted.

3. Click the Delete icon or select the File > Delete Menu menu item.

10.3.5 RETREIVING INFORMATION

1. When connected to an IED, DGP-PC retreives Settings and non-settings information.

2. Click on a specific category in the Tree directly after the connection is established. DGP-PC retrieves the
data from the IED.

3. Subsequent access to a specific setting only shows the information last retreived. To view the most
updated Settings information, click the Settings category then the Refresh icon (or select the Edit >
Refresh menu item). DGP-PC reads the latest setting changes and updates the Settings screen.

All three types of
passwords must
be entered!
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4. The retrieved data is displayed in the Spread control as shown below.

To retreive data for a category, first
select the category from the tree,
(shown at left) then click on the 
Refresh button (shown above).
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10.4 MANIPULATING SETTINGS 10.4.1 EDIT MODE

1. When a new IED is created, DGP-PC creates new Default Settings for it.

2. The user can select an IED, edit the default settings, then save it to local file. To save the settings to a file
select the File > Save Settings To File menu item or click the Save icon.

3. This action can be performed before connecting to an IED or while DGP-PC is in the EDIT MODE (see
SETTINGS MODE below).

10.4.2 SETTINGS MODE

Access to settings changes requires the user to log into the DGP with the appropriate Settings password (not
required for Modbus DGP models).

Settings changes are made by clicking on a cell (data value) and entering the new data.

• If the data value is a drop-down list, select the new value in the list.

• If the data value is a check box, check or uncheck the box.

• If the data value is an edit box, enter the new value (within the range specified by the MIN and MAX val-
ues).

Data range and validation check will NOT be performed by DGP-PC.

To send changes to the DGP, click on another cell then click the Send Settings icon or select the Control >
Send Settings to Relay menu item. 

To make changes to another setting, select the setting and follow the above procedure.

DGP settings can also be saved to a file by selecting the File > Save Settings to File menu item or clicking the
Save Settings icon. This file can be opened any time for the same IED or any IED of the same type and model.

DGP-PC Operation Required Access Level

Change Password Any Level

Manual Trip Actions Level

Enable Outputs Actions Level

Disable Outputs Actions Level

Change Time and Date Settings Level

Change Station/ Generator Id Settings Level

Calculate CRC Any Level

Relay Test Actions Level

Digital Output Test Actions level

Settings Changes Settings Level

Data Reset Actions Level

CAUTION
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10.5 PERFORMING OPERATIONS 10.5.1 DESCRIPTION

The user must be logged in with Control access for access to control operations (not required for DGP with
Modbus protocol). To access control operations, double click on the Operations branch to expand its tree to
select the appropriate operation.

10.5.2 CHANGE PASSWORD

This item allows the user to change the DGP password. The valid password characters are A to Z, 0 to 9, and
space. The factory default password contains one or more characters that are not valid. The communications
password can only be viewed in encrypted form on the MMI; as such, it is IMPORTANT that the user keep a
record of the password in a safe place.

1. To change the password, double-click click Change Password in the Operations branch.

2. Enter the present password then enter the new password.

3. If the new password is valid, it must be entered again.

4. Click the OK button to change the password.

10.5.3 MANUAL TRIP

This item allows the the output relays to be operated manually. Each of the four DGP output relays (94G, 94G1,
94G2, and 94G3) may be operated individually. Note that the relays cannot be operated if the appropriate
jumper is installed (see Figure 3–3: DGP POWER SUPPLY MODULE on page 3–4 for the location and
description of the jumpers). 

1. To select Manual Trip, click Manual Trip in the Operations branch.

2. DGP-PC responds with a selection box showing the four output relays. Select the desired relay and click
OK.

3. The relay operates and DGP-PC returns to the Manual Trip item menu.

10.5.4 ENABLE OUTPUTS

This item permits the DGP to energize the relay outputs. Note that the digital outputs cannot be enabled
remotely if the appropriate jumper is installed (see Figure 3–4: DGP MMI MODULE on page 3–5 for the loca-
tion and description of the jumpers). 

1. Select the Enable Outputs item in the Operations branch.

2. Click YES to enable the outputs.

10.5.5 DISABLE OUTPUTS

This item inhibits the DGP from energizing any of the relay outputs except for the Critical Alarm output, the
Non-critical Alarm output, the Test Pickup output, and the Test Trip output. Note that the digital outputs cannot
be disabled if the appropriate jumper is installed (see Figure 3–4: DGP MMI MODULE on page 3–5 for the
location and description of the jumpers).

1. Select the Disable Outputs item from the Operations branch.

2. Click YES to disable the outputs.
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10.5.6 CHANGE DATE & TIME

This item sets the time and date in the DGP. Changing the time and date through this menu does not affect the
time and date in the PC.

1. Select the Change Date and Time item from the Operations branch to display the current time and date.

2. The time is displayed in 24-hour format HH:MM:SS and the date in format MM/DD/YY. Click YES to display
the Change Date and Time edit box.

3. Enter the new date and/or time and click OK to accept changes.

10.5.7 CHANGE GENERATOR/STATION ID

This menu item displays the station and generator ID for the relay. The IDs can be up to 32 characters long and
must be all printable characters.

1. Select the Change Station/Generator ID item from the Operations branch.

2. DGP-PC responds with an edit box. Enter the new station and generator ID.

3. Click OK to accept changes.

10.5.8 RELAY TEST

This item allows the user to test the relay functions.

1. Select the Relay Test Mode item from the Operations branch to view the relay tests.

2. Select the desired test from the list box then click Begin Test.

3. Put the relay back in operating mode by clicking End Test Mode when the test is complete.

4. Repeat this process for each selected relay test.

10.5.9 DIGITAL OUTPUT TEST

This item allows performs digital output tests in the relay.

1. Select the Digital Output Test item from the Operations branch to view the digital output tests.

2. Select the desired test from the list box and click Begin Test.

3. To select another digital output, click End Test tjem select another test from the list. 

4. Click Cancel to exit the Digital Output Test.

10.5.10 DIGITAL RESET

This item allows the user to reset various data items contained in the relay. The data items are displayed in a
Check Box.

1. Select the Digital Reset item from the Operations branch.

2. Select the data item to be reset by checking it and clicking OK.

3. The data item is reset and DGP-PC returns to the Digital Reset item.



GE Multilin DGP Digital Generator Protection System 10-11

10 DGP-PC SOFTWARE 10.6 GETTING INFORMATION

10

10.6 GETTING INFORMATION 10.6.1 DESCRIPTION

All Information data values are read only once upon entry to the respected Information Item. If the
user exits from any item and then re-enters, the refresh button must be activated to update the most
recent data values.

10.6.2 PRESENT VALUES

This item allows the user to display, print, or copy the present values to a file.

1. Select the Present Values item from the Information branch.

2. To print present values, click on the Print Icon or select the File > Print menu item.

3. Select the data values to copy by holding down the left mouse button and dragging the mouse icon over
the data values.

4. Select the Edit > Copy menu item to copy the selection.

5. The copied data can be pasted to another application (such as Notepad) and then saved to a file.

10.6.3 FAULT REPORT IDENTIFICATION

This item allows the user to display, print, or copy the identification of each fault report. This includes the time,
date, and trip type for each fault. This information allows the user to determine easily which fault to examine.

1. Select the Fault Report Identification item from the Information branch.

2. To print the Fault Report Identification screen, click the Print icon or select the File > Print menu item.

3. Select the data values to copy by holding down the left mouse button and dragging the mouse icon over
the data values.

4. Select the Edit > Copy menu item to copy the selection.

5. The copied data can then be pasted to another application.

10.6.4 FAULT REPORT

This item allows the user to display, print, or copy the Fault Report and its associated events.

1. Select the Fault Report item from the Information branch.

2. To print the Fault Report screen, click the Print icon or select the File > Print menu item.

3. Select the data values to copy by holding down the left mouse button and dragging the mouse icon over
the data values.

4. Select the Edit > Copy menu item to copy the selection.

5. The copied data can then be pasted to another application.

10.6.5 EVENTS LOG

This item allows the user to display, print or copy events stored in the relay.

1. Select the Events Log item from the Information branch.

2. To print the Events Log screen, click the Print icon or select the File > Print menu item.

NOTE
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3. Select the data values to copy by holding down the left mouse button and dragging the mouse icon over
the data values.

4. Select the Edit > Copy menu item to copy the selection.

5. The copied data can then be pasted to another application.

NOTE: If DC power is removed for more than 24 hours, all event information may be lost.

10.6.6 OSCILLOGRAPHY DATA

For applicable models, this item allows oscillography data for a particular fault to be saved on disk.

Select the Oscillography Data item from the Information branch and follow the DGP-PC prompts.

10.6.7 DGP STATUS

This item allows the user to display, print, or copy the DGP status. 

1. Select the DGP Status item from the Information branch.

2. To print the DGP Status screen, click the Print icon or select the File > Print menu item.

3. Select the data values to copy by holding down the left mouse button and dragging the mouse icon over
the data values.

4. Select the Edit > Copy menu item to copy the selection.

5. The copied data can then be pasted to another application.

10.6.8 DGP MODEL

This item allows the user to display, print, or copy the DGP model and PROM version number. 

1. Select the DGP Model item from the Information branch.

2. To print the DGP Model screen, click the Print icon or select the File > Print menu item.

3. Select the data values to copy by holding down the left mouse button and dragging the mouse icon over
the data values.

4. Select the Edit > Copy menu item to copy the selection.

5. The copied data can then be pasted to another application.

10.6.9 STATION/GENERATOR ID

This item allows the user to display, print or copy the Station and Generator ID number. Select the Station/Gen-
erator ID item from the Information menu and follow the instructions above to print and/or copied the data.

10.6.10 MMI PASSWORD

This item allows the user to display, print or copy the MMI Password. Select the MMI Password item from the
Information menu and follow the instructions above to print and/or copied the data.
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APPENDIX B REVISIONSB.1 CHANGE NOTES B.1.1 REVISION HISTORY

B.1.2 ADDITIONS TO DGP MANUAL

Table B–1: REVISION HISTORY

MANUAL P/N DGP REVISIONS RELEASE DATE

GEK-100666 --- ---
GEK-100666A --- ---
GEK-100666B V210.12000P March 07, 2000
GEK-100666C V210.12000P, V212.00000F

V211.22000J, V210.12000D
July 28, 2000

GEK-100666D V210.22000P, V210.10000F
V211.32000J, V210.22000D

December 21, 2000

GEK-100666E V210.32000P, V212.10000F
V211.32000J, V210.22000D

October 1, 2002

GEK-100666F V210.32000P, V212.10000F
V211.32000J, V210.22000D

February 20, 2003

Table B–2: MAJOR UPDATES FOR DGP MANUAL GEK-100666F

Page
(100666E) Change From To

(in GEK-100666F)

No revisions were made to the firmware. There were no additions to the manual content, only some minor 
changes (see following section).

Table B–3: ADDITIONS TO DGP MANUAL GEK-100666E 

PAGE IN
GEK-100666D

ADDITION
(to GEK-100666E)

2-28 In Section 2.3.10: STATOR GROUND FAULT (27TN):
“Settings 3003: PICKUP, 3005: FORPWR-L, and 3006: FORPWR-H require measurements to 
determine proper settings. The DGP measures and displays 3rd harmonic voltage (THIRD 
HARMONIC N) at the generator terminals. The 3rd harmonic voltage varies at very low forward power 
levels and in many cases is non-zero when the generator is starting and becomes lower (or zero) in a 
certain band of forward power. Is is recommended that the 3rd harmonic voltage related to forward 
power is recorded as the unit is started and ran to full load to determine the exact values for PICKUP, 
FORPWR-L, and FORPWR-H.”

2-50 Added 27TN settings to Commissioning Table for the DGP***ABA relay.

7-1 In CONTACT DATA Trip Outputs specifications:
“Leakage Current: 2.36 mA (average)”

C-4 Added the following Question and Answer to the FAQ list in Section C.1.2:

“20. What should I do if an ERROR message is displayed on the DGP relay?
Besides following the instructions outlined in Section 6.3: TROUBLESHOOTING on page 6–4, it is rec-
ommended to turn off power to the relay and reseat any “suspect” card. Shipping or excess vibrations
may have caused this problem. Please perform this procedure before swapping a module from another
DGP relay.”

NOTE
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Table B–4: ADDITIONS TO DGP MANUAL GEK-100666D

PAGE IN
GEK-100666C

ADDITION
(to GEK-100666D)

Minor revisions were made to the firmware. There were no additions to manual content.

Table B–5: ADDITIONS TO DGP MANUAL GEK-100666C 

PAGE IN
GEK-100666B

ADDITION
(to GEK-100666C)

1-2 Undervoltage entry in Table 1-2: DGP SELECTION GUIDE
1-3 Section 1.14 for the DEC 1000

2-11 “112: PREFLT – PREFAULT CYCLES
PREFLT selects the number of pre-trigger (or pre-fault) cycles in each oscillography data set. It can be
set from 1 to 20. Setting 111: NUM FLTS determines the total number of cycles per storage event, as
explained above, and PREFLT determines how many of these are pre-trigger cycles.

113: OSC TRIG – EXTERNAL OSCILLOGRAPHY TRIGGER
A DGP system trip always causes oscillography to be stored. OSC TRIG enables or disables an addi-
tional oscillography trigger by an external digital input (DI5). Refer to Section 1.4.9: FAULT REPORT &
OSCILLOGRAPHY DATA on page 1–22 for further explanation. OSC TRIG may be set to 0 (DI ENA)
or 1 (DI DIS).”

2-22 In Section 2.37: OVERCURRENT WITH VOLTAGE RESTRAINT

“V =  for Wye connected VTs (see note 2)
phase-to-phase voltage for Delta connected VTs”

2-41 Added separate DGP Settings Tables for DGP***AAA, DGP***ABA, and DGP***ACA

4-23 Added the following step in the T10 procedure of Section 4.7.7:
“5. Reduce Ia to 0 A”

4-25 Added the following to Step 4 of the T13 procedure of Section 4.7.10:

4-25 Added the following note to the T13 procedure of Section 4.7.10:
VA, VB, and VC must change from 70 V rms to 29 V rms with the source voltage continuously on.

4-30 Added a column for Frequency in Table 4-6: VOLTAGE INPUTS FOR TEST T16

--- Added FREQUENTLY ASKED QUESTIONS Appendix

NOTE

3 phase-to-ground voltage×

“Set the current inputs according to the Table below:

Table 4–4: CURRENT INPUTS FOR TEST T13

PHASE A PHASE B PHASE C

MAG. PHASE MAG. PHASE MAG. PHASE

0.45 (0.09) A 0° 0.45 (0.09) A –120° 0.45 (0.09) A –240°
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B.1.3 CHANGES TO DGP MANUAL

Table B–6: ADDITIONS TO DGP MANUAL GEK-100666B

PAGE IN
GEK-100666A

ADDITION
(to GEK-100666B)

1-3 Figure 1-1: TYPICAL WIRING DIAGRAM
1-3 Figure 1-2: SINGLE LINE DIAGRAM

8-2 Figure 8-1: TARGET LEDS
8-2 Figure 8-2: MMI KEYPAD

9-4 Section 9-2: MODBUS COMMUNICATIONS

--- Chapter 10: GE-LINK SOFTWARE
--- Appendix A: TABLES AND FIGURES
--- Appendix B: CHANGE NOTES
--- Appendix C: DGP WARRANTY
--- Added an Index
--- Reference to GE Multilin Website on back page

Table B–7: MAJOR UPDATES FOR DGP MANUAL GEK-100666F

Page
(100666F) Change From To

(in GEK-100666E)

Title Updated “P/N: GEK-100666E” “P/N: GEK-100666F”
Title Removed “NOTE: All relays must be powered up at 

least once per year to avoid deterioration of 
electrolytic capacitors and subsequent 
relay failure.”
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Table B–8: MAJOR UPDATES FOR DGP MANUAL GEK-100666E 

Page
(100666D) Change From To

(in GEK-100666E)

--- Updated All instances of “GE Power Management” “GE Multilin”
--- Updated All instances of “GE-Link” “DGP-PC”

Title Updated “P/N: GEK-100666D” “P/N: GEK-100666E”
Title Updated “www.GEindustrial.com/pm” “www.GEindustrial.com/multilin”

1-5 Updated Typical Wiring Diagram (704753A7) Typical Wiring Diagram (704753A9)

3-3 Updated Front and Rear View (704752A8) Front and Rear View (704752A9)

7-1 Corrected “Trip Voltage Monitor: 30 to 3000 V DC” “Trip Voltage Monitor: 30 to 300 V DC”

9-18 Corrected “DIGITAL INPUT 6 CLOSED” “EXTERNAL VTFF CLOSED”
9-18 Corrected “DIGITAL INPUT 6 OPEN” “EXTERNAL VTFF OPEN”

Table B–9: MAJOR UPDATES FOR DGP MANUAL GEK-100666D

Page
(100666C) Change From To

(in GEK-100666D)

Minor revisions were made to the firmware. There were no updates of manual content.

NOTE
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Table B–10: MAJOR UPDATES FOR DGP MANUAL GEK-100666C 

Page
(100666B) Change From To

(in GEK-100666C)

Title Updated “P/N: GEK-100666B” “P/N: GEK-100666C”
Title Updated “www.ge.com/indsys/pm” “www.GEindustrial.com/pm”

1-1 Modified “MMI - CONTROL” in step 3 table “MMI - MASTER”
1-5 Updated Typical Wiring Diagram (704753A6) Typical Wiring Diagram (704753A7)

2-13 Corrected

2-16 Corrected

4-12 Corrected In Figure 4-3, the table row:

4-16 Corrected In Figure 4-5, the text: “BH6 or TP2-12” “BH6 or TP1-12”
4-19 Corrected In Figure 4-6, the output of the upper sin-

gle-phase current source: “IR”
“IS”

4-25 Modified “8. Change the voltage of all three phases 
to 35 V RMS...”

“8. Change the voltage of all three phases 
to 29 V RMS...”

4-25 Modified “9. Repeat Step 4.” “9. Verify that the test pickup and test trip 
operates in 5.00 to 5.05 seconds.”

4-26 Corrected In Figure 4-8, the description of the upper 
source from:
“3-PHASE, 4-WIRE CURRENT SOURCE”

“3-PHASE 4-WIRE VOLTAGE SOURCE”

4-27 Corrected In Table 4-4, the magnitude of the phase C 
test voltages from “70V” for Test A and 
“70V” for Test B

“3.8 V” for Test A
“4.2 V” for Test B

4-28 Corrected In Figure 4-9, the text “BH12 or TP2-21” “BH12 or TP1-21”
4-32 Replaced Table 4-8 Updated Table 4-8
4-37 Corrected In Section 4.7.24,

“(2601) VTFF = ENABLE (1)”
“(2601) VTFF = DISABLE (0) – set for 
TEST mode only” 

7-1 Modified “RMS measurements: ±3%” RMS measurements: ±3% of reading”

9-1 Corrected In Section 9.1.3,
“ATEL0L0Q0S7=60V0X4Y0”

“ATEL0L3Q0S7=60V0X4Y0”

I1 I2– K I1 I2⋅( )> I1 I2–
2 K I1 I2⋅( )>

T K2
I2 IFL⁄ 2
------------------=   seconds T K2

I2 IFL⁄( )2
-----------------------=   seconds

74NC AF8 AG10 74NC AF8 AG8
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Table B–11: MAJOR UPDATES FOR DGP MANUAL GEK-100666B

Page
(100666A) Change From To 

(page of GEK-100666B)

Title Modified “DGP Revision: V0001.02AA10” “DGP Revision: V210.L1200P”
Title Modified “P/N: GEK-100666A” “P/N: GEK-100666B’
Title Updated GE address

2-1 Updated DGP System settings and ratings
2-22 Updated Added k=1 curve on 46T graph

3-6 Modified Figure 3-2, 3-3, and 3-4 Replaced all with Figure 3-2

4-5 Updated Using DGP-Link section Using GE-Link Section

--- Updated all instances of “GE Multilin” “GE Power Management”
--- Updated all references to “DGP-Link” “GE-Link”
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APPENDIX C DGP FAQC.1 DGP FAQ C.1.1 FREQUENTLY ASKED QUESTIONS

1. Why does my DGP display a "351" error code?

The current inputs INS and INR are derived from the residual connections of the respective phase CTs and do
not require dedicated neutral CTs. Zero-sequence current at system and/or neutral side of the generator stator
windings is calculated and compared with the measured INS and/or INR values by the DGP as part of a back-
round self-test. If they do not match, a 351 error code is generated.

2. Why can't I get the 27 function (undervoltage) to operate?

The 27 element operates when the generator is considered on-line. The DGP recognizes the on-line status DI1
"Generator Off-Line". An Auxiliary b contact will allow the DGP to interpret the correct generator status.

3. How do I order replacement parts for my DGPs?

The following table shows the replacement part numbers and their availability for the DGP:

4. I have an older version of DGPxxxAAA firmware. What upgrade kit do I order to upgrade my
DGPxxxAAA to the latest firmware revision?

Use kit 0355A3489G0001.

MODULES DGPxxxAAA DGPxxxABA DGPxxxACA

SSP301 " " "

ANI301 " " "

DAP201 " " "

DSP401 " " "

MGM781 - specify 1A or 5A " " "

MMI301 " " "

0215B8070G0004 " 48 V DC " 48 V DC " 48 V DC

0215B8070G0005 " 125 V DC " 125 V DC " 125 V DC

0215B8070G0006 " 250 V DC " 250 V DC " 250 V DC

DIT 103 "

DIT 101 "

DIT 102 "

UNDERVOLTAGE (1)

GEN.
OFF-LINE

+

DI1

AND
27
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5. I have an older version of DGPxxxABA firmware. What upgrade kit do I order to upgrade my
DGPxxxABA to the latest firmware revision?

Use kit 0358A1186G0001.

6. I ordered a DGPxxxABA but received a DGPxxxABA-0005.

The DGPxxxABA-0005 is the standard version for ABA relays.

7. I have an older version of DGPxxxACA firmware. What upgrade kit do I order to upgrade my
DGPxxxACA to the latest firmware revision?

Use kit 0361A7507G0001.

8. What model of test plug should be used for the DGP?

The DGP uses test plug models XTM28L1 (two of these are used for the left side) and XTM28R1 (two of these
are used for the right side).

9. Can individual modules be replace while the DGP is energized?

The relay should be powered down by removing the test plugs or turning off the PS1 and PS2 switches before
replacing modules. Failure to do so can permanently damage the relay!

10. Will the DGP power supply work with an AC voltage?

The DGP power supply does not contain a bridge rectifier. Therefore, the power supply only operates with DC
voltage.

11. Why can't I change settings with the DGP-PC software?

In order to download settings using DGP-PC, the remote settings change jumper must be enabled. This is
accomplished by moving the shorting pin on J2 on the right of the MMI301 module to one side as shown in the
diagram below:
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12. What type of cable is required to communicate with my laptop?

The DGP requires a special null-modem cable to communicate directly with a laptop PC (see connection dia-
gram below). The cables are available from GE Multilin as part number 0246A9866. Please specify the cable
type and connector gender when ordering.

13. Is Modbus communication available for all DGP models?

Modbus communication is only available for DGPxxxBCA models.

C) REMOTE COMMUNICATIONS TO PC DIRECTLY

25 PIN D-TYPE

MALE

2
3
4
5
8
6
22
20
7

TD
RD
RTS
CTS
DCD
DSR
RI

DTR
GND

25 PIN D-TYPE

MALE / FEMALE

TO

PC
TO RELAY

PL-1

2
3
4
5
8
6
22
20
7

TD
RD
RTS
CTS
DCD
DSR
RI

DTR
GND

D) REMOTE COMMUNICATIONS FROM MMI MODULE TO PC

9 PIN D-TYPE

MALE

3
2
6
9
4
7
8
1
5

TD
RD

DSR
RI

DTR
RTS
CTS
DCD
GND

9 PIN D-TYPE

MALE / FEMALE

TO

PC

TO RELAY

MMI MODULE

COMM

3
2
6
9
4
7
8
1
5

TD
RD

DSR
RI

DTR
RTS
CTS
DCD
GND

9 PIN D-TYPE
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C.1.2 NOT-SO-FREQUENTLY ASKED QUESTIONS

14. My relay displays a FAIL 520 error code.

Use the MMI Control password to enable outputs and recalculate the CRC.

15. My relay displays a FAIL 770 error code.

For the DGP5xxABA models, check that both power supplies are turned on.

For the DGP5xxAAA and DGP5xxACA models, ensure both power supplies are inserted correctly.

16. My relay displays a FAIL 738 error code.

Check that control voltage is as per the DGP power supply rating.

17. What do I do if I forget my Remote Password?

Press the [INF] key on the MMI and scroll down using the arrow keys to Password then press the [ENT] key.
The message VIEW will be displayed. Press the up-arrow key once to see the encrypted password for VIEW.
Press the up-arrow key again twice to see the encrypted password for SETTING and twice once more to see
the encrypted password for CTRL. Use the password encryption table in Chapter 8 of the DGP manual to
decode these passwords.

18. Why is there a discrepancy in the pickup of function 46?

The 46 function is a negative-sequence overcurrent function. Theoretically, when single-phase test current is
used, the negative-sequence component of the test current is one-third of the applied current. Therefore, it will
take the single-phase test current three times the 46 PICKUP setting for the function to start timing.

19. Where is the figure showing Curve 4 of the 24T function in the DGP manual?

Curve 4 is a definite time delay equal to the corresponding TIME FACTOR setting. Therefore, no figure is nec-
essary. The same applies to Curve 2 of functions 59 and 27.

20. What should I do if an ERROR message is displayed on the DGP relay?

Besides following the instructions outlined in Section 6.3: TROUBLESHOOTING on page 6–4, it is recom-
mended to turn off power to the relay and reseat any “suspect” card. Shipping or excess vibrations may have
caused this problem. Please perform this procedure before swapping a module from another DGP relay.
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APPENDIX D WARRANTYD.1 DGP WARRANTY

GE MULTILIN RELAY WARRANTY
General Electric Multilin (GE Multilin) warrants each relay it manufac-
tures to be free from defects in material and workmanship under nor-
mal use and service for a period of 24 months from date of shipment
from factory.

In the event of a failure covered by warranty, GE Power Managment
will undertake to repair or replace the relay providing the warrantor
determined that it is defective and it is returned with all transportation
charges prepaid to an authorized service centre or the factory. Repairs
or replacement under warranty will be made without charge.

Warranty shall not apply to any relay which has been subject to mis-
use, negligence, accident, incorrect installation or use not in accor-
dance with instructions nor any unit that has been altered outside a GE
Multilin authorized factory outlet.

GE Multilin is not liable for special, indirect or consequential damages
or for loss of profit or for expenses sustained as a result of a relay mal-
function, incorrect application or adjustment.

For complete text of Warranty (including limitations and disclaimers),
refer to GE Multilin Standard Conditions of Sale.
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 GE MULTILIN WEBSITE  

The latest product information for the DGP relay is available on the Internet via the GE Multilin home page:

http://www.GEindustrial.com/multilin

This site provides access to the following customer services:

• Digital Products Directory
A brief description of products can be viewed online.

• Product Catalog
Individual product brochures can be downloaded and 
printed

• Product Selector Guide
A graphical tool for finding the product you are inter-
ested in

• Sales Offices
A complete listing of world-wide sales offices

• Technical Support
Complete contact information is available

• Instruction Manuals
Manuals for many products are now available online

• GE Product Software
The latest working versions of product software

• Technical Drawings
Many technical drawings are available in either 
AutoCAD, CorelDRAW, or PDF formats.

• Order Codes
Order codes for many products can be downloaded 
and printed

• Technical Publications
Papers related to power management

Much more is also available. Visit us online at www.GEindustrial.com/multilin.
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